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About

Copyright

The information contained in this User Guide regarding the use of
LogTag Analyzer software is intended as a guide and does not constitute
a declaration of performance. The information contained in this
document is subject to change without notice. Unless otherwise noted,
the example companies, organizations, email addresses and people
depicted herein are fictitious, and no association with any real
company, organization, email address or person is intended or should
be inferred. Complying with all applicable copyright laws is the
responsibility of the user.

No representation or warranty is given and no liability is assumed by
LogTag North America Inc with respect to the accuracy or use of such
information or infringement of patents or other intellectual property
rights arising from such use or otherwise.

Copyright © 2004-2023 LogTag North America Inc. All rights reserved.
https://logtag.com

Privacy Policy

LogTag North America Inc stores a small number of your personal data
to enhance your user experience. What data we store and the way we
store and use the data is described in our Privacy Policy, which you can
access from the LogTag North America Inc website at
https://logtag.com/privacy-policy. Installing and using this software
constitutes your agreement to this policy.

Disclaimer

LogTag® products assist with monitoring temperature and humidity
exposure, but do not monitor the quality of the goods they accompany.
Their purpose is to signal if product quality evaluation or further
testing is required.
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Typographical Conventions

Text in this font refers to buttons on a LogTag® product.

Text in this font refers to actions to be taken in LogTag Analyzer, such
as clicking a button, icon or menu item.

Text describes features of a LogTag® product.

An icon or menu in gray color cannot be clicked and its i
function is not available at this time. o/

Elapsed
An icon or menu in the theme color can be clicked and its @
function is available.

Elapsed

Text like this gives you tips on how to simplify tasks and how
to get extra information.

Text like this highlights notes and key information that you
should be aware of.

Text like this shows important information about issues that

could cause you to inadvertently lose data.

Text in this font refers to features, tabs or dialogue boxes.
Links or references to other part in this document appear like this.


https://logtag.com/
http://lt.help/wq1ms
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LogTag Analyzer Software License

To use the software (defined below) you must agree to the license terms set out below, including the
LogTag North America Inc privacy policy as published on http://It. help/wqgims.

Last updated: July 21, 2023
LogTag Analyzer License

LOGTAG NORTH AMERICA INCORPORATED END-USER LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS
PRODUCT. IT CONTAINS SOFTWARE, THE USE OF WHICH IS LICENSED BY LOGTAG NORTH AMERICA INC,
TO ITS CUSTOMERS FOR THEIR USE ONLY AS SET FORTH BELOW. IF YOU DO NOT AGREE TO THE TERMS
AND CONDITIONS OF THIS AGREEMENT AND TO THE PRIVACY POLICY AS PUBLISHED ON THE LOGTAG
WEBSITE DO NOT USE THE SOFTWARE. BY ACCESSING OR OTHERWISE USING ANY PART OF THE
SOFTWARE YOU INDICATE THAT YOU ACCEPT THESE TERMS ON BEHALF OF YOURSELF AND ANY
ORGANIZATION OR COMPANY YOU REPRESENT (TOGETHER, "YOU").

LICENSE: LogTag North America Inc grants you a revocable, limited, non-exclusive, non-transferable
(except as set forth herein), non-sublicensable, non-assignable (except as set forth herein) license to use
the accompanying software program(s) (the "Software") subject to the terms and restrictions set forth in
this License Agreement and solely for your internal business or personal purposes. You are not permitted
to lease or rent (except under separate mutually agreeable terms set forth in writing), distribute or
sublicense the Software or to use the Software in a time-sharing arrangement or in any other unauthorized
manner. Further, no license is granted to you in the human readable code of the Software (source code).
Except as provided below, this License Agreement does not grant you any rights to patents, copyrights,
trade secrets, trademarks, or any other rights in respect to the Software.

The Software is licensed to be used on any computing device. You may reproduce and provide one (1) copy
of such Software for each computing device on which such Software is used as permitted hereunder.
Otherwise, the Software and supporting documentation may be copied only as essential for backup or
archive purposes in support of your use of the Software as permitted hereunder. You must reproduce and
include all copyright notices and any other proprietary rights notices appearing on the Software on any
copies that you make.

NO ASSIGNMENT; NO REVERSE ENGINEERING: You may transfer the Software and this License Agreement
to another party if the other party agrees in writing to accept the terms and conditions of this License
Agreement. If you transfer the Software, you must at the same time either transfer all copies of the
Software as well as the supporting documentation to the same party or destroy any such materials not
transferred. Except as set forth above, you may not transfer or assign the Software or your rights under
this License Agreement.

Modification, reverse engineering, reverse compiling, or disassembly of the Software is expressly
prohibited. Analyzing the input to and output from the Software is expressly prohibited except when this is
done solely to evaluate the subjective quality of the Software’s visual and data analysis processes for your
own internal business purposes. You may not otherwise modify, alter, adapt, port, or merge the Software
except as specified in this License Agreement.

EXPORT RESTRICTIONS: You agree that you will not export or re-export the Software or accompanying
documentation (or any copies thereof) or any products utilizing the Software or such documentation in
violation of any applicable laws or regulations of the United States or the country in which you obtained
them.

TRADE SECRETS; TITLE: You acknowledge and agree that the structure, sequence and organization of the
Software are the valuable trade secrets of LogTag North America Inc and its suppliers. You agree to hold
such trade secrets in confidence and to protect the Software as you would your own confidential
information, but with no less than reasonable care. You further acknowledge and agree that ownership of,
and title to, the Software and all derivatives, modifications, improvements, and subsequent copies thereof
regardless of who made them, when they are or were made, and the form or media in which they are made,
are held by LogTag North America Inc and its suppliers.

TRADEMARKS AND COPYRIGHTS: "LogTag®" is a registered trademark (R) of LogTag North America Inc.
You may not remove, alter, deface, overprint, or otherwise obscure any LogTag North America Inc.
trademark, service mark, or copyright notices included with this Software.

INTELLECTUAL PROPERTY; THIRD PARTY SOFTWARE: The Software, and all modifications or derivatives
thereof and improvements thereto, and all intellectual property rights therein and thereto are and shall
remain in LogTag North America Inc. Except for the limited license granted to you in the section entitled
"License", this License Agreement does not transfer or convey to you or any third party any right, title, or
interest in or to the Software or any intellectual property rights therein. The Software may contain software
governed by license from third parties ("Third Party Software"), including, without limitation, any software
component that is subject to any open-source copyright license agreement ("Open Source").
Notwithstanding anything contrary herein, all Third Party Software is licensed to You solely under the
terms of the corresponding third party license agreement(s), if applicable. LogTag North America Inc
makes no representation or warranty concerning Third Party Software, including, without limitation, any
Open Source, and has no obligation or liability with respect to any Third Party Software, including, without
limitation, any Open Source.

PRIVACY POLICY: To use this software you must agree to the privacy policy as set forth on the LogTag
website at http://It.help/wqims. This policy is subject to changes and you should review this periodically.

TERM AND TERMINATION: This License Agreement is effective until terminated. You may terminate it at
any time by destroying the Software and documentation together with all copies and merged portions in
any form. It will also terminate immediately if you fail to comply with any term or condition of this License
Agreement. Upon such termination you agree to destroy the Software and documentation, together with all
copies and merged portions in any form.

GOVERNING LAW: This License Agreement shall be governed by the laws of the State of California and by
the laws of the United States, excluding their conflicts of law principles. The United Nations Convention on
Contracts for the International Sale of Goods (1980) is hereby excluded in its entirety from application to
this License Agreement.

LIMITED WARRANTY; LIMITATION OF LIABILITY: EXCEPT AS EXPRESSLY PROVIDED OTHERWISE IN A
WRITTEN AGREEMENT BETWEEN LOGTAG NORTH AMERICA INC AND YOU, THE SOFTWARE IS NOW
PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE, OR THE WARRANTY OF NON-INFRINGEMENT. WITHOUT LIMITING THE FOREGOING, LOGTAG
NORTH AMERICA INC MAKES NO WARRANTY THAT (I) THE SOFTWARE WILL MEET YOUR REQUIREMENTS,
(II) THE USE OF THE SOFTWARE WILL BE UNINTERRUPTED, TIMELY, SECURE, OR ERROR-FREE, (III) THE
RESULTS THAT MAY BE OBTAINED FROM THE USE OF THE SOFTWARE WILL BE ACCURATE OR RELIABLE,
(IV) THE QUALITY OF THE SOFTWARE WILL MEET YOUR EXPECTATIONS, (V) ANY ERRORS IN THE
SOFTWARE WILL BE CORRECTED, AND/OR (VI) YOU MAY USE, PRACTICE, EXECUTE, OR ACCESS THE
SOFTWARE WITHOUT VIOLATING THE INTELLECTUAL PROPERTY RIGHTS OF OTHERS. SOME STATES OR
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON HOW
LONG AN IMPLIED WARRANTY MAY LAST, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. IF
TEXAS LAW IS NOT HELD TO APPLY TO THIS AGREEMENT FOR ANY REASON, THEN IN JURISDICTIONS
WHERE WARRANTIES, GUARANTEES, REPRESENTATIONS, AND/OR CONDITIONS OF ANY TYPE MAY NOT
BE DISCLAIMED, ANY SUCH WARRANTY, GUARANTEE, REPRESENTATION AND/OR WARRANTY IS: (1)
HEREBY LIMITED TO THE PERIOD OF EITHER (A) THIRTY (30) DAYS FROM THE DATE OF OPENING THE
PACKAGE CONTAINING THE SOFTWARE OR (B) THE SHORTEST PERIOD ALLOWED BY LAW IN THE
APPLICABLE JURISDICTION IF A THIRTY (30) DAY LIMITATION WOULD BE UNENFORCEABLE; AND (2) THE
SOLE LIABILITY OF LOGTAG NORTH AMERICA INC FOR ANY BREACH OF ANY SUCH WARRANTY,
GUARANTEE, REPRESENTATION, AND/OR CONDITION SHALL BE TO PROVIDE YOU WITH A NEW COPY OF
THE SOFTWARE.

IN NO EVENT SHALL LOGTAG NORTH AMERICA INC OR ITS SUPPLIERS BE LIABLE TO YOU OR ANY THIRD
PARTY FOR ANY DIRECT, SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND,
OR ANY DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, THOSE RESULTING FROM LOSS OF
USE, DATA OR PROFITS, WHETHER OR NOT LOGTAG NORTH AMERICA INC HAD BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OF THE SOFTWARE. SOME JURISDICTIONS PROHIBIT THE EXCLUSION OR
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LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS
MAY NOT APPLY TO YOU. THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF
ESSENTIAL PURPOSE OF ANY LIMITED REMEDY.

SEVERABILITY: In the event any provision of this License Agreement is found to be invalid, illegal or
unenforceable, the validity, legality and enforceability of any of the remaining provisions shall not in any
way be affected or impaired and a valid, legal and enforceable provision of similar intent and economic
impact shall be substituted therefore.

ENTIRE AGREEMENT: This License Agreement sets forth the entire understanding and agreement between
you and LogTag North America Inc, supersedes all prior agreements, whether written or oral, with respect
to the Software, and may be amended only in a writing signed by both parties.

The software menus and texts as well as this agreement have been created in English and any other
language versions have been translated from the English version. In the event of a dispute, reference
should be made to the English language version, which is conclusive.

For further information about licensing or the privacy policy please email licensing@logtagrecorders.com.
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Chapter 1
Introduction

LogTag Analyzer version 3 is the latest LogTag® software, using Microsoft’s .NET technology.

It will allow easier integration into third-party developments and enables a path for supporting modern operating systems and multiple computing
platforms in the future, such as Linux or macOS.

If you are familiar with LogTag Analyzer version 2.x, you will find it easy to make the transition to version 3.x. There are a few new concepts, which you
can find by browsing the pages in this User Guide. The main differences are listed in the introductory guide What's new in LogTag Analyzer 3, available
from https://logtag.com.

This guide will take you through the relevant steps to successfully use the LogTag® products. You will learn how to:

« install the software
« configure LogTag® products for recording

« retrieve the recorded readings

« display and analyze the data

« configure the available options in the software so you can make best use of its features.

If you are an experienced users of a previous versions, you may skip some of the early chapters. If, however, you are about to use a newer version of a
LogTag® product or Interface Cradle we recommend you at least skim the installation chapter for any relevant changes.

This guide covers version 3.2 release 5 of the LogTag Analyzer software. If you are unsure which version you are currently using, please read the section
about Finding your software version on page 23.

If you find a feature described in this guide that does not appear in your software, we recommend you update it as explained in the section about
Upgrading LogTag Analyzer on page 24. You can always get the most up to date version of LogTag Analyzer from the LogTag North America Inc website
at https://logtag.com.

This guide includes all the relevant information to install and use the product range supplied by LogTag North America Inc, however, the reader is
expected to be familiar with using a computer and the Windows® operating system.
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The LogTag® Recording System

LogTag North America Inc offer a range of logger products for temperature and humidity,
which are complemented by software and interface products. Some of these products can be
used on their own, most often, however, you will use a combination of products to get the best
results.

LogTag North America Inc offer a variety of different models. The product range is constantly
being updated and new models added, so visit the LogTag Website at https://logtag.com
frequently to get the latest information and news about upcoming product releases.

Typically LogTag® products are configured, put with goods that require monitoring and are
downloaded once the goods reach their intended destination.

Other applications may involve stationary loggers placed in warehouses or fridges, such as the
vaxtag®, as can be seen here.

page 11
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Figure 2: Example of a stationary loggers application
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Loggers
LogTag® temperature and humidity logger products are small, battery powered, credit card size g < Tag
devices with built-in sensors and data logging memory. They record between 4,000 and 16,000 Lfgﬁ
samples from anywhere between -80 °C and +100 °C, depending on the model. For detailed
information about each product visit the LogTag North America Inc website at =
https://logtagrecorders.com/product-range/. 8 @ g 9

. A

Figure 3: Some of the LogTag® logger products

Probes

LogTag North America offer a range of probes featuring different tips and different lead
lengths. The blue-sleeved probes from the ST100 family are used with standard external-probe
temperature loggers, while green-sleeved ST10 probes complement the range of low-

temperature loggers.

Figure 4: Selection of external probes for LogTag® loggers
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Smart Probes are the latest addition to the range, and can be used with select external loggers, LogTag®
such as the latest generation of UTRED30-WiFi and TRED30-16CP loggers. These probes can be Dbl
calibrated independent of the logger, reducing down time as the probes can simply be swapped '
without the need to return the logger for calibration.

Figure 5: Smart Probe model CP100
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Software

Loggers are downloaded using the LogTag Analyzer software, which is also used to configure
loggers. This User Guide explains in detail how to configure and download loggers, how to
customize the settings and how to analyze and share the data.

Interfaces

Unless your product is one of the USB Loggers you will need an interface to communicate
between the logger and the computer.

Most products use the standard interface cradle, where the LogTag® logger is inserted into the
slot from the top as shown to enable communication. You will be able to see the contact pins
inside the slot that meet with the matching contact pads on the LogTag® unit. When inserting
a LogTag® logger into the slot you feel a slight resistance as the contacts engage. Removing the
logger will cause a slight clicking noise as the contacts snap back into their unloaded position.
New in 2018, the LTI-HID is the next generation USB interface that can be installed without
requiring a proprietary driver. It also features two indicators at the top (red & green), which
identify what actions the interface is currently performing.

LogTag

TEMPERA TURE RECORDER

Figure 6: TRED30 in standard USB interface cradle LTI/USB

Figure 7: LogTag® USB Interface LTI-HID
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Installing the software

To use your LogTag® products you need to install LogTag Analyzer on your computer. This will allow preparing your LogTag® devices for recording,
downloading, analyzing and sharing the data.
Experienced users may choose to skip this chapter. You should read it, however, if you are new to using a computer or installing software.

System requirements

To ensure that the software will work on your computer following minimum specifications are required:

« PC capable of running Windows® 8 or later, or Windows® Server 2008 R2 SP1 or later. Although you may be able to install the software on earlier
operating systems by installing some of the prerequisites manually, only operating systems currently supported by Microsoft should be considered
for installing LogTag Analyzer.

« Operating System must support .NET version 4.7.21

« 180MB free disk space (plus 2.5GB if .NET is not yet installed)

« Internet Explorer 8.0 or later

« 1 available USB port to connect an interface or USB logger

+ 1366 x 768, or higher, screen resolution?

e 065535 screen colors

If you wish to use LogTag® Online with LogTag Analyzer you will also need a supported browser and an internet connection, please refer to the

LogTag® Online help file available from https://logtagonline.com/support.

If you are unsure of your computer's specifications, please refer to your operating system's documentation or help function.

macOS and Linux

There are no native applications for these operating systems. Both Linux and macOS offer several virtualization options, though, which allow you to
run Windows software.

Linux offers Virtualbox or QEMU virtualization software, which are both free.

You can use several commercial virtualization programs on macQOS, on both Intel86 and ARM based MAC's. VMWare Fusion and Parallels Desktop are
both paid solutions, with VMWare also offering a free tier. A free option is also available (UTM, based on QEMU), but is not as easy to set up as the

1 LogTag Analyzer cannot be installed on Windows 10 versions prior to 1607 as these do not support .NET version 4.7.2.
2 Note that LogTag Analyzer works best if the operating system's display magnification has been set to 100%. When using a laptop in combination with an external screen, please ensure magnification for both is set to

the same value.
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paid versions. At the time the user guide is published, Virtualbox is available for Intel86 based computers, but not for ARM based M1 and M2 devices.
Generally, all virtualization solutions have been tested and work well.

If you run either of those operating systems, please discuss the best option with your network administrator or contact our support.
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.NET Framework

LogTag Analyzer version 3 is designed around Microsoft’s .NET 4.7.2 framework. To install and
run LogTag Analyzer you need a PC with at least a Windows 7 operating system.

The NET framework 4.7.2 will likely be installed on most PCs, which had regular updates
applied via Windows Update. On some PC's with Windows 7 Microsoft’s .NET 4.7.2 Framework
will need to be installed. The LogTag Analyzer Installer can determine the presence of the
framework and will automatically download the framework directly from Microsoft, if it is not
already present on the PC. In this case your PC will need to be connected to the internet to
successfully complete the installation. This installation method will be suitable for single PC
installations.

If you wish to install this version on more than one computer without .NET 4.7.2, you can
download a standalone installer directly from Microsoft from this link: .NET Framework Offline

Installer (external link)

Getting a copy of the software

The software can be download from the from the LogTag North America Inc website; navigate
to logtagrecorders.com/software and click the LogTag Analyzer 3 link. Complete the registration

details and click[ Download |

LogTag Analyzer is available for download in a number of different formats:
o ltanalyzer_32r5.exe

This is a single executable installer file and the most popular option; no other files are
required for installation of LogTag Analyzer software on your computer.

o ltanalyzer_32r5.msi
This file is used by Network Administrators - it requires additional files and is best suited
when distributing the software remotely to a number of PC's.
« ltanalyzer_32r5.zip
You can download a zipped version of the file, which has a smaller download size. You will
need an unzipping tool such as Unzip® to extract the single executable installer.
« ltanalyzer_32r5.iso (on request)
The ISO file can be used to generate a CD, if you need to distribute the software to PC's
without a network connection.
Click on the desired download link. Depending on the type of browser and its version you may
get different windows to start and process the download. Modern browsers like Edge, Internet

Explorer, Google Chrome or Mozilla Firefox typically have a special directory into which all
downloads are copied, but you can also select your own.

I View Dewnloads - Windows Internet Explorer

View and track your downloads

Itanalyzer_32r5.exe_3.2r5exe Do you want to run or save this
program?
na spapaczsanin

Dptions [tiemint] [aitioe

[i]

]

B)

L

Figure 9: Downloading using Internet Explorer

Opening ltanalyzer_32r5.exe EI,
You have chosen to open
[=77 itanalyzer_32r5.exe

which is a: Binary File (21.3 MB)
from: https://logtagrecorders.com

Would you like to save this file?

Save File I L Cancel |

Figure 10: Download Window - Mozilla Firefox
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LogTag North America Inc does not charge for the download and use of this software, or for
updates. You are welcome to distribute copies of the LogTag Analyzer software provided it is
distributed unaltered, in the packaged format as originally downloaded from the LogTag
Analyzer web page. Please refer to the LogTag Analyzer Software License (on page 8).
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& 69% oftanalyzer_3215,exe downlosded @ el
View and track your downloads Search downioads »
Name Location Actions :
Itanalyzer_32r5exe 69% at 227 KB/sec T s B
nitps/ogtagrecorders cam 32 sec remaining
Options Clear fist | Close
Figure 11: Download progress using IE
@) 14% of 1 file - Downloads ol &=
: Itanalyzer_32r5.exe
‘ | D
1 minute, 10 seconds remaining — 1.8 of 85.2 MB (195 kB/sec)
Clear List Search.. P

Figure 12: Download progress using Firefox

@ chrome

"': Itanalyzer_32r5 .exe

Figure 13: Download progress using Chrome



Introduction

The installation process

LogTag® Analyzer User Guide

You will require local administrator permissions for the PC on
which you are installing LogTag Analyzer.

To install the LogTag Analyzer software, locate the installation file
downloaded in the previous step and execute it (typically by double

clicking or selecting the file in Windows® Explorer and pressing Enter).

To proceed through each step of the installation process, click [Next] If
you want to change a previous step you can click [Back} At any stage
during the process, if you want to stop installing the software, click
‘Cancel

1. Select the installer language

& LogTag Analyzer Setup X

Welcome to the LogTag
Analyzer Setup Wizard

Select the setup language:

English (United States) v

< Back Cancel

2. The software now checks that all prerequisite software packages
are present. These include the NET framework and the Visual
C++ runtime libraries redistributable package.

The .NET framework is included in all supported operating
systems which are up to date with the latest updates. If not, you

page 19

will be asked to download and install the framework, as it is not
included in the installer package.

The Visual C++ runtime libraries may already be installed, as they
are used for many other commercial software. They are included
in the installer package, and you will be asked to permit their
installation, otherwise the installer will abort.

B LogTag Analyzer Setup X

Welcome to the Prerequisites
Setup Wizard

The setup has determined thatsome of the prerequisites
needed to run LogTag Analyzer are missing. This wizard will
assist youin getting and installing those prerequisites. Click
“Next™ to continue or “Cancel” to exit the Setup Wizard.

<Back | Next> Cancel

B LogTag Analyzer Setup X

Prerequisites
Select which prerequisites will be installed

Name Required Found Action
Visual C++ 2010 SP1 x86 (MFC Security Update) 40219.325... Install

Cancel
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Introduction
PR — 4. Accept the End-User License Agreement and click | Next
Installing prerequisites for LogTag Analyzer Q
5 Micro buts X & LogTag Analyzer Setup X
++ 2010 xB6 P EM'U L. M t
Wﬁ;ﬁ‘:ﬂ?mﬂm&kp Please, accept the icense terms to continue, m ser License reemen
Please read the following license agreement carefully
Status: Instaling Visual C++ 2010 5P1 Y
T SOFTWARE LICENSE TERMS
MICROSOFT VISUAL C++ 2010 RUNTIME LIBRARIES WITH
SERVICE PACK 1 n
o o e e o e, S oo ot Gast: updatedr 1 Decembesr 2014
You. Please read them. They opply to the software nomed above,
i bare e el et s e e & [d LogTag Analyzer License
LOGTAG RECORDERS LIMITED END-USER LICENSE
[]¥es, send information about my selup experiences to Mcrosaft Corporatin. AGREEMENT
For more information, read the Data Colection Polcy. v
Concel (® 1 accept the terms in the License Agreement
. . . . - . . (O 1 do not accept the terms in the License Agreement
Once the installation is complete, click |Finish|and continue with T
Advanced Installer
the installation of LogTag Analyzer. o |[hes o

3. Accept the Welcome screen by clicking .
5. Select the installation folder. You can type a folder name or

i Loty Revam Sutep o5 browse to an existing folder. If the folder does not exist, it will be
created for you.
Welcome to the LogTag

Analyzer Setup Wizard 2 LogTag Analyzer Setup - B
Select Installation Folder
Thisi ' Tag Analyzer will be i
The Setup Wizard will install LogTag Analyzer version f5i5 e oleewhereloaTanAralizewill be hebled
3.2.50onyour computer. Click "Next” to continue or i
“Cancel” to exit the Setup Wizard.
To install in this folder, dick "Next™. To install to a different folder, enter it below or dick
“Browse”.
Folder:
|C!\Program Files (x86)\\LogTag Recorders\logTag Analyzer Browse...

Select Data Location

© LogTag Data will only be accessible by me!

< Back Next > Cancel
O LogTag Data will be accessible by all users of this computer!

< Back Next > Cancel
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You can change the document storage location in LogTag
Analyzer 's option settings once you have started the
program, but you cannot change the program location.
We recommend you leave all options at their default
setting, especially if you are unsure of what option to
select or what effects changing the option would have.

A

You can also select where you want the downloaded data from
loggers to be stored. If you select LogTag Data will only be
accessible by me, the default folder will be created in your
Documents folder, and other users of the same PC will not have
access to the data.

If you select LogTag Data will be accelerate by all users of this
computer, this file location will be created in the Public
Documents folder.

6. Select, which files you wish to associate with LogTag Analyzer
(these files will, for example, automatically open in LogTag
Analyzer when you double-click them in Windows Explorer).

& LogTag Analyzer Setup X

Select File Associations
Select the extensions you want assodated with LogTag Analyzer

Please select the file types you want to automatically open with LogTag Analyzer:

[ ltdx O sitd [ .
[ .multix .asxml O .multi

Show temperatures in

(@) Celsius
(O Fahrenheit

< Back Next > Cancel

« If you are installing LogTag Analyzer for the first time we
suggest you select all file types.

« If you are upgrading from version 2, and you do not wish to
use version 2 any longer, you should also select all file types.

LogTag® Analyzer User Guide page 21

« If you are upgrading from version 2, and you are planning on
operating both versions, you can decide if you wish to
associate the files in the right column with the new version
(select those file types) or leave them associated with the
older version (clear those file types).

You can change this later by right-clicking a file, and clicking
Open with.

During the first installation, you can also select the default
temperature units to be either °C or °F.

Again, you can change this later in "General Settings".
Click once you have made your selection.

The installer now has all the information and is ready to proceed.
Click to start the installation.

B LogTag Analyzer Setup X

Ready to Install
The Setup Wizard is ready to beginthe LogTag Analyzer installation

Click "Install” to begin the installation. If you want to review or change any of your
installation settings, dick "Back™. Click "Cancel” to exit the wizard.

< Back Install Cancel
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8. The installer is copying the required files to your PC.

B LogTag Analyzer Setup X

Installing LogTag Analyzer E

Please wait while the Setup Wizard installs LogTag Analyzer. This may take several
minutes.

Status: Extracting files from archive
||

9. When the installation is complete, click to exit the
installer program.

& LogTag Analyzer Setup X

Completing the LogTag
Analyzer Setup Wizard

Click the "Finish” button to exit the Setup Wizard,

< Back Finish Cancel

The drivers required to operate your USB interface are installed as part
of the main installation process. From time to time updated drivers
may be released by LogTag North America Inc. These drivers will be

available through the Microsoft Windows® Update feature, as an

LogTag® Analyzer User Guide page 22

optional hardware update, or as part of an upgraded installer file (see
Upgrading LogTag Analyzer on page 24).

Once the installation process has completed the installer file is no
longer required and can safely be deleted.
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Finding your software version

Click About LogTag Analyzer...from the Help Menu to display the About window.

This window displays the full version number of the software being used. You can use this to
check if the same software version is installed on multiple computers or to find out which user

guide to use.
When the software is updated, the version number of the software is increased.

You can also find major and minor version of LogTag Analyzer in the title bar:

page 23

. LogTag Analyzer

Version 3.2.5

LogTag Analvzer software provides and easy to use,
powerful platform for configuring, downloading and
displaving data from LogTag products.

LogTag Analyzer

LogTag North America Inc

Copyright © 2004-2023, LogTag North America Inc
Wiew our Privacy Policy here.

Close ‘ ‘0 Help |

Figure 14: About LogTag Analyzer
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Upgrading LogTag Analyzer

LogTag North America Inc will publish updates to LogTag Analyzer to introduce new or
enhanced features, or to support new LogTag® models. LogTag North America Inc recommend
that you always use the latest version of the software.

When you first install LogTag Analyzer, the Automatic Updates function is enabled, which
means you will automatically be notified when an update is available. When the notification is
displayed, you can choose whether or not you wish to download and update the software at this
stage.

If you have disabled the automatic update function you can still get updates via the Help menu
by clicking Check Internet for updates. Neither of these two options will transmit any
information about you or your system to LogTag North America Inc, so you can rest assured
your privacy is maintained.

To download the update click . The download progress will be displayed and you will
be notified when it is complete.

page 24

& Updates

LogTag'Analyzer

Version 3.2.5

download the software now.

LogTag Analyzer 3.2 release 6
Latest release of LogTag Analyzer 3.2 release 6

It also contains several bug fixes for issues reported by users and various stability improvements.

View release notes ii« Download

Downloading information from the Internet about the latest version. No personal informatian is being sent.

A newer version of Analyzer (3.2 release 6) is available for download. Click the 'Download’ button if you want to

‘This version contains support for new LogTag models TREL30-16, UTRED30-WIFI and the UTRED30-16.

0 o= |

Figure 15: Checking for a software update

& Updates

LogTag Analyzer

Version 3.2.5
ling File 30%

download the software now.

LogTag Analyzer 3.2 release 6
Latest release of LogTag Analyzer 3.2 release 6

It also contains several bug fixes for issues reported by users and various stability improvements

Yiew release notes iJr Basnitad

Downloading information from the Internet about the latest version. No personal information is being sent.

A newer version of Analyzer (3.2 release 6) is available for download. Click the 'Download’ button if you want to

This version contains support for new LogTag models TREL30-16, UTRED30-WIFI and the UTRED30-16.

© oo |

Figure 16: Downloading the Update
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Clickwhen the file has finished downloading and follow the on-screen instructions.
Installing a newer version will update all the relevant program files. It will not affect any of

A Updates >3
your LogTag® data files or your custom settings of the software. You may, however, need to
check any shortcuts to the program you made yourself, as the location of the program files can B LogTag Analyzer
Change . Version 3.2.5
If you are unable to use either update option on the previous page you can download an Dounlaading nformation ram the nernet abaut he latestversion. No prsonalnformation s eing senl.
upgrade installer flle from the LogTag North America Inc Website. We recommend you register :\:‘eewn::ssiwnf::a{’.:r:;ﬁet(3,2Euild2:isauaxlable'ﬂrinstallaticr'\ Click the 'Install’ button to close Analyzer and install
your email address on the Software download page so you can be notified by email when an
update is available. If a newer version is available, you can download the updated version of the
installer file to your PC and then proceed with the installation process. The older version of the
. . . LogTag Analyzer 3.2 release 2
software will be replaced with the new version. Latet rlease of LogTag Anilyzer 32 relesse 2
This version contains support for new LogTag models TREL30-16, UTRED30-WIFI and the UTRED30-16.
It also contains several bug fixes for issues reported by users and various stability improvements.
View release notes @ Install ‘0 Carxel

Figure 17: Ready to install
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Migrating from LogTag Analyzer Version 2

LogTag Analyzer 3 can be installed on any computer that has LogTag Analyzer 2 already
installed. There is, however, no option to cross-upgrade from version 2 to version 3 using an
automated upgrade function. Instead, if you are currently using version 2 and you wish to
upgrade to version 3, you must download the standard software installer package from our
website and use the standard installation process as described in Installing the software (on
page 15).

LogTag Analyzer 2 will not be uninstalled as part of this process and can still be used, even

after LogTag Analyzer 3 is installed. New shortcuts will be created on the desktop for version 3

alongside those for version 2.

When you run the new version 3 for the very first time, any settings you have made in

version 2 will be transferred to version 3 (with a few small exceptions). After that initial
transfer, you can use either version independently of each other. Settings made in one version
will not affect the other (for example, you could change the displayed temperature units so one
version shows °C, the other °F). You can also update both versions independently of each other.
The installation folder and shortcuts by default are different between the two versions.

Due to the nature of some of the features, you will need to migrate some of the settings

manually:

« The User Server settings will not be transferred when you first install LogTag Analyzer 3.
You can, however, export the settings from LogTag Analyzer 2 when you are logged in, then
import the settings into LogTag Analyzer 3.

« FTP and SMTP settings are transferred, however, you will need to re-enter the credentials
for these services. You will receive a warning when you first start the program.



Chapter 2
Using LogTag Analyzer

This chapter explain in detail how to use the software to configure and download loggers, how to analyze the results and how to share them with other
users.

The User Inter ace . .. 28
Initial SOt UD .. . 46
AQVanNCed Set—UD ... 46
Connecting the Interface ... . 47

Configuring a LogTag® product for recording ... 48
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The User Interface

Once you have started LogTag Analyzer, the
main window will open. From here you have
access to menu commands, toolbar \ﬁ
commands, option settings and many other eh b S
controls.
You can find more information about the Toolbar
different areas here:

« Information about Menu commands on

Auto-download is

File Edit LogTag Wigdow User Server LogTag Online

PAR B S HCLOO0EER O

Upload Copy _ fZoom Out Real Time  Elapsed Zc us  Next  Average.  Muli  Single Options

Help

es  Signatures  Se

page 31

« Information about Toolbar commands on
page 40

« Information about The Status Bar on
page 43

For Help, press F1. To use a LogTag, press F2. (%) Select Display TimeZone ~  LogTag Configured Time (Display Clock Adjusted) Rending Emsils: 1 Uploads: 0

Figure 18: The workspace
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When you open a file, it completely fills the
docking canvas.

You can now zoom in and out, show and hide
various elements of the chart, view the
information in different forms and save or
export the file to different formats

When you open additional files, they each
open in a new file window tab.

Clicking a tab displays the corresponding file
window. The window's title bar shows the full
file title, while the tab may only show
abbreviated information, depending on how
many files are open.

File windows are initially docked, which
means they are attached to the canvas. When
they are docked, they move with the main
program window. File windows can also be
floating, which means you can move them
anywhere on your PC's screen, even outside
the program window and on to a second
screen. To float a docked window, simply click
and hold the file's tab, and drag it
downwards. You can now independently move
and resize the window.

LogTag® Analyzer User Guide

X VogTag Anaizer Version 325
Fle Edt (ogTag Window UserServer LogTag Oriine Help

Froperiies Signatures Send Mail Copy | Zoomou

Eapsed  Zoom  Predows
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Figure 19: Workspace with two files open
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This allows you to have multiple windows on
your screen.

To re-dock a floating window, click and hold
the file's title bar and drag it on top of any
docking icon:

E Docks the window to the top of the
canvas

o | bl
* 1 Docks the window to the bottom of
the canvas

o |4
@ Docks the window to the left of the
canvas

Docks the window to the right of the

canvas

Docks the window to the existing

window tabs

You can also dock a file window to another
floating window, and use the Tile function to
display windows side by side, separated by a
movable divider.

LogTag® Analyzer User Guide
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Figure 20: Multiple floating windows
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Menus and Toolbars

At the top of the screen below the title bar is LogTag Analyzer's menu system and toolbar. The toolbar provides quick access to some of the more
commonly used functions. The menu system contains lists of all the operations and commands that are available while using the software.

Menu System

File Edit LogTag Window  User Server LogTag Online Help Auto-download is

&8 Bl B PEHOLCPO00BEHNM 0@

Wizard Open Save Print Properties Signatures Send Mail Upload Copy Zoom Out Real Time Elapsed Znom Previous Average Multi  Single Options Logon Lugoff
Toolbar

Figure 21: Menu and toolbar

Menu commands

The menu system has been separated into groups of related commands. Each of these menu groups is explained in more depth in the subsequent
sections. The software will only display the menu groups and commands within each menu group that are appropriate depending on what you are
currently doing with the software.

You may also see that some of the menu commands have a reference after the command name, for example F2 or Ctrl+O. These represent key
strokes on the keyboard that instruct the software to perform the appropriate command, without the need to select the menu or toolbar command.
When only one key reference is mentioned, for example F2, then pressing that single key on the keyboard will cause the appropriate command to be
performed. If there is more than one key reference mentioned, for example Ctrl+0O, then to cause the command to be performed you must press and
hold down the first key mentioned while pressing the other key once. When letters are used in the key reference, for example Ctrl+0O, it does not
matter whether or not the caps lock is on or off.
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File Menu

LogTag® Analyzer User Guide

The File menu contains commands that relate to a LogTag® file. When clicking on File (or pressing ALT-F on the
keyboard), a menu similar to the one on the right appears.

The following table outlines the commands you can select along with a brief explanation. Some commands do not
appear if no file is open.

Command

r

Open...

B

Save

=

Save As...

>

Close

Upload

o]

Print...

o]

Print All...

B

Print Preview

Table 1: File menu - available commands
Explanation

This will display the Open file dialogue, which will allow you to open files that were
previously saved with any version of LogTag Analyzer, such as *.1td, *.1tdx or *.sltd
files and multi chart files such as *.multi or *. multix.

Initially, the folder defined in Edit - Options - File and Folder Settings will be
displayed. When you open a file after you browsed to a different location, LogTag
Analyzer will remember this location for the next time you wish to open a file.

If a multi chart file is selected, the LogTag Analyzer software will automatically show
the opened file as a new multi chart (see Multi Charts (Combining Charts into a
Single View) on page 111).

This will save any changes you have made to the LogTag file (or multi chart
configuration) to your disk drive.

This will display the Save As file dialog, which will allow you to save a copy of the
file currently being displayed in the same or a different folder with the same or a
different file name, in the same or a different file format .

This will close the currently active file. You may be asked to confirm if you wish to
save any changes, such as annotations or zoom settings. If no files are currently
open this command will not be visible.

This will send an email with the currently active file attached to a list of recipients or
upload the file to a ere-determined FTP site, as detailed in Sharing recorded data
with others on page 138.

This will open a window allowing you to print the currently active window to a
printer. This command is further explained in the section Printing the results on
page 132.

This will open a window allowing you to print all currently open windows to a
printer. This command is further explained in the section Printing the results on
page 132.

This will change the display mode of the software to show you a copy of how a
printout of the currently selected file and window would look like. In "Print Preview"
mode you will not be able to zoom in or out of a chart. Click to exit the "Print
Preview" mode and return to normal display mode.

Open
Save
Save As

Close

Print All

Print Preview

Page Setup

Send

Upload

-+

MDD @SB B EIR

Properties

@

Digital Signatures

Select Recent File

0 Exit

Ctrl+0

Ctrl+5

Brint Ctrl+P

Figure 22: File menu
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Command

o)

Page Setup...

£

Send...

=

Properties...

Digital Signature...

Select Recent File

Exit

LogTag® Analyzer User Guide

Explanation

This will open a window allowing you to view and adjust one or more of your page
settings, like printer margins and page orientation.

This will help you send, by email, the currently open and selected LogTag® file to
another user without the need to exit to your email software or to deal with file
attachments. This command is explained in further detail in the section Sending a
file by email directly from LogTag Analyzer on page 138.

This will open a window that will display the information about the file that is being
displayed and currently selected. This same window and information will be
displayed if you view the properties of the file from Microsoft Windows Explorer.

This will open a window to display a list of digital signatures that have been included
with the file. It also allows you to add and print this list of digital signatures. Further
explanations can be found in the section about Digital signatures on page 95.

This sub-menu, when clicked, shows a list of the most recent files you have viewed.
This includes any files that were opened when you donwloaded a logger.

To re-open one of these files, simply click the name of the file. The number of files
included in this list can be adjusted in Edit - Options - File and Folder Settings.

This command will exit the LogTag Analyzer software. Any files currently open will
be closed automatically. If a user is currently logged on to the User Server, the user
will be automatically logged off.
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Edit Menu

The following table outlines the commands you can select along with a brief explanation. Some commands do not

LogTag® Analyzer User Guide

appear if no file is open.

Command

B
Copy

Zoom Out

e

Real Time

@

Elapsed Time
@,

Zoom to Marks

O

Previous group of
Marks

©

Next group of
Marks

o

Options...

Table 2: Edit menu - available commands
Explanation

Places a copy of the contents of the currently displayed window onto the clipboard,
which can then be pasted into any Windows® application. The Copy command
behaves slightly differently for different tabs, please refer to the descriptions
covering individual tabs for further details.

This will undo the last zoom operation. If the chart is displaying all readings
recorded, this command will not be available.

Clicking this menu item will make the time axis represent date and time the data
were recorded. This is useful when you want to inspected at what date and time a
certain event occurred.

Clicking this menu item will make the time axis represents the elapsed time since
the recording began. This is useful when you want to inspected how long into a trip a
certain event occurred.

When this command is enabled, the chart is automatically zoomed to show readings
recorded between inspection marks. The section Starting and using the LogTag®
explains how inspection marks are recorded.

This command will show the readings recorded between the first inspection mark
shown and the previous inspection mark recorded. This command will only be
available if the "Zoom to Marks" command is enabled and the first reading recorded
is not currently visible.

This command will show the readings recorded between the last inspection mark
shown and the next inspection mark recorded. This command will only be available if
the "Zoom to Marks" command is enabled and the last reading recorded is not
currently visible.

This will open a window allowing you to customize the software. This command is
further explained in the chapter Customizing the Software on page 147.

Y

©00.,Q
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Gou Ctrl+C

Zoom QOut

Real Time

Elapsed Time

Zoom to Marks

Previous group of Marks

Mext group of Marks

Options

Figure 23: LogTag Analyzer Edit menu
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LogTag® Menu

The LogTag menu contains commands for interaction with LogTag® products.

When you click LogTag (or press ALT-L on the keyboard), a menu similar to the one on the right appears.

. . . . . F3
The following table outlines the commands you can select along with a brief explanation. [E@ Configure
Table 3: LogTag menu - available commands I@) Download F4
Command Explanation =
|F7 This will display a wizard to help you through the necessary steps to configure EL AIainate
© ) LogTag products for their next use. This command is explained in more detail in the = _ F6
Configure chapter Configuring a LogTag® product for recording (on page 48). I@ Quick Re-configure
@ This will display a wizard to help you through the necessary steps to retrieve a copy D Profiles F7
of the readings stored inside the logger. This command is explained in further detail L I
Download in the chapter Results from LogTag® Loggers (on page 92). @ P2
Wizard
iL This will display a wizard to help you through the necessary steps to switch LogTag
= products to "Hibernation". This command is explained further in the chapter .
Hibernate Hibernation - Prolonging battery life (on page 82). Figure 24: LogTag Menu
B With this command you can re-configure a logger with the same settings as for the
ik Re— previous trip. This command is explained in further detail in the section Quickly re-
CQ(;lri(Eigufe configuring a LogTag® logger (on page 78)
D’ With this command you can configure a logger with a configuration profile previously
= created. This command is explained in further detail in the section about
Profiles Configuration Profiles (on page 84).
E This will display a wizard to help you through the necessary steps to retrieve a copy
= of the recorded readings stored inside a LogTag device and then prepare it for its next
Wizard... use. This command is explained in further detail in the chapter Configuring a

LogTag® product for recording (on page 48).
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LogTag® Online Menu

The LogTag Online menu contains commands for interaction with the LogTag® web based storage and analysis
portal, LogTag Online. You can find details about connecting LogTag Analyzer and LogTag Online in the section
about Integrating LogTag Analyzer with LogTag Online. If you want to know more about LogTag Online and its

features please go to https://logtagonline.com/support.

When you click LogTag Online (or press ALT-O on the keyboard), a menu similar to the one on the right appears.

The following table outlines the commands you can select along with a brief explanation.

Command

®
[ ]
Sign In

®
=
Sign Out

@

Create an Account

Connection
Wizard

Current Team

Table 4: LogTag Online menu - available commands
Explanation

This will display a dialogue where you can enter your user name and password for
LogTag Online.

If you are signed into your LogTag Online account, you can sign out if you click this
menu entry.

This will open your default browser and display a web page where you can create a
new a LogTag Online account. For this, you will require internet access and an email
address.

This will open the LogTag® Online Connection Wizard, which is used to configure the
settings for WiFi enabled devices such as interfaces (LTI-WIFI and LTI-WM-WIFI)
and real-time loggers (UTRED30-WIFI).

The wizard is a stand-alone Windows app that will be installed together with LogTag
Analyzer.

You can find more information about the functionality of the LogTag® Online
Connection Wizard in the wizard's online help. You can also access the Wizard from
the Windows Start menu if LogTag Analyzer is not running,

LogTag Online allows you to be a member of multiple teams, however, LogTag
Analyzer can only be connected to one of the teams at any one time. You can choose
which of your teams is connected by selecting its name in this menu entry. LogTag
Analyzer will remember your team setting for the next time it is opened.

%_3 Sign In

%&‘5 Sign Cut

@ Create an Account
'u Connection Wizard

Current Team »

Figure 25: LogTag Online Menu
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Window Menu

The Window menu contains commands that relate to the management of windows open in LogTag Analyzer,
which display the contents of a LogTag® file.

Commands available in the Window menu:

Table 5: Window menu - available commands

Command Explanation
Opens a new window that contains a copy of the information of the currently selected window. This command is

*
[ .j useful when you need to closely inspect and analyze different sections of the same file.
New
Window
e, Closes the currently selected window.
®
Close
Closes all open windows.
Close All
= Maximizes all windows inside LogTag Analyzer's docking canvas, with a tab for each window.
Dock All
r‘_'| Un-docks all windows, so they can be positioned freely around the computer monitor.
Float All
Current This sub-menu, when clicked, shows a list of the currently open windows. Click on an entry to bring the window
Windows to the front. If you want to change the currently selected window to one of the windows listed, just click/select

the appropriate entry on this list.

MNew Window

Close Window

Close All

Dock All

[T} Eoat An

Current Windows

] && @

Figure 26: Window menu
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User Server Menu

The User Server menu contains commands that allow you to log on and off. When clicking on User Server (or

pressing ALT-U on the keyboard), a menu similar to the one one on the right appears. [#] Logon
3] =
The following table outlines the commands you can select along with a brief explanation. Some commands do not © =3
appear if no file is open. %ﬁ Logoff
Table 6: User Server menu - available commands 5 ch o 4

Command Explanation aE ||| =9I ES

[ ] This allows a user to log on to and use the Analyzer software. When the software is connected to the User Setti

© ; . ; . Settings

Server software, users must log on to the software prior to being permitted to use the software. Therefore, this

User logon

L ]
Ll
User logoff

=

Change

Password...

©

Settings...

command will only be available if the Analyzer software is connected to the User Server software. If a user is
already logged on to the software, then this command is not visible. The section User Server explains in more . .

: Figure 27: User Server menu
detail how to get the Analyzer software to connect to the User Server software.

This allows the currently logged on user to log off the Analyzer software. The username portion of this
command will represent the name of the user currently logged on. If there is no currently logged on user, this

command is not visible.
This allows the currently logged on user to modify their password that they use to logon to the Analyzer

software. This command will only be available if the Analyzer software is connected to the User Server
software and the User Server administrator has granted the appropriate user permissions.

This will open a window allowing you to enter the settings required to connect to or disconnect from LogTag®
User Server.
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Help Menu

The Help menu contains commands that provide you with help and assistance when using the LogTag Analyzer

software. m F Topis
When clicking on Help (or pressing ALT-H on the keyboard), a help menu appears.

The following table outlines the commands you can select along with a brief explanation. ,‘5— User Guide
Table 7: Help menu - available commands

Command Explanation #A\ Analyzer Home Page

s Opens a window that contains the online help. 0 Beewest HER

Help

Topics @ Check Internet for updates
Opens the online user guide for viewing. Requires PDF viewing software (such as Acrobat Reader) that can read o Kbt Anabia

= version 1.6 compliant PDF files to be installed on the computer. SO Sl ot

User Guide
This will open your default Internet browser software and display the LogTag North America Inc Internet site, Figure 28: Help menu

a

https://logtag.com. This command requires that your computer be currently connected to the Internet to
LogTag® successfully display the LogTag North America Inc Internet site.

Home Page

o This will gather non personal information from your system to include in the email to be sent to software
support at LogTag North America Inc, so that the support team will be informed of the relevant information

Request about your system in order to provide you with quality and useful assistance. This command is explained in

help further detail in the section about Getting more help on page 206.

@ This is a simple way of checking to see if there is a newer version of this software available for download. This
command is explained in further detail in the section about Upgrading LogTag Analyzer on page 24.

Check

Internet

for update

o Display the version information for LogTag Analyzer.

About

Analyzer
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Toolbar commands
The icons on the toolbar give you access to some of the most frequently used commands.

¥

Wizard Open

Save

B EBFB B

Print Properties Signatures Send Mail Upload Copy

Figure 29: LogTag Analyzer toolbar

Wizard

W

o
o
o
-

w
o
o
o

@ ¢[B

2
F)

Properties

Signatures

D

Send Mail

7

Upload

Table 8: Toolbar icons and their function

Wizard

Invokes the LogTag® Wizard. For more details please
refer to Using the LogTag Access Wizard on page 78.

Open
Displays the file open window. This allows you to open
previously saved LogTag® data files.

Save

Save a copy of the LogTag® data to a file on your disk
drive.

Print

Opens the Windows Print dialogue. Please see Printing
the results on page 132 for further details.

File properties
Displays file properties about the currently selected file.

File digital signatures

Displays information about any digital signatures
included in the currently selected file. Here you can also
add new digital signatures to files or print copies of the
digital signatures.

Send mail

Creates a new draft email and attaches a copy of the
currently selected file so it can be sent to a recipient of
your choice. Please see Sending a file by email directly
from LogTag Analyzer on page 138

Upload

Uploads the file in the currently active window to an FTP
server, or sends it by email. Please see Automatic
emailing and uploading to FTP sites on page 139

Zoom  Previous

=)

Copy

bt

Real Time

&

Elapsed

/G)

Zoom Out
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Next

APEOLPOOBEBENK

Zoom Out Real Time Elapsed

Average
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Copy

Places a copy of the currently displayed information to
the Windows clipboard, so you can paste it into another
Windows application.

Real Time

When this icon is active, the time axis represents the
elapsed time since the recording began. This is useful
when you want to inspected how long into a trip a certain
event occurred.

Clicking the icon switches to date and time display.

Elapsed Time

When this icon is active, the time axis represents the
date and time. This is useful when you want to inspected
at what date and time a certain event occurred.

Clicking the icon switches to elapsed time display.

Zoom out

Zooms out one level of the chart in the currently active
window. If you are displaying a chart and this function is
not available, then all available data are already being
displayed and you cannot zoom out any further.

Zoom to inspection marks

This zooms the chart so readings are shown between the
oldest reading recorded and the first inspection mark
that exists in the data. If this function is not available
then there are no inspection marks in the data currently
being displayed.

The next two commands will not be available until this
command is activated.
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Previous

[

Average

Ilagl

Multi

s

(o]

b1 W
O T
2 m

[ ] [ ]
«© W
Logon Logoff

Previous inspection mark group

This zooms the chart so readings are shown which were
recorded between the first inspection mark currently
being displayed and the previous inspection mark.

This function is disabled when either the oldest reading
is already being displayed, or the "Zoom to inspection
marks" function has not been activated.

Next inspection mark group

This zooms the chart so readings are shown which were
recorded between the last inspection mark currently
being displayed and the next inspection mark.

This function is disabled when either the newest reading
is already being displayed, or the "Zoom to inspection
marks" function has not been activated.

Average

Combines all open file windows into a single multi chart
window and activates the average tab, or, if already in
multi chart, activates or disables the average tabs. It is
recommended to deactivate this feature when processing
large data sets, as Minimum, Maximum and Average
Charts can require considerable computer resources when
activated.

Multi chart

Displays all currently open charts together in one window
using the same time axis.

Single chart

Opens all charts displayed in a multi chart in their own
individual tabs (the original multi chart remains open).

Options

This will open a window allowing you to customize the
software. You can find a detailed overview over all
settings in the chapter Customizing the Software on
page 147.

Log on/Log off

These icons are only displayed if LogTag Analyzer
requires a connection to LogTag® User Server software in
order to operate and are used to log on or off. Please see
Connecting to LogTag® User Server on page 199 and User
Server on page 186.
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If you are working with a small computer monitor, not all icons may be visible.
In that case click the down arrow next to the group where the icons are missing,

and you will get an expanded view of the toolbar.
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Print preview toolbar

The print preview feature —available through the File menu- will
display a view of the data as it would appear printed out. When the
software is displaying a file in print preview mode, an additional
toolbar will appear, similar to the picture one on the right:

i@ W 4 of 1+ b | ldv| Pagewidth -

T A B AT e

Table 9: Commands available in the print preview toolbar

Command Explanation —— S e e

E This will refresh the displayed data. T { f/ ‘ L

Refresh - - :

K45 ofi3ah M This allows you to navigate between pages. These H
controls are disabled if there is only one page to il

Page Navigation be displayed.

=

|

[
& This will open the operating system's print L i : Il e i
Print... dialogue, allowing you to print a copy of what 1 ] o ‘F | :
you see in the preview. This command is further I A A T ! w
explained in the section about Printing the | | MILA ﬁgﬁ I/l i | ' s
results on page 132. iy il ‘ ;”[3 I i'd i ! [ I -
‘ | "

Here you can select the zoom level with which

PI— the preview window displays the data. This
works much the same as in other windows
applications. It does not influence the printed
data, just how you view them in the preview

Source: HAXO-8 50100008%7_? 191(Sample MuChaid

Created: 1/11/2017 112127 AM Page:1of1

window. v
Figure 30: Print preview
View Zoom
FH This function allows you to export the currently
Acrobat (PDF) file previewed data to one of the listed formats.

These formats are additional to the export

csv delimited) - -
S formats listed in Exports and Reports

Excel 97-2003
Rich Text Format
TIFF file

Web Archive

Export (Save As)

Close the preview window with the Close button .
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The Status Bar

The status bar is located at the bottom of the LogTag Analyzer
program window.

Display Time Zone

| For Help, press F1. To use a LogTag, press F2. (¥ Select Display TimeZone +  LogTag Configured Time (Display Clock Adjusted)  Pending E-mail: 1 Uploads: 0 ;|

Time Zone Selection Upload Status

The status bar shows information about some of the software's active
tasks and settings, and what you can do. You can also select the Time
Zone for the data display.
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Dates and Times

Every LogTag® product contains a real time clock, which it uses to
determine the recording start time, when to take a reading and when to
stop recording.

Often, the loggers are used for transit monitoring applications, where
goods are transported between different countries, and frequently
different time zones.

Time zone information is included in the loggers' memory, allowing
you to relate shipments from different time zones to each other.

During configuration with a PC, the clock of each logger is set to the
computer's time, and the local time zone of that computer is also
stored in the logger's memory. When the logger is downloaded by the
recipient, LogTag Analyzer is able to use the time zone information
from the logger and the information from the PC used for downloading
to display the data in a variety of different time zones.

Table 10: Time zones for data display

Time zone What is displayed
Local PC Time All times are displayed in the time zone of the computer
Zone used for viewing the data. This is the most commonly

used option, as it displays the dates and times on screen
in your local time zone.

Note, that this is not the same as the download
time zone, if you were sent a file from a logger
downloaded in a different time zone.

Download Time All reading times are displayed relative in the time zone

Zone of the computer used for downloading the data.
Configuration All reading times are displayed in the time zone of the
Time Zone computer used for configuring the LogTag® product.
You would use this option if you wanted to view the data
in the same way the sender of the logger would see it.
UTC/GMT Time All times are displayed in Greenwich Mean Time

Zone (Universal Time Coordinated).

This is the best option when comparing different loggers
from different senders in different time zones.

The currently used time zone is shown on the status bar:

LogTag® Analyzer User Guide page 44

I For Help, press F1. To use 3 LogTag, pressF2. (V) Select Display TimeZone - F.cgfag Configured Time (Display Clock Adjusted_}] Pending E-mails: 1 Uploads: 0 :i
t 7

The default time zone used when first opening a file is set in the
options settings. If you quickly want to switch to another time zone,
without affecting all other charts, you can click on Select Display Time
Zone and choose the desired the time zone from the list.

| For Help, press F1. To use a LogTag, press F2. I@SzlzﬂD\splayTimaZan& - ILugTagCcnﬁgudeime(Disp!ayC\uckAdjus!:d) Pending E-mails: 1 Uploads:0 ;|

_—

For additional time zone settings please see Time zones on page 183

Upload Status

When either automatic or manual uploading or emailing of files is
enabled, the upload status is displayed at the bottom of the LogTag
Analyzer window in the status bar.

| For Help, press F1. To use a LogTag, press F2. (% Select Display TimeZone = LogTag Configured Time (Display Clock Adjusted) ! Pending E-mails: 1 Uploads:0 | l

Figure 31: Status bar showing one pending email.

The email counter will decrease as emails are sent. Similarly, the
upload counter will decrease as files have finished uploading.



Using LogTag Analyzer LogTag® Analyzer User Guide page 45

Color Picker
In a number of different places throughout the software you can set a color for lines, text or e

shade areas. This is done with the help of a color picker, which works similar to selecting a e [
color in other windows applications such as Microsoft Word.

To change a color for an item, click on its color selection box.

New

Current
# FFD2D2

O

Basic Color Selection

The basic color selection window will appear. If it doesn't, the color for this item cannot be
changed.

The color currently selected for the item is displayed on the right. Click on any of the colors in
the honeycomb to select it. The New color is now shown on the right above the old color, so
you can compare the two.

You can click the color picker # and then click on any part of the screen to select that color.
You can enter a hexadecimal RGB color code directly into the field labeled #. This can be
helpful if you have a corporate color scheme you are trying to match. Figure 32: Basic Color Selection

oK Cancel

Advanced Color Selection

Basic | Advanced

You can click on the Advanced tab in the color selection window to bring up a more refined
selection mechanism. Here you have more detailed control over the color, and can also apply
transparency.

Move the slider up or down to select the basic color hue. Then set luminosity (horizontal
movement) and saturation (vertical movement) in the color square and click on the desired
color. Change the alpha value to change transparency (0 = fully transparent, 255 is fully
opaque). The corresponding hexadecimal RGBA color code is displayed in the field labeled #,
where you can also enter a hexadecimal RGBA color code directly. As with the basic window the
color picker is also available.

Current
#|FFD2D2

&

O o] 0] o] o] o

(@
Q6 [210
210
255
nom 0
17
100

oK Cancel

Figure 33: Advanced Color Selection
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Initial Set-up

Before you start configuring and downloading loggers we recommend you customize some of
the settings by clicking Options from the Edit menu:

« Define the display language and temperature units used (General Settings on page 149).

« Choose how time and date are displayed (Date and Time Format on page 182).

+ Select how LogTag Analyzer names downloaded files and where these are stored (File and
Folder Settings on page 171).

» Decide which communication ports LogTag Analyzer uses (Communication Ports on
page 185).

Sometimes your network administrator will ask you to import settings from a configuration

file. You can read how to do this in the section about Importing and Exporting Option Settings.

Advanced Set-up

Once you are familiar with the basic settings, you can refine your work-flow:

+ Share data with colleagues and project stakeholders by exporting and emailing them (see
Sharing recorded data with others on page 138).

« Enable the report logs, so you can track which loggers you have configured, and what
settings were applied (see Activity Logs on page 188).

» Automate your work-flow with auto-downloading and auto-reconfiguration (see Automation
on page 160).
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Connecting the Interface

L Tip: You can skip this step if you only use USB Loggers. ]

The standard interface cradles available from LogTag North America Inc connect to a USB
(Universal Serial Bus) port.

These ports are typically located at the rear of workstations, but you can also find ports at the
front, or at the sides if your computer is a laptop. If you are using a USB hub we recommend it
has its own power supply.

LogTag Analyzer can communicate with multiple interface cradles at the same time; you may
connect as many USB interface cradles as the computer supports, although we find that
connecting more than 4 interfaces becomes impractical.

If you install LogTag Analyzer on a computer with no internet connection you must ensure USB
interface cradles are not connected until the software installation is completed, since the
required drivers are installed as part of LogTag Analyzer.

If the software cannot identify a connected USB interface cradle there may have been a
problem during the installation of the driver software. Please refer to the FAQ on the LogTag
North America Inc website for further information.

The LogTag® range of USB loggers do not require an interface to communicate with LogTag
Analyzer.

LogTag North America Inc also offers a serial (RS232) port interface. This can be useful for
heavily visualized environments such as Citrix or VMWare, although should no longer be
required with the introduction of the HID-based USB interface. Please contact LogTag for more
information.
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Configuring a LogTag® product for recording

Some of the LogTag® products are delivered to you ready to start, but
most of the time a logger will need to be configured before it can
record temperature or humidity data. During the configuration process
of a logger you define the settings that affect how it records data
during its next trip, such as

« how and when to start recording, how many readings to record and
at which interval,

« whether to stop recording after a defined number of readings or to
record continuously;

« what alerts to process and at which temperature limits;

« if password protection is required for configuring or downloading;
and

« what information to show on the logger's display.

To start the configuration process, insert the logger to be configured

into the interface (or a USB socket if you have a USB logger) and click

Configure from the LogTag menu or press F3.

Note: By default the Auto Download feature is enabled, which
means LogTag Analyzer will download any previously recorded
readings. Please see Enable automatic download of readings
from LogTag® devices on page 160 for an overview of this
feature.

The LogTag Configure window will be shown, and LogTag Analyzer will
check all connected interface cradles and USB ports for attached
loggers. Every LogTag® device found will be listed in the Progress Pane
on the left side, showing the progress of retrieving its configuration
settings.

When all loggers have been found, the configuration settings currently
stored in the logger in the first interface found are shown in the
Parameter Pane on the right. These are either the factory pre-set data,
or the parameters used when this logger was last configured. Model
number and serial number of this logger are shown in the Parameter
Pane.

( Locate cradled LogTag(s)
The software will locate the LogTag products for you so you can update their
e Lead LogTag(s) current _ _ _ N
. .: N . configuration settings for next use. Note, NO logged data will be downloaded
** configuration
and/or saved to disk.
Prepare LogTagl(s) for next use
Note: Single use LogTags, limited use LogTags, LogTags with locked
configurations, and LogTags with low battery may display a lock symbol and
not allow configuration.
USE: 03101006
TRIX-16 SN:1001016928 @ Click on an interface to the left to load that LogTags current configuration.
Interfaces with compatible LogTag that can be configured at the same time will
SERIAL: COM7 be automatically included.
HAXO-8 SN:1010080254 @
I The process of configuration allows you to define a number of parameters,
including:
+ How long it should record dara for,
+ The frequency used to sample the data,
- The limits, which -if exceeded- cause an alert 1o be displayed,
- Whether to record continuously or take a set number of readings.
G Rescar o Configure B Save Profile e Cancel 0 Help

Figure 35: Locating loggers and loading initial parameters

@ .Conﬁgure l} F3
[E'@ Dowinload i
[iL Hibernate B
@ Quick Reconfigure F&
Qf Profiles E7

[ﬂ Wizard F2

Figure 36: LogTag Menu Configure



Using LogTag Analyzer

Note: You can attach different logger models at the same
time, however, you can only configure loggers of the same
model at the same time.

In the example shown the first detected logger was a HAXO-8
in the RS232 serial interface. Therefore, the configuration
parameters for this HAXO-8 are shown.

If you wish to configure any of the other loggers found, you
can click on that logger's progress bar, and the parameter
pane will now show the corresponding configuration data for
that logger.

Depending on the logger model, different parameter tabs and
different additional information will be shown.

(. J

You can now adjust the configuration parameters for the next trip.

Please note that some loggers are factory preset for specific
applications and will only allow some of the parameters to be
adjusted, but not all of them. Such loggers include, for
example, the WHO PQS listed vaxtag® or USRID-16W models,
which have fixed log interval and alarm settings.

| J

Click the model name hyperlink, and your default web browser will
open, showing the user guide for this model. Here, you can get
additional information about specific configuration parameters for
your model, and how to operate it. For this feature to work, your PC
needs to be connected to the internet.

For some models, additional information is available, such as the
ability to support Smart Probes or being able to print calibration
certificates for the logger. Click the question mark symbol (0) next to
the feature to get additional information from our online knowledge
base.

When you have entered or adjusted the settings as desired, click
to upload these new configuration data to the device.

The logger is now ready to be started.

LogTag® Analyzer User Guide

Action Pane

|| Configure LogTag(s) HAXO-8

0 With Smart Probe support

User Information
Description:

v Locate cradled LbgTag(s)

v Load LogTag(s) current
configuration

Prepare LogTag(s) for next use

Click on LogTag below to select
model(s) to be configured/show
LogTag's current configuration

SERIAL: COM7 3

Logging Parameters
Push button start

Serial Number

Settings from SN:1010080254

Certificate of Calibration

2]

LogTag Battery: OK

[ ] configure requires a password [ | Upgrade logger

v Enable pre-start loaging |

HAXO-8 SN:1010080254 @ ‘

_ \J Record readings continuously, overwrite oldest when memory full |
USB:03101C06 @Record readings 5o that:

HAXO-8 SN:1010080258 m Readings recorded will span at least 2 + | Days

| e ——_ | Number of readings to record 8000 | maximuf is 8003

USB:03101C06- Regord a reading every 00:00:30 = 30 Séconds.
HAXO-8 SN:1010080258 ’ =
[ — Begin recording after a delay of | 00:00:00 5 Noné.

LogTag USB-HID = Enable the OK (Green) indicator |
UTRID-16 SN:5040000038 D) -
_ Enable the Alert (Red) indicator, when:

LogTag USE-HD Readings below 0.0 % oraboye 000 3 |%RH
UTRIX-16 SN:5040000030 @ arer[ ] |2 + | consecutive alert readings (1 Minite)
W A!h?v::‘ 2 + | alert readings have occurred (1 Minute)

USRIC-4 SN:3999000002 e Leave alert indicator enabled even if readings return to non-alert range
I | [ ] Ciear and reset alert when START MARK button pressed
LogTag USB-HD—|
USRIC-8 SN:4035011749 =
——
‘ » Temperature Alarm Settings | Humidfty Alarm Settings
O’ Rescan o Configure Save Profile o Cancel o Help
|| Retain Description/Password \
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Command Buttons
In addition to the button, following other actions are available in this screen:

Rescan

Scans all connected interfaces and USB ports again. Click this button if you have inserted
additional USB loggers you wish to configure, or not all connected USB loggers appear in the
Progress Pane.

Save Profilg
You can save the parameters as entered to a Configuration Profile. Please see Configuration
Profiles on page 84.

Cance
ou can abort the configuration process by clicking this button.

Hel
Clicking this button brings up a browser window, showing help for this topic.

=<

I |

Repeat Configure

This button is available only after one or more loggers have been configured. Clicking this
button will scan all interfaces and USB ports for loggers again, and upload the entered
configuration data to each eligible logger.

Restart]
Click to start the configuration process from the beginning.

[Certificate of Calibration]
Click to view the logger's factory Calibration Certificate.

Recover logge

Click if a logger is to be recovered from a failed upgrade. Please see Recovering from a failed
firmware update for further details.

Depending on the possible actions, not all buttons may be shown. If a button is not shown, its
corresponding action cannot be performed.
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Progress Pane

Each logger found will be listed in the Progress pane. It is represented by its model number,
serial number and operational status, shown via different icons, which change once a logger is Interface Type
configured:

USB: 03101C06
When you see this icon displayed in the proiress bar, the parameters entered for configuration HAXO-8 SN:1010080258 ) m

will be applied to this logger when clicking
Progress Bar Logger Serlal Number

Figure 38: Progress Pane Indicator

When you see this icon, the logger will not be configured when you click since the
@ model is different from the one for which you have entered configuration parameters.

to single use loggers or loggers that have a locked configuration. You will see this for example

A logger showing this icon cannot be configured, as there are no trips remaining. This applies
on SRIC-4 or USRIC-8 loggers when you attempt to configure them for a second trip.

This logger has a low battery. Some models cannot be configured when they have a low battery.

started, or will start automatically, depending on the chosen start options.

E\ This icon is displayed after the logger has been successfully configured. This logger can now be
@ The progress bar will also show the word Configured

9 This icon is displayed after an unsuccessful attempt to configure the logger. Further error
r@ messages will be displayed to indicate why the logger was not configured.

advanced features that the software could not set. This typically happens if you try to configure
older and newer loggers together. When you hover the mouse over this icon you can see which
features were not set.

E\ This icon is displayed after the logger has been successfully configured, but the logger has some

While the software is sending the new configuration data to each logger, progress bars in the
Progress Pane will identify the loggers that are being configured.

Once finished the progress bar shows Configured. USB: 03101C06 P
If you use [Repeat Configure] to configure another logger, you may update its configuration haxo s swaoroosss ) — (TN

without having first saved previously recorded data. =
Configuration Complete

As soon as a logger is configured, previous data can no longer be downloaded. Please

Figure 39: Logger configured

ensure you have downloaded the readings before completing the configuring process to
avoid data loss.
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[f additional loggers of the same model have been located, these loggers will also be configured
with the new data.

If you enable Retain Description/Password, existing descriptions and passwords for each logger
will be retained, instead of using the details from the configuration parameters entered. Note
that you will still need to provide a password for loggers that have an active configuration
password protection. On loggers with WiFi capability the existing network password will also be
retained.

The next sections describe each configurable option; please note, however, that not every
option is present for each of the LogTag® models.

Instead of entering every configuration detail repeatedly, you can configure loggers using pre-
configured profiles, or prepare them for a new trip with the same configuration data as used
for just completed trip by using the quick re-configure function. For more details on these
options please see Configuration Profiles on page 84 and Quickly re-configuring a LogTag®
logger on page 78.

Working with more than one logger

At some stage you may need to perform a similar task on multiple LogTag® devices, whether it
is retrieving readings or preparing them for a new trip. LogTag Analyzer has been designed to
make working with multiple LogTag® units easy.

1. You can connect multiple interfaces to your PC, so more than one logger can be
configured or downloaded at the same time.

2. Use the Auto-download feature. To retrieve a copy of the recorded readings from multiple
LogTag® products, simply insert each one into the Interface cradle (or plug them into the
USB port). The software will automatically retrieve the recorded data, save it to disk and
then display the information for you (Automation on page 160). You can repeat this for
each product without needing to interact with the software.

3. Use the Repeat feature in the configuration window without having to re-enter the same
parameters more than once, even with different descriptions or passwords.

4. Use a pre-configured Profile (Configuration Profiles on page 84) or the Quick Reconfigure
feature (Quickly re-configuring a LogTag® logger on page 78)
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User Related Configuration Parameters

User related configuration parameters are entered at the top of the
Parameter Pane:

User Information
o Description: | Ward Il Vaccine Fridge
o D Configure reguires a password
o [[] Download requires a passviord

LogTag Battery: OK o

Description €

(optional)

This can be used for identification of the load in transit to be
monitored, or simply an identifier that describes the purpose of the
monitoring. Bill of Loading information, Shipper, commodity, contact
name and other relevant information can be placed here. For loggers
with two recording channels, such as the new UTRED30-16 and
UTRED30-WiFi, a separate description field will be shown for each
channel. This will make it easier to identify in the files which probe is
monitoring what environment.

Each description can be up to 38 characters long (36 for loggers with a
display) and can contain a mix of letters, numbers and special
characters. The selected input language of the computer's operating
system determines which special characters can be selected.

If a user decides to make use of special characters, extra information
about the language used is stored inside the logger. Users will then
need LogTag Analyzer 2.3 Release 7 or later so the User ID is correctly
displayed.

If you use the special character sets for languages such as Greek or
Chinese, the maximum number of characters that can be used will be
reduced due to the increased memory required to store the characters.

Please Appendix on page 195 for a more detailed explanation.

To view the PDF file generated by a USB logger, the fonts used
must be present on the receiver's computer. PDF Reader
software typically only installs a small number of fonts, none
of which support an extended character set. Therefore, you can
only use ASCII characters in the User ID field when configuring
a USB logger.

~

LogTag® Analyzer User Guide

Configure requires a password @

If you select this option, any user wishing to configure the logger in the
future must provide this password. A new entry field appears, where
you can specify which password you wish to use.

Passwords are case sensitive ("Bob" and "bob" for example are
different passwords).

[f you enter a new password, or change an existing password, you will
need to verify the password when you click .

If you use special character sets for languages such as Greek or
Chinese, the maximum number of characters that can be used will be
reduced due to the increased memory required to store the characters.
Please see the Appendix on page 195 for a more detailed explanation.

Due to the restrictions in the Description field you can only use ASCII
characters in the password field when configuring a USB logger.

Download requires a password @
If you select this option, the recorded data from the logger can only be
downloaded after entering the correct password.

Only one password can be provided for each LogTag® unit. The same
password applies to the Configure and Download actions.

Battery condition )

If the battery in the logger reports 'low', it should no longer be used.
The software will display a warning in the top right corner.

LegTag Battery: Low

Some LogTag® models display the remaining percentage in this screen
once it falls below half capacity. Some models cannot be configured any

longer once their battery capacity falls below a pre-determined
threshold.

Remaining Starts
If the logger you are configuring has a limited number of starts, this
will be indicated here.

Starts remaining: 1

page 53



Using LogTag Analyzer

Upgrade logger

Some loggers can be upgraded, to enable new features that were not
previously available. One example is permitting the "Password on
download" option for some logger models. Such an upgrade can be
applied by enabling Upgrade logger. Please note, however, that older
software will most likely no longer be able to communicate with the
logger once it has been upgraded.

Logging Related Configuration Parameters

Logging related configuration parameters are entered in the middle
section of the Parameter Pane:

Logging Parameters
Push button start

~  []Enable pre-start loaging o o Log channels:

o () Record maximum number of readings. ® :'t:
(O Record readings continuously, overwrite oldest when memory full O only
() CH2 only

o (®) Record readings so that:
Readings recorded will span at least 5

o Number of readings to record 8000

Days

maximum is 8,001
o Record a reading every |5 + | Minutes ud

o Begin recording after a delay of o + | Minutes =

start method @

(mandatory)

Click the field to set how and when a logger will start recording its next
trip.

Push button start =,

[Push button start

Push button start from hibernation
Date/Time start

« Push button start

When the 'Push button start' option is selected, the logger will start
recording when the START button has been pressed and held until
both the OK and Alert lights alternately flash on and off.

o Date/Time start
When the 'Date/Time start' option is selected, the logger will
automatically start recording at a specified date and time. Two
additional entry fields will appear, one for selecting the date, the
other for the time. Enable pre-start logging and Begin recording

LogTag® Analyzer User Guide

after... (delayed start) options are not available with a date/time
start.

Pressing the START button prior to the start date/time will have no
effect.

Note: When using the Date/Time start option, the start time
must be at least two minutes into the future. This delay
allows you to complete the remaining configuration options
and gives the software enough time to upload the
configuration to the device before it is due to start.

« Push button start from hibernation

When the 'Push button start from hibernation' option is selected,
the logger will start as if programmed for 'Push button start'. The
difference is that once the configuration is successfully uploaded to
the logger it will be placed into hibernation. When the START/Mark
button is pressed and held, the logger will wake from hibernation
and start recording with the parameters as configured.

Note: When using this start option, the real time clock
inside the logger is suspended until logging starts. When
downloading at the end of the trip, the reading times are
back-calculated based on the time of the computer on
which the unit is downloaded. It is therefore necessary that
computer is set to the correct time, so the downloaded data
have the correct date/time.

“ J

Please see Hibernation - Prolonging battery life on page 82 for more
information.

Not every LogTag® model can support every start mechanism. If a start
option is not listed during the configuration process, this option is not
available for this model.

Enable pre-start Iogginge

(optional)

When you enable Pre-start logging, the logger starts taking readings as
soon as the configuration data have been uploaded. If you forget to
press the START button, the data for the trip will still be available. This
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ensures no critical data are lost. This option is further explained in the
section Pre-start data collection on page 80.

Pre-start readings will not be recorded if the start method is
'Date/time" or 'Push button start from hibernation'.

Record maximum number of readings (3 )
(Profile only)

When you select this option in a profile, the logger fills the complete
memory with readings, and then stops. This feature is useful for
profiles that can be applied to products with different memory sizes,
for example the USRIC-8 and USRIC-16 models.

Record readings continuously, overwrite oldest when
memory full

(mandatory 1)

When you select this option, the logger initially fills the complete
memory with readings, then overwrites the oldest data when the
memory is full. For a more detailed explanation see Continuous
operation on page 79

Record readings so that: (5 )

(mandatory)

If this is selected, the logger stops logging taking after a pre-
determined number of readings. The following two fields determine the
time these recordings will cover.

Please note that some LogTag® logger models can be stopped
manually, so there may be fewer than expected readings.

1 You must select either continuous recording, or recording for a defined time span
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Readings recorded will span at least X days (50

(mandatory %)

If you know how many days of data you want to record, enter this
number here. The shortest possible recording interval that covers this
period will be automatically calculated, based on how frequently the
logger takes a reading.

Number of readings to record (maximum is Y) @

(mandatory)

This field will display the calculated number of readings if you select a
time period and an interval. Alternatively, you can select the number of
readings desired, and the time period will be calculated based on the
interval. Y represents the maximum number of readings the product
can store, however with a selected interval and a selected time span,
you may not need to use all of the available memory.

Record a reading every X 0o

(mandatory)

This determines how frequently the LogTag® records and stores
humidity or temperature values. Select seconds, minutes or hours, then
change the number to suit3, either by clicking the up or down arrows,
or by typing a number value directly.

If you want to use a log interval such as 1 minute 30 seconds,
enter the number in full seconds.

Begin recording after a delay of X (7

(optional)

Enter the time that passes after a user has pressed the START button
on the logger until the start of the recording. Select minutes or hourss3,
then change the number to suit, either by clicking the up or down
arrows, or by typing a number value directly. This feature is useful for
example, when the logger could falsely trigger an alert because the

2 The entries are interdependent, changing log interval may change the number of days the logger can
take readings for
3 Different models support different minimum/maximum log intervals and start delays. Please refer to

the individual models' data sheets for more information.
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environmental conditions to be monitored are quite different to the
environment in which it is started.

If pre-start logging is enabled, the LogTag® logger will still
continue to record pre-start readings during this delay period.

Log Channels 0

(mandatory, only for Dual-Channel loggers)

This option is displayed only for Dual-Channel loggers, such as the new
UTRED30-16. Here, you can select which of the channels you wish to
record. When you select CH1 only, the logger records temperature
values only for the probe connected to the socket marked CH1, while
CH2 only records only the probe plugged into CH2. Both means that
both channels will be recorded. This is also the ex -factory default.

Note that the number of activated channels has no influence
on the number of readings you can record. This will remain the
same, no matter how many channels are activated for
recording.

You will not be able to retrieve any readings from a channel
that is de-activated. If you select CH1 only, and plug the probe
into CH2, no readings will be recorded if no probe is plugged

into CH1. We therefore recommend to leave this settings on
, unless you have specific reasons to de-activate one
channel.

LogTag® Analyzer User Guide
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Configuring Alarms

All LogTag® loggers can display a visual alert if one or more configured
alarm trigger conditions have been met. Some models also have the
option for the alarm to be audible (see Audible Alarm as described on
page 60). Each alarm trigger condition consists of a threshold value, an
activation type (which can be instant, consecutive or accumulative 4)
and a delay time, if it is not an instant alarm.

If an alarm trigger condition requires readings to exceed an upper
threshold temperature it is called an upper alarm. If an alarm trigger
condition requires readings to go below lower thresholds it is called a
lower alarm.

The threshold parameters are shown in LogTag Analyzer when the
logger's readings are downloaded and displayed.

Alarm related configuration parameters are entered in the bottom

section of the Parameter Pane:
. Value Sliders |
‘I\:I\:I‘l‘:l\:\:l\:o:\:I\l\:l\:ll:\i:\::li\::‘HI:\I:\:‘II

Readings below -200 = orabove 500 * °C
o After[] |2
o aer[] ]2

o [[] Leave alert indicator enabled even if readings return to non-alert range
I:] Clear and reset alert when START MARK button pressed

‘ Ternperatureilzrm Settings | Humidity Alarm Settings

| [7] Enable the OK (Green) indicator

Enable the Alert (Red) indicator, when:

< | consecutive alert readings (None)

% | alert readings have occurred (None)

Parameter entry

Temperature Alarm Settings Humidity Alarm Settings

4

« Instant = one temperature reading is above (below) the threshold

« Consecutive = temperature readings are above (below) the threshold for the time defined in the
activation delay without interruption

« Accumulative = temperature readings are above (below) the threshold for the total time defined in

the activation delay time, but may not necessarily be sequential.

LogTag® Analyzer User Guide

You will find one or more tabs, depending on the logger model you
wish to configure. Click the tab's label to show the parameters for that
tab.

HAXO-8, HASO-8 and UHADO-16 loggers show two tabs, one for
temperature alert conditions, one for humidity. Dual-channel loggers
also display two tabs, so you can configure different alarm settings for
each channel.

Note that some values apply to both tabs simultaneously, such as the
OK indicator field.

Standard Alert Related Configuration Parameters
Enable the OK (Green) indicatora

This determines whether or not the green LED should blink while the
LogTag® is recording. This is not available for display products.

Enable the Alert (Red) indicator when... 0

This defines whether or not the red light should activate when an alert
condition has been detected. An alert occurs when one or more of the
conditions described below have been met. When an alert condition has
occurred, this indicator will flash at a regular interval.

Readings below X or above Y (inclusive) 9

You can set the upper and lower threshold limits by typing the
appropriate information directly in the boxes, or by moving the value
slider, or a combination of both. If readings stay inside the range
specified by X and Y the alert indicator will not activate. If a reading of
X and below, or Y and above is recorded, the alert indicator may light
up, depending on the alert conditions. Charts will display alert readings
according the settings made in the Charts section of the Options
Screen.

The values entered in these boxes are included in the alert range. In
the example later in this section 7 consecutive readings of 45 °C will
trigger an alert, whereas 7 consecutive readings of 44.9 °C will not
trigger an alert. Please set your alert values with this in mind.

Some logger models allow you to enable upper and lower alerts
independent of each other; this is useful in situations where one of the
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alert thresholds is irrelevant to your recordings and, if left activated,
may falsely activate the alert LED. In this case there will be one check
box for each alert.

After X consecutive alert readings (W minutes) 0

Tick this box and enter a number into the adjacent field if you want to
trigger an alert condition once X number of consecutive alert readings
are recorded. Note that the number of minutes shown will depend on
the number of alert readings you enter into the box AND the recording
interval already specified. For example, if X is 3 and two readings are
above the upper threshold limit, but the subsequent reading is below
the upper threshold limit and still above the lower threshold limit then
the alert indicator will not activate. Maximum value is 256, minimum is
2.

After X alert readings have occurred (W minutes) o

Tick this box and enter a number into the adjacent field if you want to
trigger an alert condition once a total number of alert readings have
been recorded, regardless of whether they are consecutive or not.
Maximum value is 256, minimum is 2.

You can increase or decrease the values with the arrows next to the
fields. Please note these are linked and certain combinations may not
be allowed.

Leave alert indicator enabled even if readings return within alert range

If this option is enabled, the alert indicator will remain active, even if
the current reading does not meet the alert conditions specified by the
previous controls.

If this option is disabled, the alert indicator will remain active only if
the current reading meets the alert conditions specified by the previous
controls.

Please note, however, that this setting is only applicable if an
immediate alert is configured; if consecutive or accumulative alert
settings are configured this box has no effect, and the alert indicator
will always remain visible once an alert has occurred.
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Clear and reset alert when START MARK button pressed 0

If this feature is enabled, any user can turn off an active alert by
pressing the START/MARK button directly on the device. This will also
reset the internal alert counters as if no alert condition had occurred at
all while the LogTag® was recording.

Should the logger subsequently detect a further alert condition, the
alert will activate again.

Once the LogTag® has finished recording, pressing the START/MARK
button will not clear and reset any active alert.

If the LogTag® being configured does not support this feature, it will be
disabled and its setting cannot be changed.

Example:

You wish to configure a LogTag® so alert conditions are indicated if 5
continuous readings are out-of-range or 7 total readings are out-of-
range. Alert parameters should be set as follows:

[Z]Enable the O (Green) indicator
B S P T T e e e e
Readings below 0.0 = orabove 450 I °*C

Afer[7] |7 S | consecutive alert readings (35 Minutes)
After[&] 10 < | alert readings have occurred (50 Minutes)

[¥] Leave alert indicator enabled even if readings return to non-alert range

[[JClear and reset alert when START MARK button pressed

| Temperature Alarm Settings

This table shows how different conditions would result in the Alert
Indicator flashing or not:

Table 11: Alert examples
What the LogTag® recorded  What the LogTag® indicated

2 readings out-of-range, return  Neither alert condition is met.

to normal, 2 readings out-of- The maximum number of consecutive out-

range, return to normal, 2 of-spec readings is only 2 (5 required.)

readings out-of-range, return to The total out-of-range events equals 2 + 2

normal + 2 = 6. The alert condition is 7 total, so no
alert is triggered.

No Flashing Red Alert Indicator
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What the LogTag® recorded  What the LogTag® indicated

4 readings out-of-range, return  The first alert condition is not met, as the

to normal, 4 readings out-of- maximum number of consecutive alert

range condition readings is only 4 (5 required.)
The second alert condition however IS met
since the total alert condition readings
equals 4 + 4 = 8. The alert condition is 7
total. so the alert IS triggered.

Flashing Red Alert Indicator

4 readings out-of-range, return = Neither alert condition is met.

to normal, 2 readings out-of- The maximum number of consecutive alert

range condition readings is only 4 (5 required.)
The total number of alert condition
readings equals 4 + 2 = 6. The alert
condition is 7 total, so no alert is triggered.

No Flashing Red Alert Indicator

6 readings out-of-range, return  The second alert condition is not met, as
to normal the total out-of-range events equals 6 (7
required.)
The maximum number of consecutive alert
condition readings however is 6, the alert
condition is 5 consecutive readings, so the
alert IS triggered.

Flashing Red Alert Indicator
Please note following special conditions:

1. If you wish an alert to be indicated on the first reading that is
recorded out-of-spec, place a tick in the box next to "Enable the
Alert (Red) indicator when" and remove the ticks in both boxes
next to the "After X consecutive alert readings" and "After X
alert readings have occurred".

2. You cannot enter a number into the "After X consecutive alert
readings" field which is larger than the number in "After X alert
readings have occurred", since the latter alert condition would
always be met first.

3. Similarly, you cannot enter a number into the "After X alert
readings have occurred" field which is smaller than the number
in "After X consecutive alert readings". The software will adjust
field values as appropriate.

LogTag® Analyzer User Guide

Advanced Alert Settings

Some loggers support more detailed alert settings than described
before. If LogTag Analyzer encounters one of these loggers, additional
tabs are visible in the Parameter Pane:

Temperature Alarm Settings | Advanced Alarm Settings
You can access the extra tab by clicking on the tab's label.

In the advanced settings the red alert indicator can now be configured
independently for upper and lower alert values.

Readings above X
Readings below Y

(inclusive)

In addition to entering the threshold levels, tick the boxes next to
"Readings above" or "Readings below" to enable the alert conditions
for only the upper or only the lower threshold settings, or for both. If
both boxes are ticked, the behavior is the same as for the standard
alert settings. The charts will display alert readings according to the
settings made in the Charts section of the 'Options' Screen.

After X consecutive alert readings (W minutes)
Readings above
Readings below

Tick the boxes next to "Readings above" or "Readings below" to
establish whether only readings above and including the upper
threshold or only readings below and including the lower threshold
should count towards the consecutive alert readings. If both boxes are
ticked, the behavior is the same as for the standard alert settings. If
the Alert Indicator is disabled for either the upper or the lower alert,
the respective box for the consecutive alert is grayed out and cannot be
ticked.

After X alert readings have occurred (W minutes)
Readings above
Readings below

Tick the boxes next to "Readings above" or "Readings below" to
establish whether only readings above and including the upper
threshold or only readings below and including the lower threshold
should count towards the total number of alert readings. If both boxes
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are ticked, the behavior is the same as for the standard alert settings. If
the Alert Indicator is disabled for either the upper or the lower alert,
the respective box for the alert total is grayed out and cannot be ticked.

The advanced settings tab is displayed automatically if an advanced
configuration is already found in the logger to be configured. If you do
not wish to use the advanced settings, click the Temperature Alarm
Settings tab.

Example:

You wish to configure a LogTag® so an alert is displayed if 5 continuous
readings are out-of-range or 7 total readings are out-of-range, but
only if the temperature goes to 20 °C and above. You wish to see in
LogTag Analyzer if the product has gone to 0 °C and below, but you do
not wish to trigger an alert for this condition. Alert parameters should
be set as follows:

[] Enable the OK (Green) indicator

Readingsabowe [¥] 200 2 | ¢
Enable the Alert [Red) indicator, when:
i) * Readingsbelow[¥] 0.0 2|+
After |2 = | [JReadings above Atter |2 = | [[JReadings above

[ Readings betow
consecutive alert readings (None)

[JReadings below
alert readings have occurred (10 Minutes)
[¥] Leave alertindicator enabled even if readings return to non-alert range

[[] Clear and reset alert when START MARK button pressed

Temperature Alarm Set‘t:l‘gs- Advanced Alarm Settings
Figure 41: Advanced Alert Settings - Sample settings

The following table shows how different conditions would result in the
Alert Indicator flashing or not:

Table 12: Advanced alert examples
What the LogTag® recorded  What the LogTag® indicated

2 readings of 20 °C or above, Neither alert condition is met.
return to normal, 8 readings at ~ The maximum number of consecutive out-
0 °C or below, return to normal, of-spec readings is only 2 (5 required, the 8
4 readings of 20 °C or above, readings below 0 °C do not count towards
return to normal alert readings).
The total out-of-range events equals 2 + 4
= 6. The alert condition is 7 total, so no
alert is triggered, as again the 8 readings
below 0 °C do not count towards alert
readings.

No Flashing Red Alert Indicator

LogTag® Analyzer User Guide

What the LogTag® recorded  What the LogTag® indicated

The first alert condition is not met, as the
maximum number of consecutive out-of-

spec readings is only 4 (5 required.)

The second alert condition however IS met
since the total out-of-range events equals
4 + 4 = 8. The alert condition is 7 total. so

the alert IS triggered.

Flashing Red Alert Indicator

4 readings of 20 °C or above,
return to normal, 4 readings of
20 °C or above

Separate alert conditions are useful if you expect the monitored product
to encounter temperatures lower than the lowest possible alert
temperature. In this case a flashing alert indicator may not necessarily
indicate an unfavorable condition was encountered. In programs where
such conditions are monitored the lower alert should be turned off.

Audible Alarm

This option is available in TRED30-16R, UHADO-16, UTRED30-16 and
UTRED30-WIFI loggers and can be found in the Advanced Settings or
the Alarm Settings tab. When you enable this option, the logger will
sound an audible alarm when an alarm is triggered. Please refer to the
Product User Guide or Data Sheet of your specific model to establish if
it has a beeper fitted.

Please note, that continual activation of the audible alarm will
reduce the working life of the battery. When an alarm event is
triggered, the alarm should be cleared as soon as possible.
Please refer to the respective Product User Guides for more
information.

Display Logger Advanced Settings

The Alarm settings in loggers with a display (TRID30, TRED30, TRED30-
16R, TREL30-16, UHADO-16, UTRID-16, UTRED-16, UTREL-16, USRID-
16, UTRED30-WIFI, UTREL30-WIFI, UTREL30-16 and UTRED30-16
loggers) are similar to the Advanced Alert Settings on the previous page
or the USB Logger File settings on page 66, hence they are not
explained again here.

The loggers do, however, have an additional configuration tab.

Alarm Settings | Advanced Settings
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When you select this tab, you can access the settings specific to the
display:

|~ Advanced alam options
o‘ [C]Clear and reset alarm when STOR/Clear button pressed

o [[] Alarm remains on even if readings return to non-violation range
o [[] Pause alarm/statistics processing for 0 2 readings when button pressed (None)
| —Advanced logger options
|
|| [ switch off display after 30 seconds (Power save)
oi ] Show total summary days collected
|

o [J Allow logging stop with STOP button
o [[] Allow reset of logger with START button

[ Show user resettable Min/Max (if supported) o [[] Enable Quick start/stop mode (if supported)

Alarm Settings | Advanced Settings |

Figure 42: Advanced alert options for display loggers

Clear and reset alarm when STOP/CLEAR button pressed (1
If this option is enabled, any user can turn off an active alarm directly
on the device by pressing the STOP/Clear button. This will turn off the
alarm symbol and reset the internal counters as if no alarm had
occurred while the logger was recording. When the logger subsequently
registers a further alarm condition, the alarm will activate again. Once
the logger has finished recording, pressing the STOP/Clear button will
not clear and reset any active alarm.

An alarm will always be registered in the day summary and
cannot be cleared, regardless of whether the alarm symbol was
cleared or not.

Alarm remains on even if readings return to non-violation

range ®

If this option is enabled then the alarm symbol will stay on, even if the
current reading does not meet the alarm conditions specified by the
previous controls.

If this option is disabled, the alarm symbol will only stay on if the

current reading meets the alarm conditions specified by the previous
controls.
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Please note: Unlike for units without a display these settings
also apply if consecutive or accumulative alert settings are
configured. If the Alarm conditions are no longer met, all
counters are re-set and an alarm is triggered when the alarm
condition is met again. In any case, an alarm will be registered
in the day summary, regardless whether conditions re-set or

not.
(. J

Pause alarm/statistics processing for X readings (3 )

If this option is enabled, pressing either button on the device while
recording excludes the next reading from the alarm and statistics
calculations; PAUSED will now be shown on the display. This allows the
user to review the statistics or clear an alarm without causing an
invalid reading, alarm or statistic.

Switch off display after 30 seconds O
If this option is enabled, the display will turn off after 30 seconds to
save battery power.

Show total summary days collected (5

If this option is enabled, the display shows the number of days for
which statistics have already been collected.

Please refer to the LogTag® Product Specification & User Guide
documents for TRID30,TRED30 and TRED30-16R loggers on the LogTag
North America Inc website at https://logtagrecorders.com/product-
range/ for a detailed description of the functionality of these products.

Note: When referring to TRID30 and TRED30 products, versions
with both the fixed (F-suffix) and replaceable (R-suffix)
battery are included, unless a suffix is specifically mentioned.

For more information please refer to the UTRID-16 PDF Recorder User
Guide, available from the LogTag North America Inc website.
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Show user resettable Min/Max (if supported) 0o

This option only applies to newer TREL30-16 and TRED30-16R models.
These devices can display trip min/max settings in addition to the daily
min/max settings. If you enable this setting, these min/max settings
will be displayed when you review the day statistics. The min/max
values can be reset any time while the unit is logging. For more
information please refer to the Product User Guides for the relevant
products.

Allow logging stop with STOP button (1)

[f this option is enabled, the logger can be stopped by pressing the
STOP button. It will no longer take any readings, however, you can still
review the day statistics and download the logged results to a PC with
LogTag Analyzer.

Allow reset of logger with START button 0o

If this option is enabled, TRID30, TRED30 and TRED30-16R loggers can
be reset to the same conditions as if they had been freshly configured
by LogTag Analyzer. You can then start another trip by simply pressing
the START button.

When this option is enabled, anyone with access to the
logger can erase all recorded readings and statistics without

saving the data to a PC first. Please use this option with
caution!

A warning box will be displayed to remind you this is enabled and can
result in loss of data.

Warning: Enabling the ‘reset with START button' option allows
the user to erase all recorded readings and statistics. Are you
sure you want to continue?

Enable Quick start/stop if available (o )
This option only applies to TRED30-16R models. If enabled, starting
and stopping a TRED30-16R is faster than that of TRID30 and TRED30.

LogTag® Analyzer User Guide

Instead of holding the start button for 6 seconds (TRID30 and TRED30),
you will only need to press the button for approx. 1 second until the
unit starts or stops. For more detailed information please refer to the
TRED30-16R User Guide, available on the LogTag North America Inc
website at https://logtagrecorders.com/product-range/.

If disabled, the standard start/stop method (6-second button press) is
used.

Show alarm screens during review

(not shown in sample screen)

This option only applies to the UTRID-16. If selected, up to 6 additional
screens are shown when reviewing the data on the display. These
screens show the temperature alarm threshold, and the time above or
below that threshold. If the box is cleared, only the minimum and
maximum screens are shown.

For UHADO-16, UTRED30-16 and UTRED30-WIFI models trip min/max
settings are permanently being shown on the display. If you enable this
setting, a user may reset the min/max values any time while the unit is
logging.
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Additional Features for TRED30 and TREL30 models
These models show a further tab, where you can enable additional features for this product:

2]

[[]Sound alarm if not inspected by [] Show additional display text
Mon Tue Wed Thu Fri Sat Sun (®) Show total summary days collected
9:00:00 AM & ] [ ) show Fridge Symbol

() Shows Freezer Symbol

Inspection Alarms Display Settings

Smart Probe
(O Enable Standard Probe  (8) Enable Smart Probe

Alarm Settings Advanced Settings | Additional Features ‘

Figure 43: Inspection alarms and fridge/freezer symbols
Inspection Reminder Alarm o

When enabled, this alarm triggers when the logger's REVIEW/Mark button was not pressed
between midnight and the time entered, on the selected days. Once triggered, the buzzer will
sound and the time digits will blink until the alarm is cleared by pressing REVIEW/Mark.

[f the REVIEW/Mark button was pressed, no alarm will occur for that day.

In the screenshot above, the alarm would be activated if the REVIEW/Mark button has not been

pressed by 9:00am on weekdays. The alarm would not trigger on weekends as it has not been
enabled in the configuration.

[f the feature is disabled, an Inspection Reminder Alarm will not trigger.

The feature is also available in the advanced options for a configuration profile and is carried
forward during quick-reconfigure. If a profile with an enabled Inspection Reminder Alarm is
used to configure a TRED30 or TREL30 that does not support this feature, you will see the
familiar warning triangle, reminding you that not all loggers will have been configured with
this feature (see the table of icons on page 51).

Fridge/Freezer Indicator o
On the display you can show the number of days for which statistical data are stored in

memory. For newer models you can select if you wish to show this number, or instead a
symbol, indicating if the logger should be placed in a fridge (Fd) or a freezer (Fr).

To enable this feature, select Show additional display text and select one of the three options.
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Simply selecting the display of the fridge or freezer symbol does not change any
temperature alarm levels. Please make sure you have selected appropriate temperature
alarm trigger conditions that correspond to the symbol you have selected to avoid
incorrectly placed loggers.

If you disable this feature, no text will be shown on the recording display.

The feature is available in the advanced options for a configuration profile, and is also carried
forward when using the quick-reconfigure function. If a profile, that has the fridge or freezer
symbols enabled, is used to configure a model that does not support this feature, you will see
the familiar warning triangle, reminding you that not all loggers will have been configured with
all features enabled. Enabling this feature and selecting Show total summary days collected will
also work on earlier units.

0 For more information about these features and screen samples please refer to the
TRED30-16R or TREL30-16 Product User Guides.

| J

You will require LogTag® Analyzer version 2.9 or later to configure and download
loggers with these features.

(& J

Enabling Smart Probes°

This section of the window will only be shown for the new TRED30-16CP and TREL30-16CP
loggers, which support the new CP110 and CP11 Smart Probes. Unlike the UTRED30-WiFi and
UTRED30-16 models, you must select which probe you will use with the logger during the
configuration process.

If your probe features a small case as shown below, it is one of the new Smart Probes. You
must enable the Smart Probe feature so your logger records temperature data.

| LogTag - . ) —
< SMART PROBE B
—— S/N: 9829091048 -
iRy |

Use with TRED30-16CP O
o pere e gy {0t

Figure 44: CP110 and CP11 Smart Probes for TRED30-16CP and TREL30-16CP Loggers

If your probe does not have such a case, it is a standard (analogue) probe, and you must enable
the standard probe.
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If you enable the feature without using a Smart Probe, or vice versa, you will not record

the correct temperature!

How is my calibration affected when swapping probes?

Probes of the same type can be swapped during recording, however, you will need to observe
some rules if you wish to maintain a calibrated system:

« You can swap one Smart Probe with a different one without re-configuring the unit. If the
new probe is calibrated, the complete logger and probe system will remain calibrated.

« You can also swap one standard probe with a different standard probe, however, to maintain
system calibration the logger and probe will have to be re-calibrated as a system.

If you swap a Smart Probe with a standard probe you will need to re-configure the logger,

select "Standard Probe" during configuration and also re-calibrate the system if required.

If you swap a standard probe with a Smart Probe you will need to re-configure the logger

and select "Smart Probe" during configuration. If the probe itself is calibrated, re-
calibration of the system is not required.
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USB Logger File settings

LogTag Analyzer allows you to set additional options for USB loggers,
which decide:

« which type of files are generated at the end of the trip

« settings for time, temperature units, MKT parameters and

« how the individual elements of the generated PDF file will be
displayed.

LogTag® Analyzer User Guide

Note: The appearance of the PDF file can only be defined
during configuration of the logger. It is not possible to alter
the appearance once the USB logger has completed its trip.

o [¥] Generate data list Date Format Time Format Scale ¥ Axis
] Show upper alarm line © DDMMAY ® 12-hour (am/pm) | | @ Range of readings
[ Show lower alarm line O MM/DD/YY () 24-hour O Range of sensor
o () Minimum range

[] Show ¥ axis grid lines
[[] Show X axis grid lines
€ Osrowmiar 31450 | ymol

POF temperature unit: Celsius n UpperLimit: 10 ©

PDF Language: English hd - B
S o Lower Limit: = 0.0

[ Use local PC time zone (UTC =13:00)

PDF Time Zone:
o Files to generate: [Z]FOF [JLTD [JCsV

File Settings |

Figure 45: File Settings tab for USB loggers

Generate Data List §)

The PDF file always contains a one-page overview report. Please refer
to the individual USB Product guides for information about the
contents of the report.

Select this check box to show additional data list pages with a single
row for each reading, along with the with date, time and temperature

values, plus any special events that were recorded against this reading.
When you clear this box only the report summary page will be created.

Alarm and Grid Lines @

To assist with orientation on the chart, several lines can be shown or
hidden. Following options are available:

Show upper alarm line
Show lower alarm line

Select which alarm line will be displayed on the PDF. Clear the boxes if
you don't wish to see the alarm lines.

The chart will not automatically zoom to include the alarm
lines, if they lie outside the selected Y-axis scale. If you wish
to always see the alarm lines, set a custom range Y-axis zoom
which includes the alarm values.

Show Y-axis grid lines
Show X-axis grid lines

Select which grid line will be displayed on the PDF. Clear the boxes if
you don't wish to see the grid lines.

The position of the grid lines is automatically determined; it depends
on the Y-axis settings and the time span covered by the readings.

Show Mean Kinetic Temperature (MKT)o

Selecting this box calculates and displays the MKT value on the PDF
report. If selected, you can accept the suggested default value of the
Activation Energy of 83.144 KJ/mol, or type a custom AH value in the
text entry field. This value is then used for the MKT calculations.
Typical values range from 60.000 to 100.000 KJ/mol.

When you use LogTag Analyzer to download a USB logger, the custom
value can also be used for the MKT calculations in the software. This is
controlled by a setting in the customization for the Mean Kinetic
Temperature (on page 136)

Regional Settings @)

This group of parameters allows you to customize regional settings of
the PDF report. Usually, this would be set to the region of the person
evaluation the data.
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Date format

Select one of the options that corresponds to the date format you wish
to use for the PDF report. You can choose between DD/MM/YY and
MM/DD/YY formats.

Time format

Select one of the options that corresponds to the time format you wish
to use for the PDF report. You can choose between 24- and 12-hour
(am/pm) formats.

PDF Language

Select the language of the PDF generated by the logger. Available
languages are:

« English

« French

« German

« Russian

« Spanish

Please note that this feature is only available on newer models. If you
are unable to select a language other than English during configuration,

the feature is not available for your logger. The unit's display always
shows English characters regardless of the chosen language.

PDF Temperature units

Select the temperature units used on the PDF report and in the CSV file
from the list. For USB logger models with display this also sets the unit
shown on the display. It is not possible to configure different units for
PDF and Display, or to configure this after the trip has completed.

PDF Time Zone

You can clear the Use local PC Time Zone box and choose a different
time zone. This is useful if you ship to receivers in a different time
zone and you wish them to see the times in their local time.

If you choose your own time zone settings, you will need to adjust the
time zone for daylight saving yourself. For example, if you want the

LogTag® Analyzer User Guide

PDF data to show the correct time for a user in New York, set the time
zone to UTC - 5 during Standard Time and to UTC - 4 during Daylight
Saving.

Note: The time zone displayed in the PDF cannot be adjusted
by the receiver! To view the logger's data in other time zones
the receiver will need to download it with LogTag Analyzer and
adjust the displayed time zone. See Date and Time Format on
page 182 for further details.

Use local PC Time Zone

When selected, the PDF file will display times and dates in your local
PC's time zone. The time is automatically adjusted for daylight saving.

Chart Scaling @

These settings control the zoom level of the chart display. Please note
that you cannot zoom the date/time axis of the chart.

Y-axis scaling

Select one of the available options to scale the temperature axis for the
chart of the recorded readings.

« Range of readings; this scales the chart area, so the highest and
lowest temperatures recorded are displayed at the top and bottom of
the area. If you choose this option, the maximum screen area is
used to display all recorded readings.

« Range of sensor; this scales the chart to show the full temperature
measurement range of the logger.

« Minimum range: When you select this option, the entry fields for
the two temperature values become active. Enter the values you
wish to use as maximum and minimum values for the chart's y-
axis. This is useful if you wish to easily compare readings from
multiple loggers in similar environments.

If readings outside your selected range are recorded during
the trip, the scaling is adjusted so the chart always displays
all recorded readings.
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RH-axis scaling

For UHADO-16 loggers, two Y-axis scales are displayed, one for
temperature (left) and one for humidity (right). The scaling selection
made here affects the RH scale only, the temperature is adjusted to
suit.

« Range of readings; this scales the chart, so the maximum and
minimum recorded humidity values are displayed at the top and
bottom of the area. If you choose this option, the maximum screen
area is used to display all recorded readings.

« 0-100%; this scales the chart to show the full humidity range of the
logger.

o Minimum range: When you select this option, the entry fields for
the two humidity values become active. Enter the values you wish to
use as maximum and minimum values for the chart's RH-axis. This
is useful if you wish to easily compare readings from multiple
loggers in similar environments.

If readings outside your selected range are recorded during
the trip, the scaling is adjusted so the chart always displays
all recorded readings.

Files to generate )

Select which file type the USB logger should automatically create when
plugged into a USB port. Once generated, the files will be accessible on
a read-only drive or mounted device via your file system.

The files created by the USB logger are not automatically
copied to a permanent storage volume on your computer. If
you wish to retain the files you need to manually copy them to
a location such as your Documents folder.

If you clear all check boxes, no files will be generated, and you will
need to access the data with LogTag Analyzer.

USB Loggers
There is a short delay after a USB logger is plugged in, before it can be
accessed by LogTag Analyzer. The logger starts a registration process
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with the operating system called USB Device Enumeration. It will take a
few seconds while the operating system loads the required drivers.

« If LogTag Analyzer is running when a USB logger is plugged in, the
file generation that usually takes place is suppressed to allow fast
communication with the software.

« If the software is not running, the logger now generates the on-
board files it has been configured for. This process can take some
time, especially if the unit has a full memory buffer and has been
configured to create PDF, CSV and LTD files. While the files are
being generated, the green LED is permanently lit. Loggers with a
display show a blinking USB symbol, or the word 'busy'.

If you need to access the files, and LogTag Analyzer is running, please
close the software and wait for the on-board files to be generated.
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Multi-Alarms in USB Loggers

USB loggers can be configured for up to 6 different alarm trigger Temperature
conditions, depending on the model.

o All USB logger models have a primary upper and a primary lower

alarm. For some loggers such as USRIC-4, USRID-16 and some older

USRIC-8 and UTRIX-16 models these are the only alarms available. Upper threshold /_%l_aErP_é___
« USRIC-8, UTRIX-16, USRID-16W, UTRED30-WIFI and UTRED30-16

allow four freely configurable alarms in addition to the primary PP O o ..

upper and lower alarms, for a total of 6 temperature alarms.

o UTRID-16 and UTRED-16 allow two upper and two lower alarms in
addition to the primary upper and lower alarms, for a total of 6 Primary upper threshold
temperature alarms.

« UHADO-16 allows two freely configurable temperature alarms in Non-alarm range
addition to the primary upper and lower alarms, for a total of 4
temperature alarms. It allows a single primary upper and lower Primary lower threshold
humidity alarm, but each alarm can be configured with different,
independent delay values. Lower threshold Alarm3 ~ [FEEEEEmmmmmmmmEEEEE R

Initially, start with the primary upper and lower alarms trigger
conditions and activate additional conditions separately. For each
threshold value you enable, you can set the usual values such as
threshold temperature, activation type and alarm delay value.

Primary upper alarm range

Primary lower alarm range

Figure 46: Alarm ranges for USRIC-8M

You need to observe some basic rules when entering alarm conditions
into the configuration screen in LogTag Analyzer:

« A primary upper alarm must be entered before more upper alarms

b ¢ d Fourth Upper Alarm (6} [ oo Z|=c After [] 2
can be entered. Third Upper Alarm (5) [ 150 2= After [¢] 6 Z | |Accumulative ~ | violation readings (30 Minutes)
« A primary lower alarm must be entered before more lower alarms Second Upper Alarm (4) Wloo Si-c  ane@pz S acomatve [ vioiation madings 1 Hou)
can be entered Primary Upper Alanm e [ 8o Zlec After [#] 12 % | |Consecutive ~ | violation readings (1 Hour)
. . Primary Lower Alarm Lower | [&] 2.0 Bl After 12 > | Consecutive ~ | violation readings (1 Hour)
« Any additional upper alarms must have higher threshold values Second Lowes Alarm (3) Hoo Elc  ate[P

than any previously entered alarm.

» Any additional lower alarms must have lower threshold values than
any previously entered alarm. Figure 47: Representation in LogTag Analyzer

« You can enter a different number of upper and lower conditions, or
only upper, or only lower conditions, or none at all. You can,
however, not make all alarms upper alarms, and you cannot make
all alarms lower alarms either.
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« Threshold values for adjacent alarms can be equal and combined
with different alarm types and delay time values. For example, you
can enter a primary upper alarm with an 8 °C threshold and 10
accumulative readings, plus an alarm with an 8 °C threshold and 5
consecutive readings. In this instance the alarm will be triggered, if
either 10 readings in total are above 8 °C, or 5 consecutive readings
above 8 °C have occurred.

Any alarm condition that is activated will be shown on the PDF and in
the software.

Dual-Channel loggers

For Dual-Channel loggers, two alarm tabs are presented, one for each
channel. All alarm parameters are set individually for each channel,
except that the red Alert LED will light and the buzzer will sound as
long as one of the channels still has an active alarm.

1
| CH1 Alarm Settings [ CH2 Alarm Settings  File Settings  Advanced Settings

If only one of the channels is activated in Log Channels, you cannot
enter data into the tab for the other channel.

USRIC-8M and UTRIX-16M models

For a short period in 2017, USRIC-8 and UTRIX-16 models with
multiple alarm threshold values were sold with the suffix M after the
model name, i.e. USRIC-8M and UTRIX-16M. Effective November 2017
this suffix has been dropped from the model designation, and USRIC-8
(from serial number 5035127752) and UTRIX-16 (from serial number
5040022407) now support multiple alarm threshold values. Models
without the M suffix delivered before this date only allow simple alarm
settings with one upper and one lower alarm (they can also not be
upgraded).

If you are configuring earlier USRIC-8 and UTRIX-16 models
that do not support multiple alarm thresholds you will not be
able to select the [Advanced Alarm Settings]

For any loggers that do not support the advanced alarm
settings, only primary upper and lower alarms will be set. The
remaining alarms will be disregarded.
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Figure 48: Entry line for alarm trigger conditions

Delay Value

Atter[¥] 6
Ater[+] 12 alert readings have occurred (1 Hour)

Figure 49: Entry line for RH alarm trigger conditions

%

@
o
r

|

Threshold value

n

consecutive alert readings (1 Hour)

80 I |%RH

s
-
-
-

r

Threshold value



Additional Features for TRED30 and TREL30 models

For UTRID-16, UTRED-16 and UTREL-16 loggers a slightly different
screen is shown. Here, the alarm symbols that appear on the LCD are
depicted next to the entries in the software. The rules above are the
same with one notable addition; a maximum of three upper and three
lower alarm conditions can be entered.

The way alarms are shown on loggers with a display depends
on the model. Please refer to the particular model's product
user guide for information on what symbols will show with
what alarm.

LogTag® Analyzer User Guide

Temperature
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Tertiary upper alarm range

Secondary upper alarm range

Primary upper threshold

Primary lower threshold

Tertiary lower threshold

Figure 50: Alarm ranges for UTRID-16

Primary upper alarm range

Non-alarm range

Primary lower alarm range

Secondary lower alarm range

Tertiary lower alarm range

Tertiary Upper Alanm f A
Secondary Upper Alamny. 4 A
Primary Upper Alanm A

Primary Lower Alarm v
Secondary Lower Alaimn ‘v
Tertiary Lower Alarm ¥Y

150 7 |°C After [] 2 - | [Accumulative -

100 5 |°C After 12 > | | Accumulative ~ | violation readings (1 Hour}

8.0 = After 12 > | |Consecutive ~ | violation readings (1 Hour}

2.0 = After 2 > | |Consecutive ~ | violation readings (10 Minutes)
0 7| After [+] 2 * | |Accumulative = | violati dings (10 Mi

05 7 )eC after [] 2 = -

Figure 51: Representation for UTRID-16
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Updating USB Loggers

Starting with version 3.1 release 10, LogTag Analyzer allows the option to update USB loggers
directly through the software, rather than via separate apps.

From time to time LogTag North America Inc will publish updates that can be applied to a USB
logger to enhance functionality and add new features, or to improve how the logger currently
works.

This feature can be enabled or disabled in the General Settings (on page 149).

You will need an active internet connection and access to the LogTag North America
Inc website at logtagrecorders.com to be able to use this feature.

If the feature is enabled, you will be given the option to update any logger for which an update

is available, as part of the configuration process.

You will see:

« the model ID of the USB logger for which an update is available

. if the update is critical (an existing feature isn't working as expected) or a feature update
(new functionality or enhanced features are available)
You can find more information about the new and updated features on the LogTag® USB_
Logger Update page.

« a progress bar once you have started applying the update

| & tograg consgure

2. Locate cracied LogTagls)
Firmware Updates Available
Load LogTagls) cument
configuration
Prepare LogTagiz) for next use Model D Update Type
UHADO-16 Feature Update

) O e | B € sk voae

Figure 52: An update is available for a USB logger

@
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To start the update process, click [Apply Update] The progress bar indicator changes according to
this sequence:

Model ID Update Type

UHADO-16 Feature Update \ Update Mode

(the logger is being switched to accept the update)

Model ID Update Type
UHADO-16 Feature Update Erasing |

(the current firmware is erased)

Model ID Update Type

UHADO-16 Feature Update Updating Firmware

(the update process is about to start)

Model ID Update Type

UHADO-16 Feature Update [Update Progress 35%

(the update is in progress)
During the update process the logger's Alert LED will be permanently on. For models with a
display, the word boat will appear.

You should not remove any loggers during this process. If, however, the update process is
interrupted, you may see this on the screen:

Model ID Update Type
UHADO-16 Feature Update

1

Update Failure

If this happens, simply start the logger configuration from the beginning.

You can skip the update process by clicking . You will then be presented with the
normal configuration screen.

Once the upgrade has successfully completed, you will see this confirmation screen:
Keep the logger connected until you see the Configuration screen, then continue as normal
with the configuration.

If -for some reason- the upgrade process fails, and your logger continues to show bask or a red
LED, please follow the steps in Recovering from a failed firmware update (on page 210)
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Figure 53: The update has successfully completed
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Wireless Connection Parameters

Factory-new UTRED30-WIFI or UTREL30-WIFI loggers do not contain any wireless LAN
settings. Although you can configure your wireless settings in LogTag Analyzer, we

strongly recommend you run the WiFi Connection Wizard first before configuring the
recording parameters here.

When configuring a logger with built-in wireless capability such as the UTRED30-WIFI, an
additional tab is available, allowing you to enter the connection details for your Wireless fararee |l e
Network (WLAN, WiFi Network).

Since units from the factory do not come with any pre-configured wireless connection data,
you will need to enter details here when you configure a device for the first time.

You will need to have the following details available to connect to your WLAN:
« SSID (Service Set IDentiﬁer) or Network Name CH1 Alarm Seftings  CH2 Alarm Seftings _File Seftings  Advanced Seftings | WifiSettings |

MAC address  85:14:14:85:14:EC

This is the identification of the wireless network you wish to connect to.

Click Select SSID to show a list of available networks. Select one of the network names from
the list of available networks.

o Wireless Security Settings

This is sometimes also called the Authentication Method. You need to ensure the logger is
configured for one of the authentication methods your network supports:

o WPA2-PSK

This is one of the most common connection methods for small businesses, which only
requires a password and the network name to be set correctly in order to connect to the
network.

o Open
This security method does not require you to enter a password, however, open networks
often require a login on a special web page called a captive portal. Although newer
models of the UTRED30-WiFi supports open networks, it does not support a captive
portal. Your IT administrator can add an exception in your network, so your logger can
still connect.

o EAP-PEAP (with MSPCHAP2)
EAP-PEAP is an enterprise authentication method, which requires a username and

password to connect to the wireless network. Your IT administrator will be able to tell
you if your organization uses such a method, and what you need to enter.

Figure 54: WiFi Settings tab for units without a WLAN configuration
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o QOther

Occasionally, we may provide new authentication methods for our wireless loggers
through an updated Connection Wizard, and someone else may have configured these
settings in the logger for you. If LogTag Analyzer detects one of these new authentication
methods, it will still show the configured SSID when you click Select SSID, however, it
will not be able to identify the authentication method, but display "Other" instead. You
can also not see password or user name entry fields. Unless you wish to connect to a
different network, we suggest you click "Leave WiFi settings unchanged", this will ensure
the wireless settings stored already inside the logger will remain unaltered.

e )
Note: You can change the authentication to a known method, but once the logger
is configured, you will not be able to restore the previous authentication method
with this version of LogTag Analyzer. This can only be done using the same
software that generated the new authentication method in the first place.

If during configuration you are not offered a specific authentication method,
your logger does not support that method.

(& J

« WiFi Password

This is sometimes also called the Network Security Key, Pre-Shared Key (PSK), Passphrase or
simply the Network Password. This is required for all WPA2-PSK networks.

« User name, Password

When you use an enterprise authentication method, you will need to provide a user name
and a password to be able to connect to the network.

If necessary, your IT Network Administrator can advise you of these settings, usernames and
passwords.

If the network to which you want to connect the logger is not in range or hidden (in other
words, it does not appear on the list of networks), you will need to specify the settings by
typing the SSID and password of that network, once you have clicked Select SSID.

Select SSID =
Enter SSID | Wi-Fi_Network_1

w2 mrera

Wifi Password

This is required, for example, if you intend to deploy the device at a location with a different
WLAN to what is available at your current location.

Wi-Fi_Network_1
Wi-Fi_Network_2
Test_Metwork

Figure 55: Available wireless networks
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Select SSID  Leave Wifi settings unchanged
Please note that LogTag Analyzer does not check the validity of SSID or password.
Please ensure that the correct password is entered. The majority of connection errors
are a result of entering an incorrect password.

LogTag Analyzer will allow you to configure a logger with an empty SSID. This is
equivalent to disabling WiFi and you will get a warning symbol and a tooltip in the
Progress Pane indicator that such a logger will not connect to any wireless networks.

Alarm Settings  File Settings  Advanced Settings | Wifi Settings

Figure 56: WiFi Settings tab

When re-configuring a UTRED30-WIFI at a later stage, you have the option to leave the
settings unchanged. This is the default setting offered when you re-configure the device.
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Using the LogTag® Online Connection Wizard
To enter WLAN settings you can also use the LogTag® Online Connection Wizard.

The LogTag® Online Connection Wizard is available by clicking Connection Wizard from the
LogTag Online menu, or from the Windows Start menu in the Start - Programs - LogTag
Recorders shortcut folder. The connection wizard allows you to:

« configure wireless and network parameters of your WiFi enabled loggers
« configure wireless and network parameters of your WiFi enabled interfaces
« create an account with LogTag® Online (or sign in if you already have an account)

o register wireless devices against your account
You can find more information about the LogTag® Online Connection Wizard at
http://1t.help/c843e.
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Using the LogTag Access Wizard

You can use the LogTag®Access Wizard by either clicking the toolbar icon (as shown) or by

selecting Wizard from the LogTag menu. B
The LogTag® Access Wizard performs following tasks: Wizard

. Figure 57: LogTag Access Wizard from toolbar
1. All connected interface cradles and USB ports are checked for attached LogTag® products.

If any of them contain previously recorded data these are downloaded and saved.
2. The configuration window is displayed. B comgue &

ownloai F4
The Wizard performs the functions Downloading and Configuring in sequence, so you do not B oo

i F5
lose any data. @Z Hibernate
@ Quick Re-configure F&

Note: While the wizard is visible the Automatic download feature will be temporarily [ Profies 7
disabled. You will also not be able to access the Wizards while an automatic download @ Wizard P2
is in progress. [
Figure 58: LogTag Access Wizard from menu
When the wizard completes, you can click , and the process will start from the
beginning.

Quickly re-configuring a LogTag® logger

You can configure a LogTag® logger without first displaying the configuration screen. To do

this, you can click Quick Re-Configure from the LogTag menu, and you will see the Upload [F@ Configure F3

configuration screen, where a logger will simply be re-configured with the settings used for the

previous trip. F@ Download F4

You can also pr.ess the F6 functl.on key. . @ AN =
There are certain rules when using this function:

« You can use multiple interfaces. Each LogTag® device detected in an interface is re- @ Quick Re-configure F&
configured with the same data used for its previous trip. Loggers do not have to be of the [}
same model, and can each have different configuration settings. E Profiles =

» Re-configuration is only possible for loggers which used the "Push button" or the "Push
button from hibernation" start method for their previous trip. If the logger's previous trip @ Wizard =

was started by the date/time start method the quick re-configure option will result in an

error message being displayed. Figure 59: LogTag® quick-reconfigure function
« If a logger requires a password for configuration you will be requested to provide this

password. If you enter an incorrect password, the configuration process will be aborted.
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« If the unit is still logging when you reconfigure it, you will be asked to confirm whether or
not you wish to stop the current trip.

Automatic Re-Configuration after Download

To process loggers even faster, you can set-up an option to re-configure a logger with the same
settings after it has been downloaded by using the automatic download option.

This feature is set up in the Automation section of the general options by selecting Re-
configure with same settings after automatic download.

Once enabled, a logger is automatically downloaded once inserted in the interface cradle, and
immediately re-configured for logging, using the same settings as for the trip just completed.
You will receive a confirmation once the configuration is complete.

If the logger is still logging during download, you also need to acknowledge that it must stop
recording before a re-configuration can proceed.

Please note this option only works when a logger is automatically downloaded when inserted
into the interface, i.e. the "Enable automatic download of readings from Loggers" option must
be enabled, and the download triggered by inserting the logger into the interface. This does not
apply when the product is downloaded through the menu of by pressing F4.

If the logger you have downloaded does not have a configuration password and has also
finished logging, the only visual feedback on the PC will be after the logger has already
been re-configured for a new trip You will only be able to access the data from the trip

just downloaded on the PC, but not within the logger. Therefore, if the file location for
storing data is not accessible at the time of downloading, the re-configuration will not
proceed.

Continuous operation

All LogTag® products have a limited amount of memory to store the readings they record.
When selecting the option to Record readings continuously, the LogTag® will not stop once the
memory is full; instead it will replace the oldest reading stored with the newest reading.

Not every model supports continuous operation. If you configure a LogTag® and you cannot
select this option, your model does not support this feature.
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o The following LogTag will stop logging when it is

re-configured. Are you sure you want to continue?

Figure 60: Confirmation request to allow stopping the logger
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Pre-start data collection

LogTag® products support a feature called pre-start logging, which can be selected during
configuration.

When pre-start logging is enabled, the logger will automatically start recording as soon as
configuration is completed. It will record at the same sampling interval as defined in the
configuration and will continue to record until the user starts the product by pressing the
START/MARK button. Once started, it will record started readings as per the configuration
settings. While the LogTag® is recording pre-start readings the Alert LED will not activate,
even if an alert condition is present.

Pre-start logging is useful as a fail-safe recording setting so if the logger accidentally is not
started at the appropriate time, the readings will still be available to view later.

When the readings are retrieved later, any pre-start readings will be separately displayed, so
the user can quickly identify the readings recorded before and after the logger was started.
All LogTag® models have a finite amount of memory to store the readings they records.
Therefore, while the logger is recording pre-start readings it will operate in its 'continuous
operation' mode, which is explained further in the section Continuous operation on the
previous page. Once its memory is full, the oldest pre-start reading will be overwritten with
the latest pre-start reading, or the latest started reading if the logger has been started.
Once started, the logger will first fill any remaining memory, then overwrite the oldest pre-
start readings until the complete memory is filled with started readings.

If a LogTag® product has been configured to start recording at a certain date/time, or for push
button start from hibernation, no pre-start readings will be recorded.

Restricting Access

You can enable a password protection feature, which requires any user to enter the correct

password when they next configure the LogTag® logger for recording. This prevents a user

from accidentally erasing data

During configuration, select Configure requires a password. A password entry field appears,
where you can enter a password.

A confirmation of this password is required.

Password: |_| Configure reguires a password
[ ] pownioad requires a password

Figure 61: Password entry
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Tip: Sometimes users tick the password required box, but don't enter a password. Such
a "blank" password is valid, hence the password request dialogue will appear when re-
configuring such a unit. In this case simply selectingwill advance to the next
screen. A warning message will inform you when you are using a blank password.

Protecting Recorded Data

Not only can you protect a logger's configuration; most models can also be set up so they
require a password before you can access recorded data. This function can be enabled in the
main configuration screen by selecting Download requires password. The same password is
used to protect configuration and download.

The features can be used independently. You can use a download password without a
configuration password, and vice versa, or use both passwords, or none.

Note: For USB loggers, Download requires password cannot be enabled if you enable
any on-board files to be generated.

Password Rules

The password can be up to 6 characters long (16 characters for USB loggers) and can contain a
mix of letters, numbers and special characters. The selected input language of the computer's
operating system determines which special characters can be selected.

If a user decides to make use of special characters, extra information about the language used
is stored inside the recorder. Users will then need LogTag Analyzer 2.3 Release 7 or later so the
password is correctly interpreted.

This feature is not available in USB loggers.

If you use special characters for languages such as Japanese or Chinese the maximum number
of characters that can be used will be reduced due to the increased memory required to store
the characters.

Please see Code Pages on page 196 for a more detailed explanation.
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Verify Access Password

If the Configure requires a password option was enabled or the password was changed during
the configuration process the user is required to verify the password before it will be stored in
the logger. A window similar to this will appear:

Once a password has been stored in the device, it can only be accessed by providing the correct
password. Therefore, if you forget the password you will no longer be able to access the
LogTag® Passwords are case sensitive - the passwords "Bob" and "bob", for example, are
different.

Hibernation - Prolonging battery life

If your LogTag® device is not going to be used for extended periods of time you should
hibernate it. While in Hibernation it will consume minimal power, which will extend the
battery life when compared with leaving an idle LogTag® device operating.

While a logger is hibernated it will:

« not record and store any new readings;

» not activate the Alert and OK lights; and

« not respond to the START/MARK button being pressed.

The only exception is when the logger has been configured for Push button start from
hibernation in the configuration screen. In this case pressing the START/MARK button will
'wake' the product and commence logging according to the configured settings. Not every
model supports this feature.

To 'wake' a hibernated logger, go through the usual process of Configuring a LogTag® product
for recording (on page 48).

To hibernate a logger, select Hibernate... from the LogTag menu.

You can also use the F5 function key.

E The password for the LogTag(s) has
e

changed. Please verify the new
password to be used.

Description:  Password Update

Password:

0« |0~ |0

Figure 62: Password confirmation

|E‘E)) Configure f3
[@) Download F4

EL Hibernate fs

l@ Quick Re-configure fe
D’ Profiles F7
@ Wizard £2

Figure 63: Hibernating a logger
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You will see the window one on the right when hibernating a logger.
One of the following icons will show next to each of the items in the list:
+ (No picture) indicates the logger is still in the process of being hibernated.

* ¥ The logger was successfully set to hibernation

* X The software was unable to set the logger to hibernation

Once a LogTag® device has been successfully hibernated it should be removed from the
Interface Cradle before pressing any other button. As soon as the software communicates with
a hibernated logger (for example through automatic download) it will be returned to normal
operation.

The extent to which Hibernation will prolong the battery life of a LogTag® product varies
between different models and versions.

Starting and using the LogTag® logger

Once a logger has been successfully configured, it must be started to take readings.

A logger can start automatically at a date and time set during configuration, or manually by
pressing the START button on the logger.

The different start methods are explained in more detail in the section about Configuration
Parameters.

For exact procedures how to start a logger please refer to the individual Product User Guides
and Quickstart Guides, available for download from the product web pages at
https://logtag.com.
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o x

The software will locate the LogTag products for you and set them to
Hibernate mode. Please do not remove LogTag(s) or disconnect
interface(s) during this process.

Only LogTag(s) with a tick has(have) been hibernated.

LocaAtlcn Interface Model | LogTag ID Hibernated
UsB LTIHID 5034000005 v
usB LTIHID 5935000002 v
use LTIHID 5040000036 v
usB LTIHID 5040000030 v
usB LTI/USB OOFEOF0S Not found b4
usB LTIHID 5040000038 v
usB LTI/USB 03101C06 1060026140 v

G Again : Q Close 0 Help

Figure 64: Hibernating multiple loggers
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Configuration Profiles

To simplify the task of configuring multiple loggers with the same
parameters, you can store the settings you would enter during
configuration (such as alert limits, logging interval, number of
readings etc...) in a Configuration Profile, then use the profile to
configure loggers as required.

Configuring a logger with a pre-defined profile requires only three
steps:

1. Select Profiles from the LogTag menu.
The window now displayed gives you an overview of the profiles
already installed. You can also add new profiles or edit and
delete existing ones.

2. Select the profile you wish to use in the Configuration Profiles
main window.

3. Click Configure loggers.

The next few pages detail the steps required to add and manage
configuration profiles.

LogTag® Analyzer User Guide

[% Configure F3
p@ Download M
@ Hibernate F5
@ Quick Re-configure F&
a ;4' Profiles F7
B Wizard F2
Figure 65: LogTag Profile Menu
Cenigurason Pcfles = |
Deule-chck on 8 profie 10 configure loggers wih the rofie setngs.
e Model  Attribuden | (© cotnee oagers
::;:\‘a‘ﬁ:e mm :ﬂj [ Retain Description Fassword
-
LA //
[ -lm | ExportSeieces | eiessomie =
(¢ DT | o M @ =

Profile Control
Buttons

Profile Path &
Filename

> Profile File
Controls

Figure 66: Configuration Profiles Main Window
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Profiles Grid

When you first select this feature the profiles grid will be empty. You will fill the grid by adding Natne Model Attributes =
profiles, or importing profiles. Trix Profile TRINTREX R/ ]
Profiles from the grid can then be used to configure loggers. A single click on the column title Haxo Profile RAX0 R
will sort the profile using this column. Double-clicking on a profile will configure all loggers UTRID UTRID Rl

currently in connected interfaces using the parameters stored in the configuration profile. You
can select multiple profiles for export or deletion when you hold down the CTRL key while
clicking, but you cannot edit or apply more than one profile at the same time.

11

1|

Figure 67: Profiles in the profile grid

Profile Control Buttons

Clicking on a profile row and clicking |Configure LogTags | will configure all loggers currently
attached, using the parameters stored in the profile (you can also do this by simply double- proie Name -
clicking the profile name). =

To be configured, loggers must have the same model name as in the profile.
Use the control buttons to add new profiles and to edit or delete existing profiles.

Clickingwill bring up the Edit Profile window without any parameters. Type a Profile
Name into the text entry field and select a Model from the list.

Once you have selected a model, the configuration parameters for this model appear. They are :
the same parameters as already described in Configuring a LogTag® product for recording © Q

Figure 68: New profile window

When you enter the configuration parameters for a WiFi enabled logger, but do not
enter any WiFi settings, any logger configured with that profile will not connect to a
WiFi Network. Use the WiFi Wizard to connect this logger to the desired WiFi network.
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The same window will be displayed when you click . Every entry field is now populated
with the saved value for this profile. Any entry field can be edited, with the exception of the
model type and the profile name.

Click to store the profile in the Profile file, to discard any changes and to
display the help screen for this window.

Profile Storage File Name and Path

The collection of profiles displayed in the profiles grid is saved in a single file on your PC,
which is called the Profile File. This file is typically stored in a folder called LogTag
Configuration Profiles inside the My LogTag Documents folder. Every time you open LogTag
Analyzer this profile file is activated.

You can select alternative collections by opening different files. This can be useful if for
example you want to keep different profiles for different customers, or you prefer to separate
and organize your profile collections.

You can click on the "=/ button and select a different profile file. If you have unsaved changes
you will be asked to confirm if you want to first save these changes. An explorer window will
then open, where you can select a new profile file.

Note: To create a new profile file, export one or more profiles to a new profile file. You can
then open the new profile file and add, edit or delete profiles as usual. Alternatively, you can
download an empty profile file template from http://It.help/68jib.

Profile File Controls
If you have stored your profiles in different profile files, you can transfer data between
different files with the (Import] and [Export] buttons.

When you click on the [Import)button, a file explorer window will open. Browse to the profile
file from which you want to import the profiles and confirm your selection by clicking .
All profiles from the selected profile file will be imported into the currently active profile. If a
profile is imported that has the same name as an already active profile, you need to confirm
whether you wish to skip the import of this profile or overwrite the active profile with the
imported profile.

You can export selected profiles to a new file by highlighting a profile and clicking [Export) A
file explorer window will open, where you can enter a new profile file name (the file will be
created when you click , or overwrite an existing profile. If a profile is exported, and a
profile file already exists, you need to confirm whether you wish to cancel the export of this
profile or overwrite the profile file. You can export more than one file at the same time by
selecting the desired files while holding down the CTRL key.
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Profile Name  Trix Profile

Model TRIX_TREX v

User Information
Description:

|| configure reguires a password
|| povinioad requires a password

Logging Parameters
Push button start v | || Enable pre-start loaging

() Record readings continuously, overvirite oldest when memory full

(®) Record readings 5o that:

Readings recorded will span at least |26 Days

MNumber of readings to record 7500 maximum is 16159

Record a reading every |00:05:00 = 5 Minutes
Begin recording after a delay of (00:00:00  + | None

[JEnable the OK (Green) indicator

Readings abowe[ | |70.0 «c

ar||4r

Enable the Alert (Red) indicator, when:

Readings below| | |-20.0 c

After |2 = e After 2 =

consecutive alert readings (None) alert readings have occurred (None)

[ Leave alert indicator enabled even if readings return to non-alert range
Temperature Alarm Settings | Advanced Alarm Settings

@ = O o @

Figure 69: Editing a TRIX-8 profile

0 Configuration profile TRIX already exists.

Do you want to replace it?

Figure 70: Prompt when overwriting an existing Profile
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You cannot amend a profile file by exporting a profile to it. Exporting a profile will
always overwrite the target profile file.

Profile Dialogue Controls

Clickingwill store the profile in the location entered above. Clicking will

discard any changes and return you to the main window.

Please note there are some restrictions when you work with configuration profiles:

« Configuration profiles cannot use the date/time start mechanism. If a defined start time
were to be applied to a profile, this time would most likely have passed by the time the
profile is applied. If you need to configure a number of loggers and you want them all to
start at the same time you should use the standard configuration method and the
function.

« You cannot configure one type of logger model with a profile written for another model.
« You cannot have multiple profiles with the same name.

« If you have exported a profile to a profile file, canceling the main edit window will not undo
the changes.

« If you try to apply a profile to a logger with a password protected configuration, this same
password must be provided in the profile. There is no separate password confirmation
dialogue.

« Loggers that can be upgraded to use a download password will automatically be upgraded
when a profile is applied using this feature.
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Sometimes a logger cannot be configured using a particular profile. In this case one of the
following errors will be displayed:

Message

"Logger does not
support advanced
alert settings"

"Logger cannot
record more than
X readings"

"Password in
profile does not
match logger
password"

"A password
cannot be applied
to this logger"

"Logger only
supports latched
master alarm"

"Profile logger
type does not
match"

"Lease expired.
The max. number
of starts has been
reached."

Table 13: Profile error messages
What it means

You have selected a profile which has separate upper and lower alert settings, but
the logger you wish to configure does not support this. You will need to use a
different profile, or use a different logger if this feature is important for this trip.

You have selected a profile that requires the logger to take more readings than fit
into its memory. You will need to use a different profile, or use a different logger if
this feature is important for this trip.

You have selected a profile with a password, and the password currently stored in
the logger is different. You will need to use the normal configuration process to
remove the password; after that you can use the profile function to configure the
logger with the new password. If the logger does not allow the password to be
changed, you will need to use a different profile.

You have selected a profile with a password, but the logger is factory configured so
the user cannot change or enter a password. You will need to use a different profile
that doesn't have a password protection, or use a different logger if this feature is
important for this trip.

Loggers typically can have a setting applied that allows an alarm to reset if
conditions go back to within specification. Some older TRID30 loggers do not
support this feature, and if you attempt to configure such a logger with a profile
using this setting you will see this error. You will need to use a different profile or
use a later model TRID30 if this feature is important for this trip.

You are trying to configure a unit with a profile that was created for another model.
A profile is specific to a logger model, so you will need to use a different profile.

You are trying to configure a unit which has no more trips left. You will need to use
a different logger.
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Calibration Certificates

Starting with version 3.1.6, you can view and print a logger's factory calibration certificate
directly from LogTag Analyzer.

You can access the certificate:

o by clicking| Show Certificate | from the report tab after the logger was downloaded
« by clicking [Certificate of Calibration] during configuration of the logger

The certificate issue date is the date the logger was first configured.

You can also access the factory calibration certificate from the report tab when opening a saved
data file, provided the recorded data are from the period during which the certificate was still
valid.

You will not be able to access the certificate:

+ before the logger is configured for the first time. You will not be able to click
until the configuration is uploaded successfully to the logger

« after the logger was adjusted by a third-party calibration laboratory using LogTag® Calibrate

« if a logger was manufactured before 1. April 2019
« for indicator products
« on a multi chart report

If a logger was first configured with a version of LogTag Analyzer prior to 3.1r6 you
may still be able to view the calibration certificate. Please note, however, that the
certificate date may differ from that on the certificate issued by your distributor. In
this case, the distributor issued certificate is correct.

For additional information you can click the icon next to the calibration certificate button:

O

Even if you choose not to view the certificate, a PDF of the certificate document will be saved
to "My LogTag Documents", in the "Certificates" folder when you configure a logger for the
first time.
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& Certificate of calibration o=

@K 1 of 1h M @& %%

4 ®
LogTag
FACTORY CERTIFICATE OF CALIBRATION

Certificate No.: UTRID-16-A04800000290
LogTag Morth America Inc. -as the manufacturer of the LogTag brand of temperature and humidity recorders and
prabes - hereby certifies that the following product, referenced by model designation and serial number, has
been tested during manufacture in accordance with LogTag approved procedures, and meets the specifications
as published in the Technical Data Sheet

Model number:

UTRID-16
Serial number:
A04800000290
Calibration Points.
Reference Permitted PASS/FAIL Adjustment
Temperature
Deviation

59.3°C +0.7°C PASS N/A
266°C +06°C PASS N/A
120°C +05°C PASS N/A
-0.6°C +05°C PASS N/A
-162°C +05°C PASS /A
-26.7°C +07°C PASS N/A

Instrument traceabilitv
Hioki Digital Multimeter Model DT4282, Senal# 161107506
traceable tome b
System of Metnic Units, which is equivalent 1o NIST

LogTag North America

QAEC 17025) andto the
This centificate is issued by:

Issue Date: 04Aug.23
K hchymits
Yz 1

Simon Shucksmith, Managing Direcior
is calibrated during m testbares ge
arestoredin oth rerecorders e Test baares wre
checked and caibrated st lesst every Smanth: sensar empioyed n e prody
by - o cterthe limits a

Every LogTag UTRID-16 Tem

sane

rated by the s facturer in @

Thistactory Calibration Centicateis validfor apeniod ot 12 e da: cer s beensives 1 oy
conditons at e rang! 0 +40°C and ot sudjected $hanaing peor 1o 1 5t use Refrence
temperaiures are ¢ ectron Callyrecarded. snd passiial ctena sopked fr exch prod

This certficate s electranically gensrsted and does not cany 8 signatre
LogTagHorth America, inc. 10Milpond Drive, Unit 10, Latayetie, N 07843, USA htps.iflogisgeom inb@ioggcom

Close.

Figure 71: Factory Calibration Certificate
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Smart Probes

Starting with version 3.2r2, LogTag Analyzer can show additional calibration information for

LogTag data files from loggers that used Smart Probes to record temperature, in addition to the
logger's own certificate.

Following applies when viewing these certificates:

« When you display the contents of a data file from a logger, that had Smart Probes connected
when it was recording, up to two additional tabs are available in the certificate window.
The tabs show :

o The calibration certificate for the logger itself.

This certificate only applies when the logger is operated with an ST10 or ST100
analogue probe.

o The certificate for the Smart Probe connected to channel 1.
o The certificate for the Smart Probe connected to channel 2.

Either tab will only be shown if a Smart Probe was connected to this channel during
logging.
« Click the corresponding tab to display the certificate for the Smart Probes.
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X Certificate of Calibration - =
| mln.gg-e-r. Probe CH1  Probe CH2
@ 1 of 1b M |8 0% - |
Centificate No.: UTRED30-WIFI-A0A900103820
LogTag Morth Amenca Inc. -as the manufacturer of the LogTag brand of temparature and humidiy recorders and
probes - hereby certifies that the following product. referenced by model designation and serial numbet, has
been tested duriing manufacture in accordance with LogTag approved procedures, and meets the specifications
as published in the Technical Data Sheet
Model number:
UTRED30-WIFI
Serlal number:
‘ADAS00103820
Calibration Points
Reference Fermited PASSIFAIL Adjustment
Temperature
Deviation
57.3°C $08°C PASS N/A
256°C +05°C PASS A
124°C +05°C PASS N/A
00°C +05°C PASS /A
-154°C $05°C PASS /A
-260°C +08°C PASS A
Instrument traceability
Hioki Digital Multimeter Model DT4282, Seriai# 161107506
prated annually. C: Standards Laboratory of New
Zealand (; OMEC 17025) of Metric Units, which ts eouivalent io NIST. b
X Certificate of Calibration =X

Logger | Probe CH1 | Probe CH2

B 41 of 1 M BB 9% BN

i LogTag’®
FACTORY CERTIFICATE OF CALIBRATION

Certificate No.: CP100-0029001044
LogTag North Amenica Inc. -as the manufacturer of the LogTag brand of temperature and humidity recorders and
probes - hereby certifies that the following product, referenced by model designation and senal number, has
been tested during manufacture in accordance with LogTag approved procedures, and meets the specifications
as published in the Technical Data Shest

Model number:
CP100
Serial number:
0029001044
Calibration Points
Reference Permitted PASSFAIL Adjustment
Temperature
Deviation
5713°C +08°C PASS N/A
256°C +05°C PASS NIA
124°C 205°C PASS NIA
0.0°C +05°C PASS N/A
-154°C +05°C PASS N/A
-26.0°C +08°C PASS N/A

Instrument traceability
Hioki Digital Mulimeter Model DT4282, Serial? 161107506

Refetence instruments calibraled annually. Calibration s raceable 1o the Measurement Standards Laboratory of New
Zealand (acoredited 10 ISOAEC 17025) and 1o he International System of Melric Units, which is equivalent o NIST

Close
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If a Logger or Smart Probe were calibrated and adjusted by a third-party laboratory, a
message will be displayed on that tab, as shown on the right.

You can also view certificates for Smart Probes currently connected to a logger during the
configuration process:

If a logger is being configured for the very first time, the calibration information for both
the logger and the probes can only be accessed after the logger has completed the
configuration process.

To view the calibration information for the Smart Probes, these must be connected to the
logger when you click Certificate of Calibration ] after the configuration has finished. At this
point, LogTag Analyzer interrogates the logger to determine if Smart Probes are connected,
and to retrieve their information.! During this time you will see a warning message, asking
you not to remove the logger from the PC.

Calibration Information Downloading

Please wait while calibration information is collected. Please do not
disconnect loggers from the computer until this process has completed.

VI

When this process is complete, you will see the Certificate tab for the logger, plus any Smart
Probe certificates.

The logger's certificate will be automatically stored, even if you do not click
(Certificate of Calibration] (this is the same as with other logger models). To store the
Smart Probe certificates, however, you will need to view the certificates, so the
Calibration information can be downloaded from the probes.

If a logger was previously used, you can click[Certificate of Calibration] even before the
configuration data have been transferred to the logger. In this case, any Smart Probe
certificates displayed in the tabs will be of the probes last connected, which may be
different to the currently connected probes.

You can only view the certificates for the currently connected Smart Probes if you
click[Certificate of Calibration] after the logger configuration is complete.

1 This process will proceed, even if no Smart Probe is connected to either logger channel.
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& Certificate of Calibration

logger  Probe CH1 | Probe CH2

The calibration of the probe was adjusted by a third-party laboratory.
Please contact the laboratory for a calibration certificate.

Close

Figure 73: Probe calibration was adjusted
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Results from LogTag® Loggers

Once a LogTag® has finished its trip, you can:

« download the data to a PC (the section below explains this in more detail);
« view and analyze the information (as detailed in the section Analyzing the results; and
« print the information or save it to other formats (as shown in Printing the results).

LogTag® products store all recorded data in their internal, non-volatile memory. You can
download the data as many times as you want, as long as the logger is not re-configured or
hibernated.

When you download the data, a file is automatically created in a pre-defined folder. Typically
this is the C:\Users\User\Documents\My LogTag Documents folder, but it may also be a folder
in Public Documents. You can customize this location to your requirements File and Folder
Settings as described on page 171.

Downloading data stored in a logger does not erase the data from memory, however if you have
enabled the "Automatically re-configure..." option you will no longer be able to access the data
in the logger once this process has started.

If the LogTag® is currently recording while you retrieve the information, it will continue to
record without interruption. If the logger is in the process of taking a log you may see a slightly
longer download time as communication pauses to allow the log to be taken.

There are three ways to retrieve the recorded results from a LogTag® logger:

« via automatic download

Slot the product into the interface cradle, or plug it into a USB port while the LogTag
Analyzer software is running (even when minimized). If the automatic download feature is
enabled, the software will automatically retrieve the recorded readings, save the information
to your disk drive and display the information. While the software is retrieving the readings
you will see an animation. A new animation will be displayed for every new logger attached.

You can also enable the option to automatically re-configure the device with its current
settings (see Automatic Re-Configuration after Download on page 79).
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o A new LogTag has been detected in the interface. Please
wait while its readings are downloaded.

WS AL S L S S L S L A LA A e

0 Cancel

Figure 74: Downloading a LogTag® automatically
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» via the menu system
Click Download from the LogTag menu.
You can also press the F4 function key.
« Using the Wizard
Click the LogTag® icon on the toolbar or click on Wizard from the LogTag menu.

The wizard retrieves the readings stored in the logger and then offers to configure it for its
next trip.

Progress Pane

When you initiate the download manually, rather than using the auto-download feature, the
LogTag Download window will be displayed. Each logger found will be listed in the Progress
pane, much the same as in the Configuration Window.

When you see this icon displayed, communication was established, but no data were
downloaded. The most likely cause is that there are no readings in the logger.
@ When you see this icon, no logger was found in the attached interface.
rF] Data from this logger was downloaded, but the logger has a low battery. It should not be
_ used for another trip
D This icon is displayed after the logger has been successfully downloaded and the data saved.
_@ The progress bar will also show the word Downloaded
?‘ This icon is displayed after an unsuccessful attempt to download the logger. Further error
_® messages will be displayed to indicate why the logger was not downloaded.

When the logger has completed its trip and you wish to see the recorded readings, place the
LogTag® into the Interface Cradle.

@ Configure F3 ‘
F@ Download % F4
@ Hibernate 5

@ Quick Re-configure F&

:;4' Profiles F7
Wizard F2

Figure 75: Download Menu

Wizard

Figure 76: Wizard Toolbar Icon

" Locstecradled LogTagls)

o Corlesdand e LogTagt)
recorded data

The software will locate the LogTag products for you, download the relevant
information and save the information to disk. Please do not remove LogTag(s)
or disconnect interface(s) during this process.

Please ensure the following are correct
1. LogTag Interface Is plugged Into the computers communications port.
2. LogTag is completely inserted into the LogTag Interface.

LogTag USEHD ——=

uTRoc-16M swes040000028 )

77 Doweoaded

LogTag USB-HD
S5N:4035001010

LogTag USE-HD.
UTRIX-16 SN:5040000027

&

USE: 036D000E
Mot found

togTag USBHID
usmc:s sn43soaiee )

G O o |©
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Heip

Figure 77: Progress Pane when downloading data
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If the LogTag® is still recording it will continue to do so. A USB logger, however, will not record
temperatures while plugged in; instead it will record Paused readings.

The software will automatically download any readings and save them in a file.

Once the readings have been successfully downloaded, the software will display the
information. The chapter Results from LogTag® Loggers on page 92 explains in more detail
what information is displayed and how you can influence its appearance.

Your LogTag® may now also be reconfigured for another trip with the same settings as before,
if you have this option activated (see Reconfigure with same settings after automatic download
on page 160.)
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A new LogTag has been detected in the interface. Please
wait while its readings are downloaded.

Figure 78: Downloading a LogTag®logger
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LogTag® Data files

Every time you download a LogTag® Logger to your computer the data are automatically saved to a file with a

* 1tdx file extension (LogTag® Data Extended). This file is then opened, and presented to you on screen. When
you download a LogTag® product, and view the data, you are therefore viewing the file that was saved when the
LogTag® was downloaded.

The *.1tdx file is unique to LogTag® products and can only be read by LogTag Analyzer software.

You can customize a number of options for this file in the Edit - Options window:

« You can define the file's name, for example by specifying details about the logger from which the data were
downloaded (File Name on page 172)

» You can decide if existing files with older data should be overwritten or kept (Uniqueness on page 177)

« You can automatically have files sent to email recipients and FTP sites (Automation on page 160)

« You can decide which additional other file formats are created, for example PDF files (Exports and Reports on
page 179)

You can also combine data from multiple files as on page 99.

Please refer to the respective sections in this user guide for more information.

Note: If the logger you are downloading has not taken any readings, a message such as the one one on
the right will be displayed.

File generation for Dual-Channel loggers
When downloading Dual-Channel loggers, such as the new UTRED30-16 or UTRED30-WiFi models, several files
will be generated:

« a *.1td file, containing the complete data for both channels
. a *lItdx file, containing only the data for channel 1
« a *lItdx file, containing only the data for channel 2

Both *.1tdx files will be saved, then opened and be presented in the selected default tab. File names will be
generated as usual, with the suffix CH1 and CH2 added as appropriate. The *.1td file will only be saved, but not
opened, and will also not appear in the Recent File list.

Note: If your default file format is set to *.1tdx, the *.1td file will be deleted once both * 1tdx files have
been generated.

If you decide to open the *.1td file again, instead of the *.1tdx file, no new files will be generated. Instead, the
already saved file will be opened, including any changes you have made, such as 120.

Digital signatures
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The following LogTag has no readings stored in its memory.
A The logger has not been configured or started.

0

Figure 79: No Readings to download!
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Support for digital signatures is primarily provided for compliance with the US FDA 21 CFR Part 11 regulation -
Electronic records and electronic signatures. Various industries, however, may find inclusion of digital signatures
beneficial for their quality control and assurance systems.

Digital signatures allow users to record an event in a LogTag Analyzer file along with their digital signature. To
add digital signatures to data files, LogTag Analyzer must be connected to the LogTag® User Server software. For
more information how to connect see User Server on page 186, or contact your local network administrator.

To add a signature to a file, open the file and click Digital Signatures from the Edit menu, or click Signatures

located on the toolbar, which will display the File Properties window with the Digital Signatures tab already =l
activated. Signatures
Then click New to start adding a digital signature. Figure 80: Digital Signatures toolbar button

Once the Add Digital Signature dialog box appears, enter your LogTag Analyzer user password and select the
meaning for the digital signature that is being added.

Click to permanently add the digital signature to the file or to abort. Multiple digital signatures from
the same or different users can be added to a single LogTag Analyzer file. You can see all digital signatures that
were applied to a file when Viewing file properties (on page 98) or in the Report Display on page 124.

Note: The time and date displayed in the signature window is always UTC, regardless of the date and time
settings made in Date and Time Format on page 182.

How secure are my data

LogTag® files are encrypted and contain checks to detect if the file changed since it was originally created. If
LogTag Analyzer detects that a file has been tampered with, or has become corrupted, it will not open the file.

In addition, LogTag® devices automatically insert error detection codes during recording, which are used to detect
data errors. When these detection codes for a block of recordings fail the integrity validation, the relevant
readings are marked as non validated readings. Non validated readings are displayed differently to validated
readings to indicate that they have failed this integrity test.

Non validated recordings typically occur in the following scenarios:

1. One or more readings in the non validated block of readings is not the genuine recorded value.

2. A communications or hardware failure has occurred during the transfer of the data from the LogTag® to the
computer. Try downloading the recordings from the LogTag® again; make sure the contacts on the back of
the LogTag® are clean, the contact pins in the Interface Cradle slot are clean and return evenly to their
normal position when the LogTag® is removed.

As the software does not modify any of the recorded data in a LogTag® file at any time, if the software can open
the file, regardless of how long ago it was created, the contents of the file will still represent the original recorded
information retrieved from the LogTag®.

Therefore, the files created by the LogTag Analyzer software meet all criteria for data integrity and data security
as set out in the US FDA 21 CFR Part 11 regulations. The firmware code that is embedded in the processor chip of
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each LogTag® cannot be extracted or reverse-assembled. Accordingly, data sets that are recorded in the memory
of the LogTag® cannot be downloaded or modified except by being transferred to a LogTag® file. There is no way
to interfere with the process of the transfer of information between the LogTag® and the software in such a way
that data integrity would be compromised.
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Viewing file properties

The file properties window provides users with a summary of the key
properties of the data included in the file, such as model ID and serial
number, alert range and range of readings, start time end time and
total number of readings as well as the battery status. If the LogTag®
has a limited number of trips left, this is also indicated here.

The file properties window is accessed by clicking on Properties in the
File Menu or via the toolbar command.

LogTag® Analyzer User Guide

E—j Send
Upload

[‘LD Properties
B

Digital Signatures

Select Recent File

0 Exit

]

Figure 81: File properties Menu

Summary | Digital Signatures  Activities

LogTag ID | 1010080254
Model ID HAXO-8
Description

Number of started readings
First reading
Last reading

Readings range

Data originally acquired

2616

12/16/2016 12:16:14 AM

12/16/2016 10:03:44 PM

400 to 850 °C 00 to 1000 *RH

228 to 270 °C 39.6 to 571 %RH

12/16/2016 9:03:21 AM

Figure 82: File properties

page 98



Additional Features for TRED30 and TREL30 models LogTag® Analyzer User Guide page 99

Saving a Multi Chart File

If the main LogTag Analyzer window currently displays a multi chart (see Combining charts onto a single chart), you can save it by clicking & on the

toolbar or selecting Save from the File menu. Select a file name and location for your multi chart file. The file extension for multi chart files is

* multix.

A multi chart file contains a copy of each individual file that makes up the chart along with any zoom settings, annotations and the information that
describes which relation the data files have to each other.

To open a previously saved multi chart configuration file, click on the £ toolbar icon or select Open from the File menu , then select the "* multix"
file to be opened. To save a multi chart file under a different name, select the Save As command from the File menu and enter a new file name.

[ You can save a multi chart file as a PDF, but not as any of the other export file types. ]

Selected LogTag® Data files (*.sltd)

The file type *.sltd is a legacy file type, which you can open with this version of LogTag Analyzer. In this file LogTag Analyzer version 2.X allowed you
saving data zoomed to a particular time window. When opening a *.sltd file, LogTag Analyzer version 3.X will extract the data for the complete trip
and present the data zoomed to the time window stored in the file.

Since the new * Itdx format has this function built in, the support for saving this file type has been discontinued.
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Calling up previous results

To open a stored file, click the Open toolbar icon or click Open... from the File menu. This will
display the Open file dialogue.

Browse to any location accessible by the Windows® Operating System, including network and
ftp locations. Select the desired file and click . Please refer to your operating system's
help for more information.

You can also open files directly from your LogTag® Online account. Please refer to the section
about Integrating LogTag Analyzer with LogTag® Online for more information.

The files that have most recently been opened are listed in the Select Recent File sub-menu the
bottom of the File menu. After the software has been installed for the first time, there are two
files in this list, even though no files have been opened yet. These are sample files, which have
been installed along with the software, so that users can see an example of how a LogTag® file
looks. These files are not required for the correct operation of the software and therefore may
be deleted at any time.

You can also open files directly from Windows® Explorer or your email software by double
clicking on the file or right-clicking and selecting Open. When opening files from email
programs that store attachments in temporary folders such as MS Outlook, you may be asked
to store the file in a new location when performing further actions such as selecting multi
charts or uploading to FTP sites.

If the software is unable to open the file, it will display an error.

& OpenFile(s)
« v « p\Documents\My LogTag Documents v @  Search Documents
Organise = New folder -
8 This PC A~ Name
[ Desktop ) USRIC-2- 4035011749 Started , Finishe..

B UTRIX-16- 5040000030 Started 16-11-2...

| Documents
B HAXO-8- 1010050458 Started 25-05-20...

: I[::des R TIC20-W2- 1082001064 Started , Finish...
TIC20-W2- 1082001084 Started , Finish...
= Pictures ISOTAG- 2005000003 Started 8-07-2014,...
& videos [ LogTag_5040000036_11_161220_0909_...
%, Local Disk (C) ol
File name: ‘ v| LegTag Analyzer Files
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o
o @

Date medifie ™

[ETRRIr-TIE

(~.ltd, ~lt ~

Cancel

Figure 83: File Open dialogue window

Unsupported LogTag version. You may need to update your
software.

Figure 84: File not compatible with
current version of LogTag Analyzer
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Analyzing the results

Data are displayed and analyzed in file windows, which appear inside the main LogTag Analyzer
window. Each file window displays the data of a single logger and has a series of View tabs
along the bottom. Clicking on a tab changes the way the information is displayed, different
windows can display different tabs.

You can activate multi chart display, and all open file windows are combined into a single
window. You can find more information about this feature in Multi Charts (Combining Charts
into a Single View) on page 111.

These are the different ways to display the information in the file windows.
Table 14: View Tab summary

Tab selected Information displayed

Report Tab A summary display of the downloaded data, including a summary of the important
trip information and an overview graph.

Chart (or Log A display of the data in a humidity and/or temperature versus time chart.

Chart)

Data A listing (spreadsheet style) of the time versus humidity and/or temperature data.

Summary A summary of the data, including averages, ranges, alert results, LogTag®

identification data, and other information.

Day Summary A summary of the day statistics for display loggers.

Not all tabs may be displayed. You may for example see only Report, Chart, Data and Summary,
if the LogTag® does not have a statistics memory.

The readings range determines which section of the trip is shown in the view tabs. Click on the
drop down arrow and select the range you wish to display. Note that you can only make this
selection in the Chart and Data view tabs.

Table 15: Reading range selection
Tab selected Information displayed

Pre-start Readings The file window only shows data for pre-start readings, but omits any
readings taken after the logger started. This cannot be selected if the logger
has not taken any pre-start readings.

Started Readings The file window only shows the data for readings taken after the logger
started, but omits any readings taken prior to the start. This cannot be
selected if the logger has only taken pre-start readings

All Readings The file window shows the data for all readings taken by the logger.
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The most used tabs will typically be the report tab or the chart tab, as the information
displayed in either of them gives an instant overview of the data, whether just recorded and
downloaded from a LogTag®, or retrieved from previously stored data files.

The following sections describe each type of information display (Report, Chart, Data,
Summary, Day Summary and Day Summary Chart) in more detail.
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Chart Display
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Figure 86: Chart display
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When you release the left mouse button, the
area highlighted now fills the window.
Depending on the zoom level not every data
point may have a marker displayed. LogTag
Analyzer intelligently adjusts the display of
markers so the graph line is still visible.
These markers can also be turned off, and
their appearance can be altered. You can learn
more about this in the Charts Section. You
can also see a number of other marks.

Inspection marks are recorded in the
o LogTag®'s memory each time its
START/MARK button is pressed.
Download marks are recorded in the
LogTag®'s memory each time it is
downloaded to a PC.
A Paused mark will be shown when
the product records readings for
which the statistics functions are
suppressed.

A Min/Max reset mark will be
o displayed for each time the min/max
display on a logger is reset.

When the mouse pointer is moved over the
chart, a tooltip is displayed near the mouse
pointer (as shown in the example). It displays
the reading closest to the mouse pointer
position. If the readings are very close
together, you may want to zoom in further
and then inspect individual readings with the
help of tooltips.

When elapsed time is chosen for the x-axis
display, the tooltip will also show the elapsed
time.

You can also add annotations (Chart
annotations) to the chart.
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The chart area displayed in the window can be copied to the clipboard by:

« right-clicking anywhere on the chart and clicking Copy from the shortcut menu;
» pressing CTRL-C; or

« clicking Copy from the Edit menu.

This picture can then be pasted into any Microsoft Windows® application.

The chart is copied to the clipboard at its current zoom range.

You can change the appearance of all charts permanently by changing the options in Charts. If
you wish to temporarily change the appearance of only a single chart in the file window you
can use the Chart Control Panel, or the shortcut menu when you right-click on the chart.

These controls influence general items on the chart, such as turning on and off marks and grid
lines; these can be useful for finding information on the chart easier. Clicking on an enabled
item will disable it and vice versa.

The shade controls can be used to highlight the alert and non alert areas of the chart for easier
identification.

You can use the zoom controls to define which part of the data is displayed on screen (see
Zoom Controls) and the Annotation menu (see Chart annotations on page 120) to display text
on the chart.

To close a window, click X on the file window tab. You can also click % on the right side of
the window. When you right-click in a file window tab, you can also close the file itself, but

also close all other files, or close all files.

The Chart Control Panel

The chart control panel provides you with an easy way to turn elements of the chart on or off,
to annotate the chart and to manipulate which part of the data is being displayed.

The upper part of the chart control panel contains some of the functions you can also find on
the toolbar. These are replicated here to give you easy, convenient access in one location. These
include scaling functions, time axis and inspection mark zoom.

=)

~ Zoom Qut
L L :
an| Zoom Readings

@ Manual Scaling

Real Time

@ Elapsed Time

'\ Zoom

o Previous
0 -

Figure 88: Upper Chart Control Panel
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The lower part of the Chart Control Panel controls what additional information is displayed on Align Charts
the chart. The default values for the various grid lines, markers and shadings are set in Edit - Reset to Defaults
Options - Charts. s
- N Show Annotations
The options you set in the chart control panel are stored with the chart, provided you [/] tnspection Marks
save the file after you have made the changes in the chart. Resding Marks
At a later stage, if you wish to return to the default settings you can click Reset do [/ ichs et
defaults. [7] Paused Marks
You may also receive charts from other users with settings different to your own. v e
These charts can also be reset to default values using this method. %z‘:ﬁzmm

Feature

Align charts
(multi chart only)

Reset do defaults
Annotate chart
Show annotations
Inspection Marks
Reading Marks
Download Marks
Paused Marks
X-Axis Grids
Y-Axis Grids

Show only validated

.. . . @ Above Alert Shade
Table 16: Additional information for Charts

What this feature does

Shifts all charts so their first readings align on the canvas. Please see ‘
Aligning Charts on page 114 for more information.

m Non Alert Shade

m Below Alert Shade

Temp alert range

Changes the appearance and position of all charts so they correspond with L=

the settings made in Edit - Options - Charts. Figure 80: Lower Chart Control Panel

Opens the Annotation Panel and allows you to annotate the chart. Please see
Chart annotations on page 120 for further details.

Select, if you wish to show the chart's annotations, clear, if you wish to hide
them.

Select, if you wish to show each recorded Inspection Mark in the chart, clear,
if you wish to hide them. This setting also controls the Min/Max Reset Marks.

Select, if you wish to show the chart's Reading Marks, clear if you wish to
hide them.

Select, if you wish to show each recorded Download Mark in the chart, clear,
if you wish to hide them.

Select, if you wish to show each recorded Paused Mark in the chart, clear, if
you wish to hide them.

Select, if you wish to show the X-Axis (vertical) grid lines, clear, if you wish
to hide them.

Select, if you wish to show the Y-Axis (horizontal) grid lines, clear, if you
wish to hide them.

Select, if you wish to show only validated readings on the chart, clear, if you
wish to hide them. Please see How secure are my data on page 96 for further
information about non-validated readings.
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Feature

Above Alert Shade
(single-chart only)

Non Alert Shade
(single-chart only)

Below Alert Shade
(single-chart only)

Temp alert range/
Hum alert range

(HAXO-8 single-chart
only)

Hide/Show (/=4

Manual Scaling

LogTag® Analyzer User Guide

What this feature does

Select, if you wish to show readings above the upper alarm limit with a
different background color, clear, if not.

Loggers with more than 2 alarms may show more than one
background color. Please note these cannot be turned off
individually.

Select, if you wish to show readings in the non-alert area with a different
background color, clear, if they should appear with a white background.

Select if you wish to show readings below the lower alarm limit with a
different background color, clear, if not.

If the button shows Temp alert range, the alert shading uses the temperature
maximum and minimum alert values for the shading. If the button shows
Hum alert range, the alert shading uses the humidity maximum and
minimum alert values for the shading.

The Y-Axis grid lines also adjust so they align with the corresponding
divisions.

Clicking hides the Chart Control Panel when it is currently shown, clicking
=4 shows the panel when it is currently hidden.

Sometimes you will want better control over the temperature and humidity scale, or the time
window in which readings are displayed, than you can achieve with the mouse zoom.

To do that, you can enter the zoom values directly:
Right-click anywhere on the chart area and select Manual Scaling. The dialogue as shown will

be displayed.
You can select:

« Range of sensor; the chart is zoomed to the minimum and maximum values for each
sensor. These values are dependent on the logger model.

« Range of readings; the chart is zoomed so the axis covers the minimum and maximum
reading values (with a small margin added).

« Custom Range

When selecting this option you have complete control over which part of the graph is

displayed.
You can specify

200

() Range of sensor
() Range of readings
(®) Custom range
From *C

S
|

from

LO) Date
from: Wednesday, February 7, 2012

to: | Thursday, February 8, 2012

[] Applyto all open charts

OOK

Q Cancel

v | |0T:13

wv | |22:04
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Figure 90: Manual scaling window
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o The temperature (and humidity ranges if applicable) for the y-axis.

o the date and time range for which the readings will be shown. Please note that you
cannot enter dates and times outside the span of the logger's logged data.

o Alternatively you can specify an index range for the readings. You can see each reading's
index in the data tab. This is useful if you wish to display a certain part of multiple files
that do not cover the same date and time range.

Initially the dialog shows the current zoom settings.

If you select the check box Apply to all open charts, these settings will be applied to all

currently open charts as follows:

+ The Y-axis scaling (temperature and humidity) will be applied to every open chart. Range of
sensor and Range of readings use the currently active chart's sensor range or reading range
for all charts. If you want each chart to display its own sensor or reading range, please select
the corresponding option in Default Zoom in the chart options.

o The X-axis scaling (time) will be applied to every chart with readings inside the selected
time frame, including pre-start readings.

If a chart's readings fall completely inside the specified range, the X-axis will not be scaled.

If a chart's readings fall partially inside the specified range, the X-axis will be scaled so only

those readings inside the range will be displayed.

A chart will always display the readings at the time they were recorded. As a result the first

and last readings may not always align perfectly with the selected time frame, particularly

with long log intervals.

« No scaling will be applied to files where the active tab is the summary tab, day summary tab
or one of the data list tabs.

If you clear the check box Apply to all open charts, the chosen settings will only be applied to

the currently active chart.

Click to apply your selected settings, or to abort.
©

To return to the previous zoom level, click Zoom Out from the Edit menu, click zemow on the
toolbar or right-click anywhere on the graph area and select Zoom out. You can do this

individually for each chart. You can also right-click and select Zoom Readings.
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Inspection and download mark zoom

You can also zoom directly to certain parts of the chart by using the inspection mark zoom
icons on the toolbar and in the context menu. Note that these controls are disabled when a
multi chart tab is active.

/®

Zoom

Previous

O

Next

,@

Zoom Out

Zoom to inspection marks

This zooms the chart so readings are shown between the oldest reading recorded and the first
inspection mark in the data. If this function is not available then there are no inspection
marks in the data currently being displayed.

The next two commands will not be available until this command is activated.

Previous inspection mark group

This zooms the chart so readings are shown which were recorded between the first inspection
mark currently being displayed and the previous inspection mark.

This function is not available when the oldest reading is already being displayed.

Next inspection mark group

This zooms the chart so readings are shown which were recorded between the last inspection
mark currently being displayed and the next inspection mark.

This function is not available when the newest reading is already being displayed.

Zoom out

Zooms out one level of the chart in the currently active window. If you are displaying a chart
and this function is not available, then all available data are already being displayed and you
cannot zoom out any further.

L For this function, Min/Max Reset Marks are treated as if they were Inspection Marks. ]

In addition to zooming out and manually scaling the chart, you can right-click anywhere on the

chart and use these additional functions:

From first reading to first inspection/download mark

This zooms the chart so readings are shown between the oldest reading recorded and the first

inspection mark or download mark that exists in the data. This is different from the "Zoom to

inspection marks" feature as it also evaluates download marks. You can use this function to
look at the first set of data where a logger is downloaded more than once during a trip, for
example in a cold chain transport where goods are transferred from a cargo ship to a
distribution truck and you are only interested in the shipping portion of the trip.
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From last inspection/download mark to last reading

This zooms the chart so readings are shown between the last inspection mark or download
mark and the newest reading in the data.

[f either of the these menu points are grayed out you are either already looking at this part of
the data, or there are no inspection or download marks present.

In the General section of the Options you have the opportunity to define these and two
additional settings as the default when files are opened or loggers are downloaded.

From last download mark to last reading

This zooms the chart so readings are shown between the last download mark and the newest
reading in the data. You can use this function to look at the last set of data where a logger is
downloaded more than once during a trip, for example on a distribution truck which has
multiple drop off points and you are only interested in the last portion of the trip.

From last inspection mark to last reading

This zooms the chart so readings are shown between the last inspection mark and the newest
reading in the data. You can use this function to look at the last set of data where inspection

marks are placed at multiple points in the trip and you are only interested in the last portion of

the trip.
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Multi Charts (Combining Charts into a Single View)

You can overlay data from multiple loggers in
=

one view. When you click muti  in the

toolbar, all file window tabs containing data

for a single logger are combined into one
window, where you can access a Multi Chart,
a Multi Report and a Multi Data listing by
clicking the corresponding tab.

Charts will be shown in different colors, as
chosen in the color palette in the Options for
Charts, where you also define the
composition of the Chart Legend. The legend
contains an entry for each chart showing the
chart's color and the description defined in
the settings.

You can annotate a multi chart in the same
way you annotate a single chart, including a
summary statistic.

You can also view Min, Max and Average
Charts, and select other options.

When you close a newly created multi chart,
it will either be stored automatically, or you
will be asked if you want to store the chart.
This depends on the settings made in File and
Folder Settings as described on page 171.

File Edit LogTag Window User Server LogTag Online Help
) bl
ieEs B0 B8 PEOL,00
. =] V4 v
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Hiding and Showing Charts

In the multi chart window you can hide each
chart individually. Right-click anywhere on
the chart, point to the entry of the file you
wish to hide and click to clear the tick. To
show the chart again, repeat the procedure
and select the name again.

You can also hide all humidity readings, or all
temperature readings. A tick will indicate the
readings that are hidden. To show these
readings again, click the entry once more.

Note: If the temperature readings are
hidden, and you click Hide Humidity
Readings, the temperature readings
will be shown and the humidity
readings hidden.

Opening additional files

If you open additional files, these will initially
be shown in separate file window tabs,
including data from freshly downloaded
loggers. You can add the data for these files
to an existing multi chart. Right-click
anywhere on the multi chart and point to
Attach Document. Click the name of the file
you wish to add.

Removing files from the multi chart

If you wish to permanently remove a file from
the multi chart , hide the chart as described
above, then save the file.

Once saved, hidden files will be
permanently removed from this
chart. To prevent data loss, ensure a
copy of the individual file was saved.

£
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Figure 92: Shortcut Menu after right-clicking on chart area
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More than one multi chart window

If you open at least two additional files, you
can generate a second multi chart by clicking
the multi chart icon from the toolbar. All files
shown in separate windows will be combined
into a new multi chart window. The new multi
chart window additionally contains all charts
from the original multi chart, but they are
initially hidden. They can be shown as
described on the previous page.

The Summary tab is not available in
the multi chart display. If you require
additional information about the
chart data, activate the display of the
desired statistics in the Chart
Statistics section in the Options
Window (Chart Statistics on

page 154). The chosen values will be
displayed separately for each chart.

& J

Extracting individual files from a multi chart

A multi chart contains the complete data sets
for each of the loggers from which is was
generated.

You can view the data for each individual
chart in a single-chart window by extracting
them to a *.1tdx file.

Right-click anywhere on the chart, click Open
Document and click the name of the file you
wish to extract. A new file window tab will
open, showing the contents of the extracted
file, which is saved in the same location as
the multi chart.

LogTag® Analyzer User Guide
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Aligning Charts

Select Align Charts from the Chart Control Panel to automatically align all charts in the current

multi chart window to the earliest start time:

« When Started Readings is selected, the charts are aligned so the first started reading is
shown at elapsed time zero. Charts with no Started readings (i.e. charts with only pre-start
readings) are hidden in this view.

o When Pre-start Readings is selected, all charts with Pre-start readings are aligned so the
earliest Pre-start reading is shown at elapsed time zero. Charts with no pre-start readings
are hidden in this view.

« When All Readings is selected, all charts are aligned so the earliest reading is shown at
elapsed time zero, regardless whether this is a Pre-start reading or a Started reading.

Every chart is assigned a different color based on the Chart palette and elapsed time is shown.

If you use the toolbar Icon to switch to Real Time, the charts will be shown in their
original relative position.

Shifting Charts

For easier data comparison, chart start times can be shifted while you are viewing the multi
chart display.

To shift a chart, move the mouse pointer over the chart until a tooltip from that chart is
displayed. Right-click, then click Shift Chart. A dialog box will be displayed, where the new
start time and date can be selected.

Click the down arrow next to the date to display a calendar where you can select the new start
date. Highlight the hours or minutes from the time and use the up and down arrows next to
the time to change the numbers.

You can revert the chart to its original display by clicking Original start time.
To apply the selected start date and time click‘

Min/Max/Average Chart Display

When you click the Average icon sesse in the toolbar, the currently active multi chart file tab
will now show charts for the calculated values of rmmmurn maximum and average readings,

instead of the individual charts.

Switching from Average display to Standard display and vice versa, or changing the Readings
Range will force the multi chart to be re-drawn according to the default settings. You can then
use the standard zoom controls to show the portion of the charts you want to see.

Select new start date and time for Warming Drawer
Example

Sunday, October 1, 2017 v | 1549 (C)=

(¥ original start time

Figure 93: Shifting a chart
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You can annotate the Average Chart in the same way as any other chart tab; such annotations
will be visible in the other chart tabs and are stored with the multi chart when saved. An
annotation that is linked to a data point on the chart will still be shown, even if the data point
itself is no longer being displayed.

Please note the following behavior:

Zoom settings will not transfer to the Average tab.
Download marks and inspection marks will not be displayed in the "Average" tabs.

Non-validated readings and re-calibrated readings will not be displayed with the special
attributes, even if set in the options. If you have chosen to show non-validated readings,
they are included in the minimum/maximumy/average calculations, otherwise not.

To avoid memory overflows, the maximum number of data points or loggers that can be
shown in the average chart is restricted. If you try to show average charts outside these
limits, you will see this warning message:

If one or more of the charts have sections with readings outside the LogTag®'s sensor
range, LogTag Analyzer is unable to calculate the minimum, maximum and average values,
and those sections of the graph will not be displayed. This will likely result in a "broken"
graph line, regardless of whether show readings beyond specifications in the Charts section
in the Options Window is enabled or not (Charts on page 155).

Due to the large number of calculations performed in this feature, specifically when opening
large numbers of charts spanning long periods, having the Average displayed can occupy
large amounts of memory and run slow. Therefore we recommend only turning the feature
on when required.

Clicking on the Average Icon in the toolbar again will turn the average display off. Selecting the
single charts command in the toolbar will open each chart in the multi chart in a separate File
Window, however the Average Chart tab will not be closed.
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Analyzer does not currently support Average functionality
for data sets greater than 100,000 readings or more than 200
loggers.

Figure 94: Warning: Too many charts open
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Behind The Scenes

To create some meaningful results, LogTag Analyzer uses a special trend line process to
calculate the minimum, maximum and average values across multiple charts, rather than a
histogram. It is important you understand this mechanism, so you can interpret the displayed
readings correctly.

This is an example of two loggers, one with a 5 minute log interval (A) and the other (B)
logging every 2 minutes.

Before the data are displayed in an average tab, LogTag Analyzer normalizes every chart's
readings so they fall in line with the logging interval of the LogTag® with the shortest log
interval, in this case unit (B). It does not shift any charts, but rather calculates a theoretical
value for those reading times by linear interpolation. Interpolation determines probable
environmental conditions, i.e. what the LogTag® would have recorded had it taken a reading at
that time.

Without this method, it would not be possible to compare units with different log intervals, or
those that have the same log interval, but were started at different times.

As a result of this process, absolute values for minimum and maximum may not always be
shown if they do not fall on normalized times, as seen in the example at 10:35 - despite 21 °C
being the maximum it will not be displayed as it is not a normalized value.

Note: The charts in above example are based on loggers started at the same time. If
unit (A) had been started earlier, depending on the start time unit (B) may also have
its readings interpolated. To ensure the chart with the shortest log interval always has
its real values shown, please use the Aligning Charts function from the context menu.
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Figure 97: Multi chart data - normalized min/max/average curves
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Dew Point

Theoretical background

At any given temperature, air can contain no more than a certain amount of water vapor before
it is saturated. Relative humidity is one way of describing how much water vapor is currently
present in the air in relation to how much there would be if the air was saturated.

Relative humidity is therefore described as a percentage. The higher the temperature, the more
water vapor the air can hold, the lower the temperature, the less.

The dew point is defined as the temperature air needs to cool down to, so it becomes saturated
with moisture. The water vapor then condenses and forms, for example, dew, rain, fog or
Snow.

If a foreign body is brought into an environment, and it is colder than the dew point, moisture
will form on the surface of that object.

Knowing dew point and its difference to the current temperature will allow you to assess how
likely it is that condensation will form on the goods or materials you monitor.

Since dew point is closely related to temperature and relative humidity, it can be calculated if
those are known, for example, using a temperature and humidity logger such as the HAXO-8 or
UHADO-16. LogTag Analyzer uses the Magnus formula with the Sonntag ITS-90 constants for
an approximation of the dew point, that does not take into account atmospheric pressure. The
approximation is typically accurate for temperatures between -45 °C and +60 °C, but carries
some small errors, which can be estimated from the chart below. The formula is less accurate
for water vapor over ice.
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Figure 98: Formula used for dew point

Dp(1,RH)

T

RH

4

Dew point calculated from
relative humidity and
temperature

The temperature at the
calculated data point.

The humidity at the calculated
data point.

17.62, Sonntag ITS-90
constant

243.12°C, Sonntag ITS-90
constant
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Figure 99: Approximate dew point error for humidity/temperature
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Application
The dew point shows as an extra line on charts for temperature and humidity loggers, such as
the HASO-8, HAXO-8 or UHADO-16.

R, LogTeg Anatyoer Venion 328 e
Fle Edt LogTag Window UsarServer logTag Oriine  Help
A&EERB BBl B CL,PFO00BEHM. O
Wod o See Pt | Propees Sgbees SedMal Upied  Copy Eapoed Zosey' o Nei | Avbage W Sopie ||| Opoes
S2FEIBII Started 20082019 Finished 24082000 (2] - x
Temp °C HAXO-8: 82FB181333 Started 20/08/2019, Finished 24/08/2019 Hum %RH (B Zoomou
100 Zoom Resgiogs
o I R

210 Feoo o
180 |70 pressous
1 Lsso Hest
120 Lais feset 1a Deust
aveotyte Crart

Dew Point

E3

2
WENBNWB | 2GHBAGE  WDBOHESE 738 * % OGSIBOTHIE  GAM0003 2308203 10423
— Huridty (5] — Tergersure () — DewPent (T}
Report | Chart | Data Summary =

For Help, prest F1. To use s LogTag. press F2. (7] Select Display TimeZone = Local PC TimeZone (Display Clock Adjuited)  Pending Emaite 0 Uplosds 0

By default, this feature is disabled. You can enable it in Options in the section about Charts on
page 155.

If the dew point line is enabled, you can toggle it off and on by right-clicking

anywhere on the chart and clicking the Dew Point entry:
| ¥| Below Alert Shade

Humidity (%RH)
Temperature (*C)

Dew Point (°C) |
L=

If the dew point line is disabled, this menu entry is not available.

\.

Dew point lines are not currently supported on multi-charts.
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Chart annotations

You can include additional information in your chart tab by adding textual and graphical
annotations. Annotations are stored in the *.1tdx file and will be shown again when you next
view the file. Annotations will be printed, and will also be shown on anyone else's computer, if
you are sharing annotated files. You can place up to 58 individual annotations.

If a chart's annotations are currently shown, you can hide them by right-clicking anywhere on
the chart and clearing the tick for Show Annotations. You can show them again by selecting
Show Annotations. You can also perform both actions via the Chart Control Panel.

Adding Annotations
To start annotating charts, right-click anywhere on the chart and select Annotate Chart from
the menu. This will open the basic view of the Annotations Panel.

You can also open this by clicking Annotate Chart from the Chart Control Panel.

When the Annotations Panel is open, an annotation will be placed at the position of the mouse
pointer every time you click the mouse button on the chart canvas. You can choose different
types of annotations with different behavior.

The following table explains what each of the options in the Annotations Panel mean and how
they influence the look and position of the annotation:

Table 17: Basic annotation options
Option Selection What it does

Anchor type Chart Point If a Chart Point annotation is placed, the annotation will always be
linked to the time stamp of the reading on which the mouse pointer is
positioned when placing the annotation. If the chart is zoomed or
panned, and the data point is not visible, the annotation is also not
shown. When a chart becomes part of a multi chart, all chart point
annotations for the single chart are also visible in the multi chart.
Chart point annotations are good for marking specific times on the
chart with additional information.

Background If a Background annotation is placed, the annotation will always be
linked to the position on the canvas in which it was placed. Even if the
chart is zoomed or panned, the annotation will always stay in the
relative position from the canvas edges.

Background annotations are good for placing information relating to
the entire chart. The Statistics Information for example is placed on
the canvas using a background annotation.

Copy
Delete Annotation

Annotate Chart M
Lag

Zoom Cut
Zoom Readings

Manual 5caling

Show &nnotations

Inspection Marks

JIE

Reading Marks

Figure 100: Chart Right-Click Menu

Annotations Advanced
Anchor Type: | Chart Point v
Add DataPoint Infnrmatimn

Type: Callout Rectangle v

Figure 101: Chart Annotation Panel
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Option

Add DataPoint
Information

Add Series
Information

Type

Selection

Enabled
Disabled

Enabled
Disabled

Callout
Rectangle

Callout Ellipse

Line

What it does

This option can only be selected when the Anchor type is Chart Point.
If enabled, text will automatically be added to a callout, showing date,
time, value and type of reading. If disabled, the callout will be empty.

This option can only be selected when the Anchor type is Background.
If enabled, text will automatically be added to a callout, showing the
charts series information from the legend. If disabled, the callout will
be empty.

When this annotation
type is selected, a
rectangular callout shape
is used when placing the
annotation. If the Anchor type is Chart Point, a pointer to the related
reading is also added, To add text or change the automatically placed
text double-click the annotation.

When this
annotation
type is
selected, an 11/30/2012 10:48:21 AM
elliptical 19.7 °C

callout shape 1112 0050 Trip:2_2307 °C
is used when
placing the
annotation. If
the Anchor type is Chart Point, a pointer to the related reading is also
added, To add text or change the automatically placed text double-
click the annotation.

11/30/2012 10:48:21 AM 19.7 °C
1112 0050 Trip:2_2307 °C

When this annotation type is selected,
you can place a line on the drawing
canvas:

» Move the mouse pointer to where you wish the line to start

e Press and hold the mouse button
» Move the mouse pointer to where you wish the line to end
e Release the button
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Option

Selection
Arrow

Rectangle

Chart Statistics

LogTag® Analyzer User Guide

What it does

When this annotation type is selected from
the drop down, you place an arrow on the

drawing canvas:

* Move the mouse pointer to where you wish the arrow head to start
e Press and hold the mouse button

* Move the mouse pointer to where you wish the arrow tail to end

* Release the button

When this annotation type is
selected from the drop down, a
rectangular shape is placed on the
drawing canvas. This rectangular
area is useful for highlighting
sections of the chart, but please note that you cannot place text inside
this shape.

This annotation is only available as a Background annotation. When it
is selected from the drop down, a rectangular callout is placed on
drawing canvas, and text will automatically be added to the callout,
showing the information defined in Chart Statistics on page 154, for
example range of readings or min/max/average values.

Tip: If you wish to place a rectangle with text inside, place a
Chart Statistic Annotation and replace the text with your
own.

You can refine the appearance of annotations in the advanced view of the Annotations Panel.
This view can be activated by clicking the Advanced button when the Annotations Panel's basic

view is shown.

You can click Basic to return to the basic view. If you close the Annotations Panel while in
advanced view, next time you open it, it will also show the advanced view.

You will be familiar with these options from many other Windows programs:

Group
Style

Selection

Line width
Line Style
Line Color
Color
Transparency

Table 18: Appearance settings
What it does

These parameters define the look of the shape object that is
placed with every annotation. Line width, style and color define
the outline of the object, color determines the object's fill color
and transparency defines how opaque or transparent the object
will be. 100 is equal to the object being fully opaque, 0 to the
object being fully transparent.

Annotations I Basic |

Anchor Type: Chart Point v
Add DataPoint Information|v/|

Type: Callout Rectangle v
Style
Line Width |1 %
Color . Line Style |Solid v
Transparency '100 = Line Color .
Font
Font Color: D size (10 3
Font: .Segerl v
Font Style: ’Normal v

Figure 102: Advanced View of the Annotations Panel
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Group Selection What it does

Font Font Color These parameters define the properties of the font used for text
Size inside the callouts. Note that only a small selection of system
Font fonts is available.
Font Style

Note: Mouse zooming and panning is disabled when making annotations.
You can, however, still use manual scaling to zoom to the desired section of the chart.

To stop annotating the file, close the Annotations Panel; right-click anywhere on the chart and
select Annotate Chart from the menu. You can also close it by clicking Annotate Chart from the 22 HAXOE TI00BERS [z
Chart Control Panel or by clicking the Annotations Panel's Close button . If you change file ' e
window tabs, the Annotations Panel closes automatically.

pm |

Chart annotations added in the chart tab will also show in the chart displayed at the
bottom of the Report Display on the next page, which is much smaller. If you want the
text to remain legible in the Report tab, you may need to choose a larger font and
increase the size of the surrounding frame to suit. If you intend to print the Report we
recommend you trial a suitable size for the font using the advanced view. Figure 103: Chart with different types of annotations

[ 1900001875029pm |
Humidity [%ARH) X6

Editing Annotations
To change the position of an annotation, use the mouse and point to the annotation. When the

pointer has changed to ‘%9, press and hold the mouse button, move the annotation to the
desired location and release the button.

To change the size of an annotation, click inside the annotation. The sizing handles appear.

Use the mouse and point to one of the handles until the cursor changes (jﬁ, b, N, " Or +).
Press and hold the mouse button and drag the handle to the desired size.

To edit the text of an annotation, double click the annotation.

Deleting Annotations
To delete an annotation, click inside the annotation and press the Delete key. You can also
right-click inside the annotation and click Delete Annotation.
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Report Display

The Report display tab provides a convenient and quick way of seeing
all important information for a trip in one single screen.

The graph area shows the same chart segment as the one you see in
the chart tab. The zoom controls do not work in the report tab, so if
you wish to show only a particular segment, you need to zoom to this
segment in the chart tab before viewing the report. Annotations are
visible, but the chart cannot be annotated when in the Report Tab.

Click to open a window where you can add text:

ne YD :‘l‘-qIQAArial v'12v_

Receiver Notes are here !

O o

5

Figure 105: Receiver Notes Entry Dialogue

This text is stored in the file, and displayed in the report's Receiver
Notes section every time the file is opened. Use the dialogue toolbar's
controls to format the text.

Click to display a window with the logger's factory
calibration certificate (if available). See Calibration Certificates on
page 89

The Events Info section lists all events that have taken place during
the trip. You will see if a logger has been previously downloaded ,
when an inspection mark was placed, when readings were paused or
when the clock was manually changed on a logger with a display.

If a probe was changed during the time shown in the chart, a Probe
Change event will be shown in this list, if either the removed or the
added probe was a Smart Probe.

LogTag® Analyzer User Guide

& i of 1 b ¥l |08 cd Wholepage ~

l.“o‘gTag

Alarm Status Recorder Info
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Receiver Notes Show Certificate

Download and

Recorder has been Downloaded 10/23/2003 5:46:46 AM
Timezone

Mote: All Date-Time values are in UTC +01.00 DayLight
Information

Low X Fail || Serial # 000B110337 Model: TRIX-8
High 3 Fail | | Description: Warming draw - Oven #5

Battery: OK Trip #: 2
= General
Information

‘Marm_ Recorder Configuration
ETET Starttype : Push button start
Start delay - None

Interval : 30 Seconds
Alert indicator - Enabled lower & upper
OK indicator = Enabled

Temperature alarms
Lower : 25.5 °C after 2 Consecutive
Upper : 38.5 °C after 2 Conseculive

Recorded Data

W Configuration
Information

First reading : 10/1/2003 3:4942 PM
Lastreading . 10/1/2003 8:46:42 PM

Elapsed time © 4 Hours 57 Minutes 30 Seconds
Trip | Tolalreadings - 595
First evaluated | 10/1/2003 4:3642 M
Information Last evaluated - 10/1/2003 7:3842 PM

Evaluated Time : 3 Hours 2 Minutes 30 Seconds
Evaluated Readings = 365

Temperalure slatistics

Lowest. 232°C

@ 10/1/2003 6:25:42 PM
Highest - 45.7°C

@ 10/1/2003 6:4242 PM
Average reading 38.2°C

Standard Deviation: 5.1 *C(SN)

MKT(AH80) 393°C

Low Alarm

High Alarm

Triggered: 10/1/2003 6:19:42 PM
Time below/equal: & Minutes
Low =5 Ocourrences - 1

Alarm Info

*C - Minutes below = 10 60

Triggered. 10/1/2003 4.37.12 PM

Time above/equal: 1 Hour 20 Minutes 30 Seconds
Occurrences . 2 — High
*C - Minutes above = 345 75 Alarm Info

e et b s el

Events Info

Event
Information

Tnspection
Download

10/1/2003 4:43:12 PM
0/1/2003 6:22:42 PM

10/1/2003 6:2612 PM
10/1/2003 7:35:12 PM

Inspection
Inspection

Receiver

Notes

Report | Chart Dats  Summary

Figure 104: Report Tab
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You will also see an entry for each time a digital signature was applied
to the file, together with information which signature was applied by
which user.

For each block of paused readings in USB loggers only the first
and last reading are listed.
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Multi Chart Reports

A multi chart can also be viewed in the report tab, where you can see a B4 SIrHIRSIE o <A [
brief summary for each logger, a and a smaller version of the chart. L ogmg Recomen Iintieme D Te Dl Dot i) ———
Chart annotations added here will also show in the chart that is i a3 Information
displayed at the bottom of the Report Display on page 124, which is Descrpton A Totl 1 e s
. First reading = 22/08/2011 10:00:00 pm Last reading © 25/08/2011 9:53:30 am
much smaller that the one in the chart tab. If you want the text to Eheouk i & Cogs et e St T
remain legible in the Report tab, you may need to choose a larger font L s
and increase the size of the surrounding frame to suit. The report also o S T —
. Elapsed time . 2 Days rs 56 s Total re: s . 7192
shows a summary for the combined data of all loggers that make up Readoga ringe. 08 10205T Avecage madeg: 10
. . . MKT(aH B3.144) 155 Standard Deviation. 9.7
the multi chart, separately for all readings and the zoomed readings. ST O o T
Fw[:l':‘T::;" ;goggzi'ljﬁwwpm LmruT::; ;;’MHQEHDW
Elapsed time - 2 Days 11 Hours 54 Minutes Total readings : 7188
Readings range: 6.4 10 21.3°C Average reading: 14 8°C
MKT(aH 83.144) 16.7 Standard Deviation. 6.1
Info for I ann‘::a: NOTI:HI‘-‘A lr.::: 11.?“
IR Elupaedtims - 2 Daya 1 Howrs 55 ntes Totsradingy 7190
Loggers Readings range” 8010 233°C Average reading: 15 9°C
MKT{AH 83.144) 176 Standard Deviation: 5.8
Dus:::no: :Er-nms lr‘::: 1"?“
First reading : 22/08/2011 10:00:00 pm Last reading : 25/08/2011 9.55.00 am
Elapaed tima ;52 Dors 1) Hours 35 Menutes Total readings - 7191
Readings range: 5610 25.7'C Average reading 14.2°C
MKT(aH 83 144) 16.8 Standard Deviation: 7.2
Serial # 5010002909 Model: HAXO-8
r.f'f?:.“l'i",;" ﬁ$:1.|;wwpm uslna::g' :mngssm am
Elapsad time 33 Dot iy OU® 50 Minutes Total readings - 7191
Readings range: 7510 22.0°C, 4.2 10 97 9%RH Average reading  15.8°C, 40 T%RH
MKT(aH 83.144) 176 Standard Deviation: 5.9
Senial ¥ 501?0&1 l:ndd HAXOS8
o ion estfile #® 27
rf:l:.Tﬁ-'ng ;?omn |aDDﬂDepm llslrnﬂﬂ:g ;woapmussﬁctam
Elapsed time Jgg:z;:""“" 55 Miuase Total readings - 7191
Readings range: 5.0to 218°C. 18.910 91 5%RH Average reading 15 1°C. 47 5%RH
MKT(aH 83.144) 172 Standard Deviation: 6.5

Statistics for All readi
Combined Readings range -1510 25 7°C, 42 10 97 3%RH Average reading 13 6°C, 44 1%RH ]

202 of zoomed range of g
Statistics J Readings range 13 10 220°C. 42 1o 97 9%AH Average rmading 13 6°C. 44.0%RH ]

DOGNT DGR DADN  ZGGMN1 DGR JGGAN  JUGMOON JGEIN  JMBXY  Smoon  Jwsan
GG AS0eem  S0Ge  AMOign  WWOe 00t MiGies  3@Gen MG 3N0e  FMGim
.

SRAIUN AT T MATURN AT AT AT MAT AT AT @ epeies

Multiple files in the report Receiver
= T Notes

5082023112827 am Page 10f1
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Data Display

When you click the data tab, the readings are displayed in a
spreadsheet-like list in chronological order, including an index, date &

Index Date Time Elapsed Temperature *C Events Comment

7 21 PM 04:58:00 -202 Below Alert

time and elapsed time. Headings 30351 PM 04:58:30 203 Below Alert
. . oreee 4:04:21 PM 04:59:00 -204 Below Alert
The data tab only displays those readings shown on the chart. If the o s | sowsirw | oames0 20 . Readings below

chart is zoomed in, the data tab only shows those zoomed readings. €01 /12013 ASZLPM 030000 208 pelow Aert lower limit
. . 602 10/1/2013 . 405:51 PM 05:00:30 =207 Below Alert
You cannot use the scroll bar or arrow keys to display readings before o e s s100 P Fe——
or after the currently zoomed readings; to expand the number of 02 ) ) 205 selowAler
| ; 505 Reading with 143
readings switch to the chart and zoom out. e . e .
. o Min/Max Reset Mark e In-Spec Readings
For temperature and humidity loggers such as HASO-8, HAXO-8 or e T e o o
UHADO-16 the humldlty values will be dlsplayed in their own Column, 09 10/1/2013 40921PM | 05:0400 121 Above Alert
3 3 - 3 - 610 145 Above Alert
so will dew point values if this feature is enabled. = Reading with e _
I Index sl Time I Elapsed I Humidity %RH -'Iemperam'e'c. Bewpoik’c. | Events Comment  * &2 Inspection Mark 88 Readlngsabove
| e 21mse09 074526 010300 535 2538 195 i £ &e Above Alert upper limit

10/1/2013 05:06:30 45 Above Alert

65 21/082019 074626 0104:00 693 258 198
66  21/0872019 074726 010500 690 28 197 615 10/1/2013 4z 05:07:00 3L Above Alert
. . . . 515_ 4:12:51 PM 05:07:30 362 Above Alert Inspection Mark

On the list you can also identify any special marks attached to the s o205 [WAEELRMN ososco 19 Abowealert Downlosd Merk
reading, such as download marks (identified through rose o e i | e e e Scroll Bar J
background), inspection marks (identified through red bac}{ground), 20 Reading with 82 Aeownet
paused marks (identified through blue background) and min/max reset = Download Mark = —
marks (identified through green background). The text color identifies o3| W ARV | ST 53 Above Alet .
if a reading has been above the upper alert value (red), below the Report  Chart | pata | Summary A1l Readings v

lower alert value (blue) or within specification (black). You can scroll
through the readings with the arrow, page up/down, home and end
keys, or use the mouse wheel.

You can sort the list by clicking one of the column headers. This can
be useful, for example, when you want to look at all events and the
times they occurred.

You can add a comment for each reading. This comment will be stored
against the reading when you save the file. In the row for which you
wish to add a comment, click in the Comment column and type your
text.

The list grid can be copied to the Windows clipboard and pasted into
other windows applications such as Excel. Press CTRL-C to copy the
entire currently displayed list. Copied data always include the header
row, even if it is not highlighted, and are always sorted by index. You
can also click Copy from the Edit menu, or right-click in a row and
click Copy All. You can also copy only the highlighted rows if you

Figure 106: Data tab
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right-click anywhere in the highlighted section and click Copy
Selected. You can select as many rows as you wish using the mouse.
Point to the first row you want to select. Press and hold the mouse
button, drag the pointer to the last row you wish to select, and release
the button.

LogTag® Analyzer User Guide
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Multi Chart Data Tab

Data listings are also available when viewing a
multi chart. Here, the data listings for the
individual loggers are combined into a single
list, with each row representing one reading
from a single logger.

Marks, text and background colors are shown
in the same way as for single file lists.

Readings are initially sorted and indexed
chronologically, but can be sorted by clicking
one of the column headers. This can be
useful, for example, when you want to look at
all readings from a specific logger. If you wish
to return to the original chronological sort
order, simply click the Index column header.

You can add a comment for each reading. This
comment will be stored against the reading
when you save the file. In the row for which
you wish to add a comment, click in the
Comment column and type your text. Copy
and Paste functions work identical to the
single file data tab.

If you combine more than 10 charts
into a multi chart, the data tab is not
available. Dew point readings are not
shown in the multi chart data tab.

LogTag® Analyzer User Guide
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Index | Serial #: Date Time Elapsed  Humidity%RH | Temperature °C Events Comment =
73 FFIBE20425  23/08/2011 1005:00 00:05:00 72
74 0060D20511  23/08/2011 100500 00:05:00 99
75 7000045085  23/08/2011 100500 00:05:00 84
76 23278M 23/08/2011 1005:00 00:05:00 19
77 0018230625  23/08/2011 1005:00 00:05:00 09
78 5010000827 /08/20; 90
79 5010002909  23/08) Logger Serial Numbers 94 Below Alert
80 FFIBE20425  23/08/20 2
31 0060D20511  23/08/2011 1005:30 0005:30 99
82 7000045085  23/08/2011 100530 00:05:30 84
8 23278M 23/08/2011 100530 00:05:30 18
84 0018230625  23/08/2011 1005:30 000530 09
85 5010000827  23/08/2011 1006:00 00:06:00 412 90
8 5010002009  23/08/2011 1006:00 00:06:00 379 94 Below Alert
87 FFIBE20425  23/08/2011 1006:00 00:06:00 72
887~0Q60D20511  23/08/2011 1006:00 00:06:00 99
8 7 84
90 23278M 18
91 0018230625  23/08/2011 1006:00 00:06:00 08
92 5010000827  23/08/2011 100630 000630 535 90 Above Alert
93 5010002909  23/08/2011 100630 00:0630 696 95
94  FFIBE20425  23/08/2011 100630 00:06:30 72
95 0060D20511  23/08/2011 1006:30 00:06:30 99
96 7000045085  23/08/2011 100630 00:06:30 84
97 23278M 23/08/2011 100630 00:0630 18
98 0018230625  23/08/2011 1006:30 00:06:30 09
99 5010000827  23/08/2011 1007:00 00:07:00 483 90
100 5010002909  23/08/2011 1007:00 00:07:00 579 95
101 FFIBE20425  23/08/2011 1007:00 00:07:00 70
102 0060D20511  23/08/2011 1007:00 00:07:00 99
103 7000045085  23/08/2011 1007:00 00:07:00 84
104 23278M 23/08/2011 1007:00 00:07:00 18 5
Report  Chart | Data |

Figure 107: Multi chart data tab
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Summary Display

The summary tab offers a brief statistics overview of some of the important trip data. You can
customize the statistical data you wish to include in this tab in the Options dialogue for the
Summary Statistics on page 152.

The first section shows the data for the complete trip, regardless of whether or not the chart is
zoomed in. The second section is only displayed if the chart is zoomed in, and displays the
statistics for only the zoomed readings.

If there are readings beyond the limits of the sensor within the time interval displayed, the
statistics for this interval will show "**".

The zoom controls available for the chart tab are inactive in the summary tab.

If inspection marks are present in the data, statistics summaries for each of the inspection
mark groups in the data can be seen amended to the end.

The list grid can be copied to the Windows clipboard and pasted into other windows
applications such as spreadsheets, including the list header row.

Displaying statistics
The statistics displayed on the Summary tab can be configured in the Options dialog. Refer to
the topic on Summary Statistics on page 152. By default, all statistics are displayed on the
Summary tab.
For temperature and humidity loggers two additional statistics are automatically shown when
the dew point feature is enabled:
« Dew point offset range
The dew point offset is the difference between the temperature and the calculated dew
point. The closer this offset gets to 0, the closer the temperature is to the dew point. The
dewpoint offset range is a measure of how close the dew point got to the actual temperature
during the trip.
« Average dew point offset
The average dew point offset for the recorded data.

Statistics can also be displayed on the chart, in a Chart Statistics Annotation. Refer to the topic
on Chart Statistics on page 154 for more information about configuring the chart statistics.

[f there are readings beyond the limits of the sensor within the time interval being displayed,
the statistics for the relevant interval will be displayed as "**".

4 | Statistics for Started readings

LogTag ID
Description

Battery status

Time zone

Reading interval
Number of starts
Number of readings
Number of started readings
Non alert range
First reading

Last reading
Elapsed Time

Readings range

6045000020

OK

UTC +13:00

30 Seconds

4

16129

16129

0.0 to 201°C
10/7/2016 3:59:08 PM
10/13/2016 6:23:08 AM
5 Days 14 Hours 24 Minutes 30 Seconds
158 to 27.1°C

4 Statistics for between the first reading and inspection mark #1

First reading

Last reading

Elapsed Time

Readings range

Average reading

Standard Deviation (S}

Time below/equal lower alert
Time above/equal upper alert

Time not in alert

10/1/2003 12:00:51 PM
10/1/2003 1:12:21 PM
1 Hour 12 Minutes
-81 to 126°C

10.7 °C

37C

None

1 Hour 12 Minutes

None

Degree Minutes below lower alert 0.0 *C-Minutes

Degree Minutes above upper alert 1657.5 *C-Minutes

Mean Kinetic Temperature

113°C

First reading

Last reading

Elapsed Time

Readings range

Average reading

Standard Deviation (S)

Time below/equal lower alert
Time above/equal upper alert

Time not in alert

4 |Statistics for between inspection mark #1 and inspection mark #2

10/1/2003 1:12:51 PM
10/1/2003 4:12:21 PM

3 Hours

-144 to 145°C

-125°C

47°C

None

26 Minutes 30 Seconds

2 Hours 33 Minutes 30 Seconds

Degree Minutes below lower alert 0.0 *C-Minutes

Degree Minutes above upper alert 2244 *C-Minutes

Mean Kinetic Temperature

-92°C

page 130

Figure 110: Statistics tab when inspection marks are included
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Day Summary Display

The day summary tab is displayed for
LogTag® models with an integrated statistics
memory.

LogTag® logger products with display

Min. reading

For these logger models the day summary IIE{W pate | wam | MR || rime avovereausluoper ser Time below/equa louer sert |
H M o 10/31/2016 12 0 o7 o
dlsplay ShOWS the hlStory .Of up t_o 30 days> | 1 10302016 25 0 01 0 Day summary header row
arranged into 24 hour periods, with | 2 tonsnons i o 12 0
information about maximum and minimum ag— 2 : = - .
. | i Summary Grid
values for the day, and if alarms have been [ 5 tncce @ ;s & 102y A 0
. d h d £ 107252016 @ 186 A 1Day 179 A 0
trlggere on t ose ayS -7 10/242016 | 199 A 10 Minutes -17 Y 9 Hours 10 Minutes

The Day summary grid can be copied to the
Windows clipboard and pasted into other

windows applications such as spreadsheets, Alarm Marker Above Limit Marker Below Limit Marker

including the header row.

Report Chart Data Summary DaySummary

Figure 111: Day summary for loggers with display and

statistics memory
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Printing the results

Printing from LogTag Analyzer is similar to printing from other
Windows software.

Before you print for the first time, however, we suggest you take some

time to set-up your preferred page settings.

Page Setup

Click Page Setup from the File menu; the Page Setup window will be
displayed.

You can set page margins, paper size and orientation. You can check
what the print will look like by clicking Print Preview from the File
menu, as described on page 42.

Printing a single document

Click the Print icon () on the toolbar or click Print from the File

menu to display the Print window.

Choose a printer and, if required, adjust its properties.

Choose the range of pages to be printed:

o All - All pages will be printed

« Selection - Prints the range of readings you selected, for example
by highlighting rows in the data tab.

o Current page - Prints only the current page.

« Pages - Prints only the pages you specify in the text entry.

Please note that LogTag Analyzer will try to print charts and reports

on a single page where possible.

Printing multiple documents

You can print all currently open documents at once.

Click Print All from the File menu; the printer dialogue will be
displayed. After you have made your selection click print, and each
document's currently active tab will be printed with the respective

zoom settings.

LogTag® Analyzer User Guide

Margins

Left: —
807 Cm— 807
C—

Orientation Paper
(®) Portrait Size: | A4

) landscape
o ok 0 Cancel 0 Help

Figure 112: Page Setup Window

General

Select Prrter
76 Adobe PDF FHP Color Laserlet CPISH
= Brother MFC-L2700DW series Printar 5 HP Laserlet 5

EiFax FHP Laseriet M1522 MFP
< >
Status FReady [OPittotic | Preferences

Location:
Comment

Page Range
@@ Mumber of gopies: [1

() Pages: i ] Colate >
Erter ether a sngle page number or a sngie 1 2
page range. For example, 5-12

o] [ e ] [ oo

Figure 113: Printer dialogue
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Printing multiple documents on high-resolution monitors can make
your computer unresponsive for long times. We recommend to print
no more than three documents at the same time.
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Automatically calculated statistics

When displayed recorded data, the software will automatically calculate and display some
statistics calculated from those data. These statistics are shown on the summary tab and are
also calculated for each sequence of data points between the inspection marks.

If any readings within the time interval are beyond the limits of the sensor, the values for
Average Reading, Standard Deviation, and Mean Kinetic Temperature will not be displayed for
the relevant time interval .

Average Reading

The Average Reading is the arithmetic mean of the sequence of data points. It is calculated by
adding all the data point values together and then dividing the total by the number of data
points. Mathematically this formula can be expressed as illustrated.

For example, if there were 5 data points to calculate the arithmetic mean of and they were,
12.3, 15.9, 16.2, 14.7, 14.9, then the arithmetic mean would be 14.8.

The number of decimal places displayed can be set to 1, 2 or 3 by clicking Options from the Edit
Menu, then navigating to the Summary Statistic section and selecting the number of decimal
places from the Decimal Places entry. Please note this setting is shared amongst all statistics
calculations.

n
Dot
=1

n

av —

Figure 114: Formula for average reading

av is the calculated arithmetic mean
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I is the number of data points to include in

the calculation

tj are the sequence of data points to include in

the calculation
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Degree Minutes

Some products and materials change their characteristics or degrade, if they are exposed to
temperatures outside the ideal conditions for extended periods. For example, some products
may experience freezer burn if they experience an extremely cold condition or experience a
colder than ideal temperature for a long period of time. LogTag Analyzer will automatically
display the results of two separate Degree Minutes calculations. The result of the first is based
on the readings recorded below the "ideal conditions", the second on the readings above the
"ideal conditions". The "ideal conditions" used in the calculation of the Degree Minutes
formula are represented by the non-alert range based on the upper and lower alert values
entered during configuration of the LogTag®.

Mathematically the formula for calculating the degree minutes above alert can be expressed as
illustrated.

For example, if there were 5 data points to calculate the degree minutes of and they were, 12.3,
15.9, 16.2, 14.7 and 14.9 degrees, each of these temperatures were recorded at 2 minute
intervals and the high alert temperature threshold was 12.6 degrees, then the degree minutes
temperature above the upper alert threshold would be 22.6 degree-minutes.

page 135
n
degmin = ) abs(t; —a) X s

1=1

Figure 115: Formula for degree minutes

deg min Total Degree Minutes spent
above/below the alert
threshold.

ti The temperature that was
above/below the alert
threshold.

a The alert temperature
threshold.

S The duration of time, in

minutes, the temperature was
sustained.
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Mean Kinetic Temperature

Some products and materials have accelerated rates of degradation at higher temperatures. For
example, perishable food items and pharmaceutical products can degrade and many forms of
bacteria grow exponentially as the environmental temperature increases. Mean kinetic
temperature is a calculation that accommodates the non-linear thermal effect, which
temperature can have on products. Mean kinetic temperature is represented as the equivalent
temperature the product was thermally subjected to during the time the various temperature
readings were recorded.

Mathematically the formula for calculating the mean kinetic temperature can be expressed as
illustrated.

For example, if there were 5 data points of which to calculate the mean kinetic temperature,
they were, 12.3, 15.9, 16.2, 14.7 and 14.9 degrees Celsius, then the mean kinetic temperature
would be 14.9 degrees Celsius using the default AH.

By default LogTag Analyzer uses an activation energy value of 83.144 KJ/mol for the calculation.
To enter a custom value for AH, click Options from the Edit Menu, then navigate to the
Summary Statistic section where you can enter the desired value in the Use the following value
text field.

Charts and the Statistics page display the AH parameter if it is different to the default value,
and display Logger deltaH if the parameter from the logger was used.
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A
R
mkt = — 273.15
> exp —=OH
In i=0 Rx (t;+273.15)
- n
Figure 116: Formula for mean kinetic temperature
mkt is the mean kinetic
temperature, in degrees
Celsius
AH is the activation energy.
R is the universal gas constant,
which is 0.0083144 KJ/mol K
n is the number of data points
to include in the calculation
ti represents the data points to

include in the calculation, in
degrees Celsius
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Standard Deviation

The standard deviation is a useful measure for determining how spread out the readings are
from the arithmetic mean (Average Reading). Most controlled environments typically try to
keep the environmental conditions at a stable and consistent humidity and/or temperature.
The standard deviation can be used to help indicate how stable the environmental conditions
were maintained. One standard deviation (sometimes expressed as "one sigma'") away from the
mean, positive or negative represents approximately 68 percent of all the readings. Two
standard deviations, or two sigmas, away from the mean represents approximately 95 percent
of the readings. Three standard deviations represent about 99 percent of the readings.

For example, if the arithmetic mean of the readings was 50.6 °C and the standard deviation was
2.3 °C, then approximately 68% of the readings were between 48.3 °C and 52.9 °C, 95% of all the
readings were between 46.0 °C and 55.2 °C and 99% of the readings were between 43.7 °C and
57.5 °C. Further more, if all the readings were recorded over a span of 1 day (24 hours) then the
temperature was between 48.3 °C and 52.9 °C for approximately 16 hours and 19 minutes during
the recorded period of time.

Mathematically standard deviation can be expressed as illustrated. Figure 118: Population based standard deviation

LogTag Analyzer allows the calculation of sample or population based standard deviation.
Which of those is used for the calculation can be set by clicking Options from the Edit Menu,
then navigating to the Summary Statistic section and selecting sample based or population

S the calculated sample based
standard deviation

based. SN the calculated population
Here you can also adjust the number of decimal places used to display the result, but please based standard deviation
note this setting is shared amongst all statistics calculations. n the number of readings to
For a more detailed explanation of the various ways to calculate standard deviation please include in the callculatloin
consult the relevant literature related to statistical and probability calculations. av Ezleea(flcmated arithmetic
ti a reading to include in the

calculation
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Sharing recorded data with others

You can share data downloaded from a LogTag® device with other users in a number of

different ways.

« If the person you wish to share the data with has access to the same software version of
LogTag Analyzer as you, you can send the latest *.1tdx file via email, or upload it to an FTP
server.

You can find more details about sending files automatically or upon request in the sections
about Automatic emailing and uploading to FTP sites on the next page and Sending a file by
email directly from LogTag Analyzer below

« If they have an earlier copy of LogTag Analyzer prior to version 3, it may be easier for them
if you send a legacy file, such as the *.1td format. You can use the Save As function, then
send the file manually via the Send Mail function.

« If the other user does not have access to a version of LogTag Analyzer, you can send the data
in various export formats, such as spreadsheet files, PDF files and various other text format
files. You can find the relevant information in the sections about Saving a file for use in
spreadsheets on page 140, saving Exports and Reports on page 179

« If you have access to LogTag® Online you can upload the data to your account, and add the
other person to your team. See Integrating LogTag Analyzer with LogTag Online on
page 143for more information.

Sending a file by email directly from LogTag Analyzer

You can email files to someone else directly from inside LogTag Analyzer.

When you click the Send Mail icon from the toolbar, a new email message will be created in
your default email program, with the currently active file already attached to the message. Type @
the recipient's email address, add a message that you wish to include and then click Send.

Clicking on Send in the File menu will achieve the same results as clicking the Send Mail icon. Figure 119: Send Mail Toolbar Icon

Note, the recipient of the file will need to have LogTag Analyzer software installed to open and
view the file you sent. LogTag Analyzer software is free and can be downloaded from
https://logtagrecorders.com/software/lta3/download/.

If you want to send data in file formats other than the LogTag Analyzer format, specify the
desired file formats in the Exports and Reports section in the Options Window (Exports and
Reports on page 179). The data files will automatically be attached to your emails in the desired
formats.

Send Mail
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To send a multi chart, it must first be saved to disk (Saving a Multi Chart File on page 99).

Note: You can automatically send emails and upload files to ftp sites using LogTag
Analyzer's automated SMTP and FTP functionality. Please see Automatic emailing and
uploading to FTP sites below for further details.

Automatic emailing and uploading to FTP sites
Every time data are downloaded from a LogTag®, LogTag Analyzer can automatically email the
resulting data files to pre-selected recipients or upload them to an FTP site.

Email uses SMTP (Simple Mail Transfer Protocol), which defines how electronic mail is
distributed across networks.

FTP (File Transfer Protocol) describes a mechanism by which files are transferred between
different computers and networks.

LogTag Analyzer supports different authentication methods for each protocol, which you can
select when you configure the settings for each service. Here, you also set whether the process
should be automatic, on request, or both.

If you wish to learn more about FTP, SMTP, email and networking please refer to one of the
many good articles available on the Internet, such as the ones on Wikipedia or the various FTP
and SMTP client providers.

If you activate manual uploading/emailing, but not automatic uploading/emailing, you need to
click the Upload button on the toolbar to upload or send the file in the currently active window.

A @&
Upload Upload
Figure 120: Active and inactive Upload Toolbar Icon

If the button is inactive, neither email nor FTP options are enabled.
When uploading or emailing files this will be shown in the status bar Upload Status on page 44.

Tip: The manual email function described here is different from the "send mail"
button on the toolbar. The Send mail button opens a draft message in your standard
email program and attaches the data file. You then need to complete the recipients'
email addresses and press the send button. The manual email function via SMTP does
not use your standard email program, but the configured SMTP settings and requires
no further action once the Upload button on the toolbar is clicked. You can, however,

not change the recipient without changing the SMTP settings.
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Note: The automatic functions only work if a file is created by downloading data from a
LogTag® in the interface. If the uniqueness settings in the File and Folder Settings are
set so that certain conditions do not result in creation of a new file, no file is uploaded
or emailed either. If you always want to upload a file, we suggest you add the file
creation time variable (%TIME) to the file name, that way a new file will always be
generated .

Note: If you upload a file via the manual or automatic FTP function, any file that
already exists on the server with the same name will be overwritten without warning.
It is up to you to make sure files are created with unique file names.

Saving a file for use in spreadsheets

Occasionally you may wish to export a LogTag® data file so you can analyze it in more detail
using a spreadsheet program such as Microsoft™ Excel. You can choose between a few different
options to achieve this.

CSV File export

You can use the File - Save as command from the menu, and select the *.csv option. CSV files
can be read by most spreadsheet programs and text editors. CSV files are the most flexible
export files, as they can be customized in Exports and Reports to suit your particular export
needs.

The *.CSV file contains a section at the top with a summary of the recorded data, followed by
the list of readings. You can also decide to include index, date, time, elapsed time, events and
comments when you customize the export. You can also choose the day summary for loggers

containing such a summary.

Please note that files created by LogTag Analyzer may not always be true CSV files (
Comma Separated Values), as they use the list separator from the Windows operating
system. It does however mean the file can be opened with MS Excel without going
through the data import facility. To create a true CSV file select "Use custom list
separator" and enter a comma in the adjacent field. You can also use the custom list
separator to generate files for applications which require other list separator
characters.

(& J

You can also automatically export the data into a CSV file when a logger is downloaded. Please
Exports and Reports on page 179 for further details.
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LogTag North America Inc also offer a conversion program, which you can use to bulk convert
legacy *.1td files to *.csv files. You can download this utility called LogTag®Convert from the
software download page at https://logtagrecorders.com/software/.

XLS file export

You can use the File - Save as command from the menu, and select the * xls option. This
creates a file that can be opened directly with MS Excel. It contains two tabs, one with a listing
of the readings, including index, date, time, elapsed time, events and comments, the second
with the contents of the summary tab. Files from loggers with a day summary will contain a
third tab showing that summary.

XLS files cannot be customized or exported automatically.

Using the Windows Clipboard

Select the Data tab and press CTRL-C or click Edit - Copy from the menu. Open an empty
worksheet in your spreadsheet program and select CTRL-V or click Edit - Paste from the
application’s menu. The data will be pasted in the cells and you can save the file in the format
of your spreadsheet program.

PDF files

LogTag Analyzer can save the currently active LogTag® file to a PDF file. One single file will be
generated, which contains the report, chart images, summaries and a data list.

PDF files can be generated automatically, or by selecting Save as from the File menu. Select a
file name and location for your PDF file. Automatic generation of PDF files is enabled in the
section about Exports and Reports on page 179. Here you can also define the composition of the
PDF file.

Click the button; the PDF Export Settings dialogue is displayed, allowing you to
select which content of the PDF file will be created.

[ Note: The report page is always included in the PDF. ]

If a chart is zoomed, the PDF file will also contain a zoomed setting.

Saving a file as text

Occasionally you may wish to export a LogTag® data file so you can import it into other
software as text. You can either do this manually using Save as from the File menu, or
automatically when you download a logger.

You can choose between different text formats:
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PDF Data Settings
D Show readings beyond specification as blank
Include the following
DChart image
Data
Summary
Day Summary
PDF Layout Settings

Paper Size: |A4 v |

Orientation: (@) Portrait () Landscape
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Figure 121: PDF Export Settings
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« You can save the file as a *.txt file.

This file is a tab delimited file that can be opened in any text editor on a PC.
« You can save the file as a *.txtm file.

This file is a tab delimited file that can be opened in any text editor on a Mac.
« You can save the file as a *.html file.

This file is a mark-up text file that can be opened in any browser.

You can define the contents of these files by clicking Options from the Edit menu and selecting
the Exports and Reports tab.

LogTag® Data files (*.Itd)

The legacy file type *.1td is the main file format of LogTag Analyzer software before version 3
was introduced.

You can open these files with LogTag Analyzer version 3 without loss of information.
Annotations, chart titles and receiver notes will all be converted and visible when saved using
the new *.1tdx format.

You can also save data in the *.1td format using LogTag Analyzer version 3, so they can be
accessed by LogTag Analyzer version 2 or earlier. However, none of the additional settings such
as annotations, zoom and notes are saved.

You can decide which file format you want to be the default format in File and Folder Settings
on page 171.
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Integrating LogTag Analyzer with LogTag Online

LogTag® Online is a web based storage, analysis and sharing portal for data recorded by
LogTag's range of data logging products. You can upload complete trips or live temperature
data recorded from loggers, associate the data with locations and share them with members of
a collaboration team.

What LogTag® Online can do is described in detail on the Help Center web page at
https://logtagonline.com/support.

The following section shows the integration of LogTag Analyzer with LogTag® Drive, one of the
features of LogTag® Online:

« Signing in on the next page and out of your LogTag® Online account

« Automatically uploading files to LogTag® Online on page 145 Drive from Analyzer
» Uploading data to LogTag® Online locations

« Opening files directly from LogTag® Drive using Analyzer
o Working with multiple teams on the next page
You can automate some of these steps in the LogTag® Online settings.

Note: To maintain compliance with the FDA CFR 21 Part 11 guidelines, you cannot
connect to LogTag® Online while being connected to User Server and vice versa. These
options are mutually exclusive.
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Signing in

To upload data to LogTag® Online you must be able to access an active LogTag® Online account
and connect LogTag Analyzer to your LogTag® Online account by entering the sign in
credentials for that account.

You can create a new LogTag® Online account by clicking Create an Account in the
LogTag Online menu, which will open a browser window. Complete the details and
follow the on-screen instructions.

Initially, a red dot shows next to the LogTag Online menu, indicating that you are not signed
in. Click Sign In from that menu, and a window opens where you can enter your details:

Provide the email and password for your LogTag® Online account and click .

Once you are connected, the dot next to the LogTag Online menu changes to green, indicating
that you are now signed in.

In the settings for LogTag® Online you can choose to complete the sign in process
automatically next time you start LogTag Analyzer. You can also choose to sign in manually
every time you start LogTag Analyzer.

Working with multiple teams

LogTag® Online allows you to be part of multiple teams, but you can only upload or view files
for one team at a time. If you are part of multiple teams, you need to select which of these
teams you wish to be the currently active team.

Click Current team from the LogTag Online menu and click the name of the team you wish to
be active.

Now, when you upload files to LogTag® Online they will be uploaded to this team, and only
this team's data files are available for opening.

If you are a member of only a single team, this will automatically be selected.
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LogTag Online Sign In X

You are required to Sign in before you can continue.
[ @) Please enter your username and password. Contact
your administrator for further assistance.

Email:
Password:

Remember Password
||
0 | O | 0 |

Figure 122: Sign in window
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Figure 123: Team selection for your account
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Automatically uploading files to LogTag® Online

If you have a LogTag® Online account you can upload data from your loggers directly to
LogTag® Online, using LogTag Analyzer. This is useful if you wish to share data online with
others who do not have access to a PC with LogTag Analyzer.

This feature is enabled in the LogTag® Online section of the Option settings. If enabled, the
data for each LogTag® product you download to your PC is uploaded automatically to your
team's account, provided you are signed in (The LogTag menu shows a green dot). Loggers you
upload are automatically registered as a device in your team's account.

The logger's data are always stored locally in the folder defined in File and Folder
Settings on page 171.

Data is, however, only uploaded if a new file is generated when the logger is
downloaded. If no new file is generated, for example when downloading a logger that
has stopped, for a second time, no data is uploaded.

Note that you can only upload the data at the time it is downloaded from the logger. At
the moment, it is not possible to upload files manually.

A J

If your logger is attached to a location
If your logger is attached to a location, the logger's data are added to the location data each
time you download it via LogTag Analyzer.

Lo You can attach all logger models to a location2, including USB loggers. ]

If your logger is not attached to a location

If your logger is not attached to a location, a data file will be uploaded to LogTag® Drive in
addition to being stored locally on your PC. This can be viewed in LogTag® Online in the same
way as a file uploaded via one of the wireless interfaces (LTI-WIFI or LTI-WM-WIFI). Other
team members can then download the file and view it in LogTag Analyzer.

2 Attaching a logger to a location is done in LogTag® Online or via the WiFi wizard. For more information about locations please see the

LogTag@ Online help.
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If LogTag® Online is not available

If LogTag® Online is not available at the time you download the logger, for example when the
network is down or you are not logged in, LogTag Analyzer will keep trying to upload the file at
regular intervals, if this is set up in Options - LogTag® Online.

You will receive regular reminders to complete the sign-in process.

Opening files directly from LogTag® Drive

When you are signed in to your LogTag® Online account from LogTag Analyzer, you can open
data files stored in LogTag® Drive directly. Click Open from the File menu, or click the Open
toolbar icon.

The folder list contains an Analyzer entry (similar to your Dropbox or Onedrive entries),
showing the currently selected local storage folder as well as an entry LogTagOnline.

v B Analyzer

LogTagOnline

My LogTag Data
Click LogTagOnline to show a list of files currently stored in your LogTag® Online account.
These files represent shortcuts to the actual file content stored in LogTag® Drive. Once you

have selected a file for opening, it will be copied to your local storage folder, then opened in
LogTag Analyzer in the same way you would open a locally stored file.

LogTag Online Sign In
. You are required to Sign in before you can continue.
o« Please enter your username and password. Contact

your administrator for further assistance.

Email: mail@healthcare-specialists.org

Password: |

Remember Password

%> | O | 0

Any file you open will be copied to your local storage folder, regardless of the settings
made in Automation. This means the file will be available even after you have signed
out from your LogTag® Online account. The shortcut in the Select recent File menu
will reference the local file.

Figure 124: Sign-in reminder
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Chapter 4
Customizing the Software

This chapter explains in detail how to customize the software to your needs.

General SettingS ... o 149
SUMMAIY StatiStiCS .. 152
CATE S At StICS . o 154
QTS 155
AU O At 0T . 160
File and Folder Settings ... 171
EXpOrts and RepOrtS .. ... 179
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LogTag® OnliNe ... ... 190

Importing and Exporting Option Settings ... 191
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Many of LogTag Analyzer's features can be customized to suit your specific requirements.

This is done in the Options dialogue, which you can open by clicking the Options icon in the
toolbar or by clicking Options from the Edit menu.

©

Options
Figure 126: Toolbar Icon

To change any of the options, select the corresponding category in the left pane of the options
window. You will the see what can be changed in the right pane. Most of the options available
will be applied as soon as you click . For example, if the language selection or the date
format are changed, all windows that are open will be updated without the need to restart the
software.

Some of the display settings, such as decimal point and date/time formats, are
controlled by the regional settings of the Windows operating system. These can usually
be found in the Control Panel under "Regional and Language Options". Please refer to
your Operating System's documentation for further assistance.

[ Edit | LogTag Window
J Copy Ctri+C
9\ Zoom Out

‘ Real Time

@ Elapsed Time

o Marks

( roup of Marks
@ Next group of Marks
@ Options I

Figure 125: Edit Options Menu
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page 149
General Settings
The General Settings options allow you to change various preferences that will effect the
overall appearance of the information shown by LogTag Analyzer. opties _ x|
[ cererar settings Options - General Settings Reset All To Defaults
Show temperatures in... Psommarysmses
Here you set the unit used for temperature values displayed in the software's dialogues, lists, Flea =
charts and reports. The options are: (“”"
) Automation
« Fahrenheit (°F) e s
« Celsius (OC) |5 Exports anaReports
+ Kelvin (K) ESomesrne
] Communication Ports
( ) ) vsersener
For loggers with a display and USB PDF loggers the temperature unit used on the e
display or in the PDF is set during configuration. It is independent of the temperature e T —
unit chosen here. EN s i —
~ 7 [ Oter options! firmware updates for this session only
e N
Note that if your Windows Region is set to Japan, you will not be able to select @ o« @ ox || eencwes | @ e |
Fahrenheit as your temperature unit. : )
L ) Figure 127: General settings

Default time interval to display
Here you set the default time zoom level. This is zoom is applied when a file is opened or a
logger is downloaded. You can set this to:

o All readings

« From first reading to first inspection/download mark
» From last inspection/download mark to last reading
« From last inspection mark to last reading

« From last download mark to last reading

The section about Inspection and download mark zoom on page 109 explains in more detail
how this feature works.

Language
This setting determines which language the software uses. Supported languages are:
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« English US

« Chinese (Simplified)
o French

« German

o [talian

e Japanese

« Portuguese

« Russian

« Spanish

o Turkish

Enable automatic checking for a newer version

The LogTag Analyzer software can periodically check to determine if a newer version is
available for download from the LogTag North America Inc website.

To enable this feature select Enable automatic checking for newer version and set the number
of days between checks by entering or selecting a number in "Check every XX days". To disable
the feature, clear the box.

If you enable the automatic check, and a new version is available, a window with an overview
of the update will be displayed. Please see Upgrading LogTag Analyzer on page 24

Enable USB Logger Update Check

If you enable this feature, the LogTag Analyzer software will check the LogTag North America
Inc website for available updates that can be applied to USB loggers, at the same time it checks
for a newer version of the software. If updates are available, the required files are downloaded
immediately and offered during the configuration process of any USB loggers that are eligible
for an update. You still have the option of declining the update at the time the configuration
process takes place. Typically, these updates are mandatory or recommended, particularly if
they improve the performance of the unit or add more features.

If you disable this feature, upgrade files are not downloaded or applied.

Optional 